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product overview

Figure 1 - hp color inkjet printer cp1700

« Product positioning: High performance, wide-format printer providing the benefits of
individual color cartridges for small business

« Takes over the price points of the DJ 1220C with higher performance and
expandability options

* Printer price: USD 499

* Announcement date of the printer is Nov 1, 2001

« High speeds: 16 ppm black fast; 14.5 ppm color fast

* Designed for small business

* Prints on both A4/Letter and A3+/13X19" and B size paper and special media

* Prints cost-effective color documents, proofs, collateral, and comps on a wide variety of
paper

* Prints automatically on both sides of the document using the auto-duplex unit
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key selling points

available options

« 3 printer SKU options available:
* hp color inkjet printer cp1700

« hp color inkjet printer cp1700d
* hp color inkjet printer cp1700ps
» Expandability options:

* Auto-duplex unit

» 250-sheet paper tray

¢ LIO internal network module

« HP Jetdirect external print servers
» Connectivity features

» USB

* |EEE 1284

* LIO

« front connect infrared

quality

» Uses HP PhotoRet Ill color layering technology

* 2400 x 1200 dpi printing (on hp premium photo paper only)

» Adobe PostScript 3 software RIP included with the hp color inkjet printer cp1700ps
provides:

* Greater color accuracy

 Support for industry color management standards including ColorSync, ICC Profiles,
PANTONE

» Emulation for press standards, such as SWOP/EuroScale

« ADI Driver (releases 13 onwards) included in-box for AutoCAD users (for Windows

only)
 High Speeds: Fast - 16 ppm black/14.5 ppm color

media flexibility

* Prints on paper types ranging from plain paper and transparencies to thick card stock
(up to 72Ib/270gsm)

* Prints on media sizes ranging from 4 x 6 inch/A®6 size small postcards to 13 x 19
inch/A3+ posters and 13 x 50 inch banners

* Built-in media size sensor, for A3 paper size

« Built in media type sensor - recognizes the paper type in use and automatically selects
the appropriate settings

 Paper path capacity:

» Rear manual feed: 1 sheet (16 to 72 Ib)

* Front manual feed: 10 sheets (16 to 36 Ib)

» Tray 1: 150-sheet paper tray (16 to 36 Ib), envelopes (20 to 24 Ib), and cards (110 Ib
index)

» Optional Tray 2: 250 sheets (16 to 36 Ib) plain paper
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low printing costs

* Four separate high-volume ink cartridges

* Low-ink status indicator LCD

« Front-panel cancel button to help maximize your consumables
* Duty cycle of an average of 5000 pages per month

» Low Costs: 2.2 cents K/8.4 cents (CMYK), 1750 pages out

hp confidential
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unique product features

Figure 1.2 - hp color inkjet printer cp1700
* Superior print quality
* outstanding photo quality (with HP PhotoRet III)
» Up to 2400 x 1200 dpi resolution on premium photo paper only
* CANCEL button terminates print jobs at one touch of the key, reducing ink and time
wastage
» Optional network card enables
« Sharing of printer in small workgroups (of 2-3 users)
* Remote printer management
e Smart printing features:
* LCD printer status indicator
* CANCEL button
* Smart software features:
e ZoomSmart
* Booklet
* Handouts
* Tiling
« 2-sided printing (manual or automatic)
* Watermark
* Banner
* Mirror Image
» Smart hardware features:
* automatic pen alignment
» Media type sensor
* Media size sensor (A3 only)
« Straight paper path eliminates bends and smudges in the print output
* Front-access infrared sensor allows wireless printing from a variety of mobile devices
including laptops and PDAs
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localization

Localization language options available for the following:
 Reference Guide
* Starter CD
 Packaging
» LCD Messaging

Each of the above has the following localized language options:

available language options

Reference Guide o US English
0 Bahasa Indonesia
o Traditional Chinese
o Simplified Chinese
0 Korean and Japanese
o Starter CD 1 o Starter CD1
o Starter CD 2 =  Windows Driver: US English,
Portuguese(Brazilian), Euro-Spanish, French,
Italian, German, Dutch, Polish, Czech, Turkish,
Arabic, Traditional Chinese
=  MAC Driver: US English, Portugese (Brazilian),
Euro-Spanish, Swedish, French, Italian, Germany,
Dutch, Japanese
o Starter CD2
=  Windows Driver: US English, Swedish,
Norwegian, Danish, Finish, Russian,
Greek, Hebrew, Japanese, Korean,
Simplified Chinese
= MAC Driver: US English, Portugese
(Brazilian), Euro-Spanish, Swedish,
French, Italian, Germany, Dutch,
Japanese
US English
Bahasa Indonesia
Traditional Chinese
Simplified Chinese
0 Korean and Japanese

Packaging

O O O O

localized language options
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foot print
hp color inkjet printer cp1700/ hp color inkjet printer cp1700ps

Fig 1.10 hp color inkjet printer cp1700/ hp color inkjet printer cp1700ps
* Weight: 13.5 kilograms
* Width: 673.3 mm
» Height: 284.3 mm
* Depth: 567.7 mm

hp color inkjet printer cp1700d

¥
Fig 1.11 hp color inkjet printer cp1700d
* Weight (printer): 13.5 kilograms
* Weight (Auto-Duplex Unit): 2.4 kilograms
* Width: 673.3 mm

* Height: 284.3mm
* Depth: 653.5mm
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top of the printer

top of the printer

The top of the printer displays the following:

1. Ink cartridge cover - Provides access to the ink cartridges

2. Printhead cover - Provides access to the printheads

3. Printhead access latch - Lifts to allow each printhead to be removed from its color-
coded socket
Carriage lock - Locks the printhead access latch.
5. Hook - Connects to the carriage lock. Must be engaged for the printer to operate
6. Top cover - Provides access to the interior of the printer

Ea
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front of the printer

Front of the printer

The front of the printer displays the following:
1. Front manual feed - Holds the paper to be fed into the printer. The paper width guide
slides to fit the width of the paper.

arMeN

Tray 1 - Holds plain paper and special media.
Tray 2 - Holds plain paper. This is an optional accessory.
Output tray - Collects the printed pages.
Paper guides - Guides the print paper into the printer.

-,

|

it

i
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rear of the printer

rear of the printer

The rear of the printer displays the following:

1. USB port - Attach a USB cable.

Parallel port - Attach the parallel cable

3. LIO Adaptor Slot - Install an optional HP JetDirect print server/Internet connector LIO

module

Power input - Attach the power cord..

5. Rear access panel - Remove this to clear paper jam. Remove the rear access panel to
install the optional auto-duplex unit. Rear access panel required for straight paper path
(rear manual feed).

N

Ea
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controls

controls
The Liquid Crystal Display (LCD) panel displays information about the status of the printer. It
also has buttons to perform basic printer operations. The LCD panel of the printer displays the

following:

1. CANCEL button: Cancels the current print job

2. POWER light: Is always lit when the printer is on. Blinks when printer is initializing,
canceling a job, or turning off.

3. Power button: Controls power to the printer. Press to turn the printer on or off.

4. LCD: Displays messages relating to the current state of the printer and the ink levels in
the individual ink cartridges.

5. RESUME light: Blinks whenever the printer requires user intervention (for example, to
clear a paper jam or to close an open cover.

6. Resume button: Resumes current print operation after temporary interruption, for
example, when adding print media to printer.

7. Infra-red port: Used for printing form an infra-red device, such as a handheld device or

laptop.

Tour of the product hp confidential 1-13



auto-duplex unit
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auto-duplex unit
The printer automatically prints on both sides of paper by using a printing accessory called the
auto-duplex unit. The auto-duplex unit is attached at the back of the printer. The auto-duplex
unit of the printer displays the following:
1. Buttons: Press to remove the auto-duplex unit from the printer.
2. Rear cover: Remove to clear a paper jam from the auto-duplex unit.
3. Handles: Press to remove the rear cover from the auto-duplex unit.

The auto-duplex unit is a standard accessory provided with the hp color inkjet printer
cpl700d.

Note
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product specifications

model numbers

printer name model number availability

hp color inkjet printer hp color inkjet

hp color inkjet

cpl700 printer cp1700d | printer cp1700ps
hp color inkjet printer cp1700 C8108A Worldwide
(base model)
hp color inkjet printer C8106A Worldwide
cpl700d(base printer plus auto-
duplexer)
hp color inkjet printer cp C2691A Worldwide

1700ps (base printer plus
software Adobe PostScript 3
RIP)

printer model numbers

Note The hp color inkjet printer cp1700, model C8108A, is the base model or starting point for
each additional model listed above. The additional model numbers are created for specific
distribution channels or by the addition of hardware or software.

serial number location

The serial number is located on the serial number plate found on the back of the printer and on
the Diagnostic test page.

printer description

» Connectivity features, such as USB, IEEE 1284, front connect infrared, and a LIO
networking slot PCL3 enhanced

» HP PhotoREt Il print quality with alternative 2400 8 1200 dpi mode for photo printing

e Individual print cartridge for each color (CMYK)

» Uses HP PhotoRet Ill color layering technology

» Accepts a wide variety of media from plain paper to transparencies or thick card stock
(72 Ib/270 gsm)

 Low cost-per-page and intervention rates

» Expandability options including auto-duplex unit, 250-page second input tray, and
network capability with LIO internal/Jetdirect external modules

* Media size sensor (A3 only)

« Infrared printing

Tour of the product hp confidential 1-15



 Low-ink indicator and printer status LCD

» ADI Driver (releases 13 onwards) for AutoCAD users (for Windows only)
 The hp color inkjet printer cp1700 series supports the printing of Hagaki cards in the

Japan region.
printer features
print speed

print speed: letter/A4

These are approximate page-per-minute (ppm) figures. Exact speeds will vary depending upon

system configuration, software program, and document complexity.

characteristic fast normal best
Black text 16 ppm 8 ppm 4 ppm
Mixed text color 14.5 ppm 7 ppm 4 ppm
4 in by 6 in Photo 1.4 ppm 0.9 ppm 0.7 ppm
Full page color 5.5 ppm 1.3 ppm 0.7 ppm

print speed: letter/A4
print speed: (11 in by 17 in/A3)

These are approximate page-per-minute (ppm) figures. Exact speeds will vary depending upon

system configuration, software program, and document complexity.
characteristic fast normal best
Black text 10 ppm 5 ppm 1.7 ppm
Mixed text color 9.5 ppm 3.5 ppm 1.6 ppm
8 in by 10 in Photo 0.5 ppm 0.3 ppm 0.2 ppm
Full page color 3.7 ppm 0.9 ppm 0.5 ppm

print speed: 11 in by 17 in/A3

print resolution

characteristic specification
Black Printing Max. 600 x 600 dpi
Color Printing Max. 2400 x 1200 dpi

print resolution
print method

Drop-on-demand thermal inkjet printing
printer languages

* hp color inkjet cp1700: HP PCL 3 enhanced

* hp color inkjet cp1700d: HP PCL 3 enhanced

* hp color inkjet cp1700ps: HP PCL 3 enhanced and
» Adobe PostScript 3 Software RIP

software compatibility

» Microsoft Windows 95, Windows 98,
* Windows Me, Windows NT 4.0, Windows 2000,

hp confidential
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* Mac OS 8.6 or later

system requirements

system minimum recommended

requirements

Windows 95/98 | Pentium 60 MHz, Pentium Il 450 MHz, 128 MB RAM,
16MB RAM 200 MB hard disk space

Windows NT 4.0 | Pentium 60 MHz, 24| Pentium Il 450 MHz, 128 MB RAM,

9.x

MB RAM 200 MB hard disk space

Windows Me Pentium 150 MHz, Pentium Il 450 MHz, 128 MB RAM,
32 MB RAM 200 MB hard disk space

Windows 2000 Pentium 133 MHz, Pentium Il 450 MHz, 128 MB RAM,
32 MB RAM 200 MB hard disk space

Mac OS 8.6 or 32 MB RAM Mac OS 8.6 or later (iMac): 333

later (USB/AppleTalk) MHz. 64 MB RAM

Mac OS 8.6 or 32 MB RAM (IR) Mac OS 8.6 or later (Power Mac G3

or later): 350 MHz, 64 MB RAM

system requirements

170 interface
USB, IEEE 1284, IR, network LIO

recommended cables

cable part number
HP USB A-B (2 m) C6518A
HP IEEE-1284 A-B Parallel Cable (2 m) C2950A
HP IEEE-1284 A-B Parallel Cable (3 m) C2951A

font information

cables

« 8 built-in fonts, 4 each in portrait and landscape orientations
* CG Times, CG Times ltalic, Universe, Universe Italic, Courier, Courier ltalic, Letter

Gothic, Letter Gothic Italic
HP supplies and accessories

accessories

part name part number
Auto-duplex unit C8219A
Second input paper tray C8220A

ink information

HP accessories

printheads HP Part number
HP No. 11 Black C4810A
HP No. 11 Cyan C4811A

Tour of the product
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HP No. 11 Magenta C4812A
HP No. 11 Yellow C4813A
printheads
ink cartridges HP part number
HP No. 10 Black (69 ml) C4844A
HP No. 11 Cyan (28 ml) C4836A
HP No. 11 Magenta (28 ml) C4837A
HP No. 11 Yellow (28 ml) C4838A

ink cartridges

hp photo quality inkjet paper

print server HP part number size
Two-sided, matte, 100 sheets C7007A letter
Two-sided, semi-gloss, 25 sheets C6983A letter
Two-sided, semi-gloss, 25 sheets C6984A A4
Two-sided, semi-gloss, 25 sheets C7006A A4/AP

hp photo quality inkjet printer

hp professional brochure and flyer paper

print server HP part number size
Two-sided, gloss, 50 sheets C6817A letter
hp professional brochure and flyer paper
hp heavyweight paper
print server HP part number size
Premium, 100 sheets C1853A A4
Design, 100 sheets C6790A super B/A3
hp heavyweight paper
network
print server HP part number
HP Jetdirect 200m print server/Internet connector (LIO | J6039A
module
HP Jetdirect 250m print server/Internet connector (LIO | J6042A
module)
HP Jetdirect 170x external print server J3258A
HP Jetdirect 175x external print server J6035A
HP Jetdirect 300x external print server J3263A

network

hp confidential
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media specifications

paper
media metric size eng_:jlish size
U.S. Letter 216 x 279 mm 8.5 x 11 inches
U.S. Legal 216 x 356 mm 8.5 x 14 inches
Tabloid 279 x 432 mm 11 x 17 inches
Super B 330 x 482 mm 13 x 19 inches
A3 297 x 420 mm 11.7 x 16.5 inches
A3+ 330 x 483 mm 13.0 x 19.0 inches
A3 Banner 297 x 420 mm 11.7 x 16.5 inches
Tabloid Banner 279 x 432 mm 11 x 17 inches
A4 210 x 297 mm 8.3 x 11.7 inches
A5 148 x 210 mm 5.8 x 8.3 inches
B4 257 x 364 mm 10.12 x 14.33 inches
JIS B5 182 x 257 mm 7.17 x 10.12 inches

envelopes (tray 1 and rear manual feed only)

paper specifications

media metric size english size

U.S. No. 10 105 x 241 mm 4.12 x 9.5 inches
Monarch 98 x 191 mm 3.87 x 7.5 inches
DL 200 x 110 mm 4.33 x 8.66 inches
A2 111.1 x 146 mm 4.4 x 5.8 8 inches
Kaku No.2 240 x 333 mm 9.4 x 13.1 inches
JIS Envelope 3 120 x 235 mm 4.7 x 9.3 inches
JIS Envelope 4 90 x 205 mm 3.5 x 6.1 inches
C6 114 x 162 mm 4.49 x 6.38 inches

cards (tray 1)

envelope specifications

media metric size english size
Index card 102 x 152 mm 4 x 6 inches

Index card 127 x 203 mm 5 x 8 inches

A6 card 105 x 148 mm 4.13 x 5.83 inches
J Hagaki card (for Japan) 100 x 148 mm 3.94 x 5.83 inches
Hagaki Ofuku (for Japan) 200 x 148 mm 7.9 x 5.8 inches

transparencies

card specifications

media metric size english size
U.S. Letter 216 x 279 mm 8.5 x 11 inches
A4 210 x 297 mm 8.27 x 11.7 inches

transparency specifications

Tour of the product
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minimum printing margins (based on portrait orientation)

paper description left and right| top bottom
margins margin margin
Letter, legal, Tabloid, Executive, 0.25in (6.4 0.12in 0.46 in
A3, B4, media of user-defined size| mm) (3.0 mm) (11.8 mm)
A4, A5, B5, envelopes, cards, 0.13in (3.4 0.12in 0.46 in
other media sizes mm) (3.0 mm) (11.8 mm)

minimum printing margins

Note When you are using the auto-duplex unit, the minimum top margin must match or exceed
0.46 inor 11.8 mm.

media handling

recommended media weight

category | specification

Paper e« 16to 36 Ib Bond using Tray 1 or front manual feed
16 to 72 Ib Bond using rear manual feed
Envelopes 20 to 24 |b Bond

Cards 110 Ib Index

media weight
maximum number of pages supported (tray 1)

Media capacity is dependent on the manufacturer, the type of media, and the media
construction.

category maximum number of pages supported
Plain paper 150 sheets of plain paper

Envelopes 10 envelopes

Transparency 30 transparencies

tray 1: number of pages supported

maximum number of pages supported (tray 2)

Media capacity is dependent on the manufacturer, the type of media, and the media
construction.
category maximum number of pages supported

Plain paper 250 sheets

tray 2: number of pages supported
memory information
hp color inkjet printer cp1700 series

* 16 MB builtin RAM
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reliability

characteristic specification

Printer Duty Cycle 5,000 pages/month

Black Printhead 18 months (from DOM2) or 200 ml

Color Printheads 18 months (from DOM) or 530 ml
reliability

2- DOM = Date of Manufacture

physical specifications

Note The specifications below are given for a printer without Tray 2 and auto-duplex unit
installed.
characteristic specification
Width 26 in or 674 mm (width)
Height 8.4 inor 215 mm
Depth 22.3 in or 568 mm
Weight printer only 29.7 Ibs (13.5 kilograms)

physical specifications (without tray 2 and auto-duplex unit)

Note The specifications below are given for a printer with Tray 2 and auto-duplex unit
installed.
characteristic specification
Width 26 in or 674 mm
Height 11.2 in or 285 mm
Depth 25.4 in or 646 mm
Weight printer only 29.7 lbs (13.5 kilograms)
Weight Tray 2 only 7.7 Ibs (3.5 kilograms)
Weight auto-duplex unit| 4.4 lbs (2 kilograms)
only

physical specifications (with tray 2 and auto-duplex unit)
electrical specifications

power requirements: input voltage and frequency

characteristic specification
Source 100 to 200 VAC ( £ 10%)
Frequency 50 to 60 Hz ( + 3 Hz)

power requirements
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power consumption (varies according to region)

Printing: 47.7 watts
Standby: 9 watts
Energy Star®compliant
Off mode: 0.6 watts

environmental specifications

Characteristic Specification Specification
(Temperature) (Celsius) (Fahrenheit)
Operating 5 to 40 degrees 41 to 104 degrees
Storage -40 to 60 degrees -40 to 140 degrees

temperature specifications

Humidity: (non-condensing) | Relative

20 to 80 percent RH

humidity specifications

Noise Levels per ISO 9614-1 Sound Power

: 6.4 B(A)

Sound Pressure

LpAm: 48.8 dB(A)

noise level specifications

warranty

1-year limited warranty
product certifications
safety

* CCIB S and E (China)
* CSA (Canada)
* PSB (Singapore)
* UL (USA)
* NOM-1-NYCE(Mexico)
* TUV-GS (Germany)
* K Mark and MIC Mark (Korea)
« LS (Lithuania)
* EEI (Estonia)
» CE (European Union)
* B mark (Poland)
EMC

e FCC Title 47 CFR Part 15 Class B (USA)
* CTICK (Australia and New Zealand)

* VCCI (Japan)

» CE (European Union)

* BSMI (Taiwan)

* GOST (Russia)

* ICES (Canada)
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PANTONE (R)*

PANTONE calibrated

PostScript (R) is a trademark of Adobe

Systems Incorporated which may be registered in certain jurisdictions.

Microsoft (R) is a U.S. registered trademark of Microsoft Corp.

PANTONE (R)* *Pantone, Inc.'s check-standard trademark for color.

Pentium (R) is a U.S. registered trademark of Intel Corporation.

TrueType (TM) is a U.S. trademark of Apple Computer,inc.

Windows NT (R) is a U.S. registered trademark of Microsoft Corporation.

Windows (R) and MS Windows,(R) are U.S. registered trademarks of Microsoft Corp.
Copyright C Hewlett-Packard Co. 2000

This information is subject to change without notice and is provided as is with no
warranty.Hewlett-Packard shall not be liable for any direct, indirect, special, incidental or
consequential damages in connection with the use of this material.
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Accessories, User Replaceable Parts, Supplies and Manuals

hardware accessories

The following HP accessories are available for order on the HP website. Visit
http://www.hpshopping.comfor more information.

name part street weight
number price

Tray 2 (250-sheet input tray) C8220A US$ 129 | 3.5kg

HP auto-duplex unit C8219A US$ 129 | 2.4 kg

HP Jetdirect 200m printer server/Internet | J6039A US$ 159

connector (LIO module)

HP Jetdirect 250m printer server/Internet | J6042A US$ 249

connector (LIO module)

HP Jetdirect 170x external print server J3258A US$ 144

HP Jetdirect 175x external print server J6035A US$ 199

HP Jetdirect 300x external print server J3263A US$ 255

hardware accessories

user replaceable components

The following are the customer replaceable parts for the printer.

part name part number
Assy - Cleanout Trough SVC C8108-67036
Assy - Tray Main SVC C8108-67044
Assy - Output Tray SVC C8108-67045
HP No. 11 Black Printhead C4810A
HP No. 11 Cyan Printhead C4811A
HP No. 11 Magenta Printhead C4812A
HP No. 11Yellow Printhead C4813A
HP No. 10 Black ink cartridge C4844A
HP No. 11 Cyan ink cartridge C4836A
HP No. 11 Magenta ink cartridge C4837A
HP No. 11 Yellow ink cartridge C4838A

user replaceable components

supplies and manuals

name part list price street price pages
no. (USS$) (USS) out
HP No. 11 Black C4810A| $39.99 ~ $35 16,000
Printhead
HP No. 11 Cyan C4811A| $39.99 ~ $35 24,000
Printhead
HP No. 11 Magenta C4812A| $39.99 ~ $35 24,000
Printhead
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HP No. 11Yellow C4813A| $39.99 ~ $35 24,000
Printhead
printheads

name part ink list price | street pages

no. capacity | (US$) price out

(USS)

Black ink C4840A| 28 cc In-Box Only| In-Box Only | 700
cartridge
HP No. 10 Black | C4844A| 69cc $38.99 ~$34 1750
ink cartridge
HP No. 11 Cyan | C4836A| 28cc $38.99 ~$34 1750
ink cartridge
HP No. 11 C4837A| 28cc $38.99 ~$34 1750
Magenta ink
cartridge
HP No. 11 Yellow| C4838A| 28cc $38.99 ~$34 1750
ink cartridge

identify expiration dates

« Install-by Date: This date is printed on the retail box for both ink cartridges and
printheads. Install the ink cartridges and printheads before the Install-by date for

optimized performance.

» Manufacture Date: This date is printed on the pouch for both ink cartridges and

ink cartridges

printheads. The number is in the following format: YYMMDDhhmm. For example, a
printhead manufactured on November 19, 1999 at 1:12 pm has a Manufacture Date

of 9911191312.

 End-of-Warranty Date: This date is printed directly on the ink cartridges and printheads.
It is the date by when the warranty period for the ink cartridges and printheads will be

over.

paper type part part description
number

hp bright white inkjet paper C1824A 500 sheets, letter
C1825A 500 sheets, A4
C1857A 200 sheets, B
C1858A 200 sheets, A3

hp premium plus photo paper | C6944A Gloss, 20 sheets, 4 x 6 in
C6950A Matte, 20 sheets, letter
C6831A Gloss, 20 sheets, letter
C6951A Matte, 20 sheets, A4
C6832A Gloss, 20 sheets, A4

hp premium photo paper C6979A Gloss, 50 sheets, letter
C6040A Gloss, 15 sheets, A4
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C6058A Gloss, 20 sheets, B
C6059A Gloss, 15 sheets, A3
hp photo paper C1846A Gloss, 20 sheets, letter
C1847A Gloss, 20 sheets, A4
C6745A Matte, 20 sheets, A4
C6765A One-sided, gloss, 20 sheets, A4
hp colorfast photo paper C7013A Gloss, 20 sheets, letter
C7014A Gloss, 20 sheets, A4
hp photo quality inkjet paper C7007A Two-sided, matte, 100 sheets,
letter
C6983A Two-sided, semi-gloss, 25
sheets, letter
C6984A Two-sided, semi-gloss, 25
sheets, A4
C7006A Two-sided, semi-gloss, 25
sheets, A4/AP
hp design paper C6791A Gloss, 50 sheets, B
hp professional brochure and C6817A Two-sided, gloss, 50 sheets,
flyer paper letter
C6818A Two-sided, gloss, 50 sheets, A4
C7020A Tri-fold, two-sided, 100 sheets,
letter
C6821A Two-sided, gloss, 50 sheets, A3
C6820A Two-sided, gloss, 50 sheets, B
C6955A Matte, 50 sheets, letter
hp heavyweight paper C1853A Premium, 100 sheets, A4
C6790A Design, 100 sheets, super B/A3
hp premium inkjet paper C1856A 100 sheets, A3
516347 200 sheets, A4
51634Y 200 sheets, letter
C1855A 100 sheets, B
hp premium inkjet transparency| C3828A 20 sheets, letter
film
C3834A 50 sheets, letter
C3832A 20 sheets, A4
C3835A 50 sheets, A4
hp social expressions banner C1820A 100 sheets, letter
paper
C1821A 100 sheets, A4
hp social expressions greeting | C6828A Felt-textured, ivory, half-fold, 20
cards sheets, letter
C6829A Felt-textured, ivory, half-fold, 20
sheets, A4
C7019A Textured, white, half-fold, 20
sheets, letter
C6044A Gloss, 10 sheets, letter
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C6045A Gloss, 10 sheets, A4

C1812A 1/4 fold, 20 sheets, letter

C6042A 1/4 fold, 20 sheets, letter

C7018A 1/2 fold, 20 sheets, A4

hp social expressions iron-on t-
shirt transfers

C6049A 10 sheets, letter

C6050A 10 sheets, A4

Manuals

paper types

documentation

purpose

release notes

Includes installation and the latest printer
information

Includes last minute changes and
software troubleshooting tips.

Hp JetDirect guide

Configuring the printer for network
printing

Troubleshooting

Help sources

user guide

Setting up the computer

Using the printer

Performing common printer tasks
Maintaining the printer

Troubleshooting when a problem occurs
Resolving printer problems

reference guide

Includes specific information about
setting up the printer
Information about installing the software

setup poster

Helps set up the printer

Provides illustrated setup information
Printed version of this document is
provided with the printer

An electronic version is available as an
Adobe® Acrobat® Portable Document
Format (PDF) file on the Starter CD

printer web sites

Printer information
Latest printer software

education and training material
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upgrades

model upgrades

You need to purchase the auto-duplex unit to upgrade from hp color inkjet printer cp1700 to

hp color inkjet printer cp1700d.

base model sku upgrade option | upgraded sku
hp color inkjet printer Auto-duplex hp color inkjet printer
cpl1700 (C8108A) unit(C8219A) cpl700d (C8106A)

You can purchase the following accessories to upgrade the printer hardware.

accessory upgrade option
2nd Input paper tray C8220A
hp jetdirect 200m print server (LIO module) J6039A
hp jetdirect 250m print server (LIO module) J6042A
hp jetdirect 170x external print server J3258A
hp jetdirect 175x external print server J6035A
hp jetdirect 300x external print server J3263A

firmware upgrades

To flash your printer with the latest firmware flash code, perform the following steps:

1. Download the latest firmware flash code

2. Set the printer in manufacturing mode by holding down the RESUME button and hitting

the POWER button.
3. Initiate the DOS prompt.

4. At the MS-DOS prompt enter the command "copy/b<filename>/Ipt1:"
5. To check the firmware flash code version sent, print the 4-button self-test page or press
the RESUME button 5 times while holding on to the POWER button

software upgrades

You can access the latest printer software by using the following URL:
www.hp.com/support/hp business inkjet printer cp1700 series
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service and support

support pack options

region description part
number
Europe HP warranty extension, 3-year, next day unit H3678A
exchange
North HP warranty extension, 1-year, next day unit H3685E
America exchange
HP warranty extension, 2-year, next day unit H3684E
exchange
HP warranty extension, 3-year, next day unit H3683E
exchange

available support pack options

web links

Information about products, ordering, setting up, and using printers, downloading printer
drivers, technical support, and details about the e-services, personal services, and business
services.

e http://www.hp.com
HP main web page. Contains information about the products, technical support, and details
about the e-services, personal services, and business services offered by HP

e http://www.hp.com/cposupport
Contains information about ordering, setting up, and using printers, and downloading printer
drivers.

* http://www.software.hp.com
HP Software Depot. Printer driver upgrades for maximizing printer operations

* http://www.hp.com/go/partsinfo
HP SPI/HP Part Surfer. A web-based solution for obtaining the latest parts information for HP
products

« http://cvseesc.cv.hp.com
Requires a user name and password

* http://ijbuwww.cv.hp.com/techmktg
Requires access to the HP intranet

« http://snserver.mayfield.hp.com
Service Notes Web Page

telephone support

Before making a call, print a diagnostic page from the Toolbox utility or the LCD panel and
then fill in the following information for the Customer Care Center representative.

Printer model

Serial humber of the printer

Brand and model of the computer

Version of printer software

Printer driver

CPU speed
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RAM size

The telephone service at the HP Customer Care Center is available free of cost during the
printer warranty period. Customer support representatives answer questions regarding the
setup, configuration, installation, and operation of the printer. They also help troubleshoot and
diagnose printer problems and provide instructions for service and repair.

region phone number
Africa/Middle | 41 22 780 71 11
East
Argentina e Buenos Aires: 11 4778 8380
e Outside Buenos Aires: 0810 555 5520
Australia e During warranty: 3 8877 8000

e After warranty: If your product is not under warranty, you
can call 613 8877 8000. A per-incident, out-of-warranty
support fee of $27.50(inc GST) will be charged to your
credit card. You can also call 1902 910 910 ($27.50
charged to your phone account) from 9:00 am to 5:00
pm, Monday to Friday. (Charges and support hours are
subject to change without notice.)

Austria 0660 6386
Belgium e Dutch: 02 626 88 06
e French: 02 626 88 07
Brazil e Sao Paulo: 11 3747 7799 or 11 4197 4998
e Qutside Sao Paulo: 0800 15 7751 or 0800 13 0999
Chile 800 36 0999
China 010 6564 5959 or 800 810 5959
Colombia 9 800 91 9477
Czech 02 471 7327
Republic
Denmark 39 29 4099
Finland 0203 4 7 288
France 0143623434
Germany 0180 52 58 143
Greece 01 6189890
Hong Kong 300 28555
Hungary 36 1 252 4505
India 9111 682 6035
Indonesia 21 350 3408
Ireland 01 662 5525
Italy 02 264 10350
Japan 0570 000511
Korea e Seoul: 02 3270 0700
e Outside Seoul: 080 999 0700
Malaysia 03 295 2566
Mexico ¢ Mexico City: 5258 9922

« Qutside Mexico City: 01 800 472 6684
New Zealand | 09 356 6640

Norway 22 11 6299

Peru 080010111
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Philippines 2 867 3551

Poland 22 37 5065 or 22 37 5065

Portugal 14417 199

Puerto Rico 1877 232 0589

Russia 095 923 50 01

Singapore 272 5300

Spain 902 321 123

Sweden 8 619 2170

Switzerland 08488011 11

Taiwan 2 2717 0055

Thailand 2 6614000

The 020 606 8751

Netherlands

Turkey 12165797171

United 0 207 512 5202

Kingdom

Venezuela e Caracas: 207 8488
¢ Outside Caracas: 800 10111

Vietnam 8 823 4530

call center numbers

calling from elsewhere in the world

Contact the local dealer or nearest HP Sales and Support Office for technical assistance or
hardware repair services.

Tour of the product hp confidential 1-31



support

customer sends unit directly to HP for Exchange or Repair

World-wide Repair Strategy: Standard Bench Repair (5-7 Days)
customer sends unit directly to HP for Exchange or Repair, or Customer takes unit to
Dealer/ASP and Dealer/ASP sends unit to HP for Exchange or Repair.

centralized repair service HP dealer/ASP
centers (e.g. CRCS, SME, AP
HUBS)
HP Exchange(FRU at product level) ¢ North * North
America America
* Middle East * Middle East
e latin America e latin America
e Europe e Europe
e Asia Pacific ¢ Asia Pacific
* Africa * Africa
HP Express Exchange(FRU at North America
product level)
Return to HP(Assembly Level Repair, ¢ North e Middle East
at PCA Level) America e Latin America
Middle East e Europe
e Latin America e Asia Pacific
e Europe e Africa
e Asia Pacific
* Africa
Pick-up and Return ¢ North * North
America America
Middle East Middle East
e latin America e latin America
e Europe e Europe
¢ Asia Pacific ¢ Asia Pacific
* Africa * Africa
HP Express Repair

customer sends/takes unit to at HP Bench

customer sends/takes unit to at HP Bench or ASP for Exchange or Repair.

non-centralized repair service| HP ASP
centers (e.g. Bench Repair,
ASP, Depot)
HP Exchange(FRU at product level) * North * North
America America
Middle East Middle East
» Latin America » Latin America
e Europe e Europe
* Asia Pacific * Asia Pacific
» Africa * Africa
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HP Express Exchange(FRU at North America

product level)

Return to HP(Assembly Level Repair * North * North

at PCA Level) America America
* Middle East * Middle East
e Europe e Europe
* Asia Pacific * Asia Pacific
» Africa » Africa

other support offerings

Response Center Support * North
America
* Middle East
e Latin America
e Europe
* Asia Pacific
» Africa
Mfg Division Support only * North
America
* Middle East
e Latin America
e Europe
* Asia Pacific
e Africa
Customer Support Center * North
America
* Middle East
e Latin America
e Europe

* Asia Pacific

Free Phone Support

Toll Phone Support

Email Support

POP(Parts Ordering Process) * North
America
* Middle East
e Latin America
e Europe
* Asia Pacific
e Africa

Repair and Return Parts Program

Replacement Parts Program

Self-Maintenance Program

Customer Self Repair
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Support Pack or E-Pack Offered * North
America
e Middle East
e Latin America
e Europe
» Asia Pacific
» Africa
CREW (Customer Replaceable End-User Warranty) * North
Program America
* Middle East
» Latin America
e Europe
* Asia Pacific
» Africa
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warranty
warranty

repair and warranty information

If the hp color inkjet printer cp1700 needs repair, customers are directed to an authorized
service provider or an hp facility. Repair services are free during the printer's limited warranty
period. If repairs are needed after the limited warranty period has expired, the customer is
quoted a repair cost.

duration of warranty period

hp product duration of limited warranty
hp color inkjet printer cp1700 1 year

Software 90 days

Accessories 90 days

Ink cartridges 90 days

Printer peripheral hardware 1 year

duration of limited warranty

Extent of limited warranty

Hewlett-Packard warrants to the end-user customer that the HP products specified above will be
free from defects in materials and workmanship for the duration specified above, which
duration begins on the date of purchase by the customer.
For software products, HP’s limited warranty applies only to a failure to execute programming
instructions. HP does not warrant that the operation of any product will be uninterrupted or
error free.
HP’s limited warranty covers only those defects that arise as a result of normal use of the
product, and does not cover any other problems, including those that arise as a result of:
 Improper maintenance or modification;
« Software, media, parts, or supplies not provided or supported by HP; or
» Operation outside the product’s specifications.
For HP printer products, the use of a non-HP ink cartridge or a refilled ink cartridge does not
affect either the warranty to the customer or any HP support contract with the customer.
However, if printer failure or damage is attributable to the use of a non-HP or refilled ink
cartridge, HP will charge its standard time and materials charges to service the printer for the
particular failure or damage.
If HP receives, during the applicable warranty period, notice of a defect in any product which
is covered by HP’s warranty, HP shall either repair or replace the product, at HP’s option.
If HP is unable to repair or replace, as applicable, a defective product which is covered by
HP’s warranty, HP shall, within a reasonable time after being notified of the defect, refund the
purchase price for the product.
HP shall have no obligation to repair, replace, or refund until the customer returns the defective
product to HP.
Any replacement product may be either new or like new, provided that it has functionality at
least equal to that of the product being replaced.
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HP products may contain remanufactured parts, components, or materials equivalent to new in
performance.

HP’s Limited Warranty Statement is valid in any country where the covered HP product is
distributed by HP. Contracts for additional warranty services, such as on-site service, are
available from any authorized HP service facility in countries where the product is distributed
by HP or by an authorized importer.

Limitations of Warranty

TO THE EXTENT ALLOWED BY LOCAL LAW, NEITHER HP NOR ITS THIRD PARTY SUPPLIERS

MAKES ANY OTHER WARRANTY OR CONDITION OF ANY KIND, WHETHER EXPRESS OR
IMPLIED WARRANTIES OR CONDITIONS OF MERCHANTABILITY, SATISFACTORY QUALITY,
AND FITNESS FOR A PARTICULAR PURPOSE.

Limitations of Liability

To the extent allowed by local law, the remedies provided in this Warranty Statement are the
customer’s sole and exclusive remedies.

TO THE EXTENT ALLOWED BY LOCAL LAW, EXCEPT FOR THE OBLIGATIONS SPECIFICALLY
SET FORTH IN THIS WARRANTY STATEMENT, IN NO EVENT SHALL HP OR ITS THIRD PARTY
SUPPLIERS BE LIABLE FOR DIRECT, INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL
DAMAGES, WHETHER BASED ON CONTRACT, TORT, OR ANY OTHER LEGAL THEORY
AND WHETHER ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

Local Law

This Warranty Statement gives the customer specific legal rights. The customer may also have
other rights which vary from state to state in the United States, from province to province in
Canada, and from country to country elsewhere in the world.
To the extent that this Warranty Statement is inconsistent with local law, this Warranty
Statement shall be deemed modified to be consistent with such local law. Under such local law,
certain disclaimers and limitations of this Warranty Statement may not apply to the customer.
For example, some states in the United States, as well as some governments outside the United
States (including provinces in Canada), may:
* Preclude the disclaimers and limitations in this Warranty Statement from limiting the
statutory rights of a customer (e.g. the United Kingdom);
» Otherwise restrict the ability of a manufacturer to enforce such disclaimers or
limitations; or
» Grant the customer additional warranty rights, specify the duration of implied
warranties which the manufacturer cannot disclaim, or allow limitations on the duration
of implied warranties.
FOR CONSUMER TRANSACTIONS IN AUSTRALIA AND NEW ZEALAND, THE TERMS IN
THIS WARRANTY STATEMENT, EXCEPT TO THE EXTENT LAWFULLY PERMITTED, DO NOT
EXCLUDE, RESTRICT, OR MODIFY, AND ARE IN ADDITION TO, THE MANDATORY
STATUTORY RIGHTS APPLICABLE TO THE SALE OF THE HP PRODUCTS TO SUCH
CUSTOMERS.
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completing the installation of the software for local connection ..............cooooiiiiiiiiinnenn, 49
startup page Of the CD BIrOWSEN......c..iee e e e e e e eens 52
changing t0 the CD-ROM AFIVE .. ... et e e eans 55
typing install to install the printer SOfWaArE.........c.cuiiiiiii e 55
identifying the language version Of DICP ... 56
opening the Printers WINAOW .........iuiiiiie e e e e e e e e e e e e e e e e eneeens 57
accessing the Add Printer WIZArd ..........o.ooiioi e e e e 58
selecting the Local Printer OPtION ... ...cuiii e e e e e eae e eens 58
SEleCting the PrINTEr POI ... ..ttt et et e e e e e e e e e eens 59
selecting the printer MaNUFACIUIET .........vuie e e e e e e ens 59
selecting the model Of the PrINtEr ... ... e 60
inserting the INStallation diSK ..........oouiiuiiii e 60
specifying the location of the hpL700K.inf file ... 61
specifying whether to keep or replace the existing driVer .........ccccoviiiiiiiiiir e 61
SPECITYING the PrINEr NAME. ...ttt e e e e e ens 62
specifying whether to share the Printer ..o e 62
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accessing the Printer SEIVEI PrOPEIIES .. ... e et ee e e e e e e e e e e e e e eaeens 73
ACCESSING the DIIVEIS 1D ...t e ea e eans 74
selecting the printer software to be uninstalled..............coeiii i 75
changing t0 the CD-ROM AFIVE .. ... et e e eans 76
typing install to install the printer SOfWaArE.........c.cuiiniiiii e 76
selecting the language Version Of DICP. ... ... e ens 77
opening the Printers WINAOW .........iuiiiee e e e e e e e e e e e e e e e e eneeens 78
accessing the Add Printer WIZArd ..........o.oo e e e e 79
selecting the Local Printer OPtION ... ...cuiiii e e e e e e e e e eens 79
SEleCting the PIINTEr POI .. ...ttt et et et e e e e e e e e e aens 79
selecting the printer MaNUFACIUIET .........v.ii e e e e e e e e ens 80
selecting the model Of the PrINtEr ... ... e 80
specifying the location of the hpL700K.iNf file .........oeeiieiii e 81
specifying whether to keep or replace the existing driVer ........ ..o, 81
SPECITYING the PrINtEr MAME. e i e e e e et et e e e e e e eaneens 82
specifying whether to share the Printer ... e 82
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completing the installation of the printer SOftWare..........ccoo i, 83
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lIftING the OULPUL traY . e ettt ettt et e e et e e e a e et et e e e enens 90
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hardware setup requirements

operating system

minimum operating
system requirements

target operating
system requirements

Windows 95/98

Pentium 60 MHz; 16-MB
RAM

Pentium Il 450 MHz; 128-

MB RAM; 200-MB hard
disk space

Windows ME

Pentium 150 MHz; 32-
MB RAM

Pentium Il 450 MHz; 128-

MB RAM; 200-MB hard
disk space

Windows NT 4.0
(service pack 4 and
above)

Pentium 60 MHz; 24-MB
RAM

Pentium Il 450 MHz; 128-

MB RAM; 200-MB hard
disk space

Windows 2000

Pentium 133 MHz; 32-
MB RAM

Pentium Il 450 MHz; 128-

MB RAM; 200-MB hard
disk space

Mac OS 8.6 or later

32-MB RAM
(USB/AppleTalk)

(iMac): 333 MHz; 64-MB
RAM (Power Mac G3 or
later): 350 MHz; 64-MB
RAM

Mac OS 8.6 or 9.x

32-MB RAM (IR)

hardware setup requirements

The hardware requirements for postscript are:
* Mac OS 8.6 and above: G3; 300 MHz
* Windows: Pentium lll; 350 MHz; 128-MB RAM

Note

The hardware setup requirements are specific for direct connect or peer-to-peer network. A
client server network requires higher setup specifications.

set up and configure
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contents of the box

o T=
contents of the box
 hp color inkjet printer cp1700: The printer is packaged in the box.

< Auto-duplex unit: An optional accessory to print on both sides of paper
automatically.

Note The auto-duplex unit is packaged with the hp color inkjet printer cp1700/d.

« Ink cartridge box: Contains four ink cartridges in the following colors:
* Black

e Cyan

* Magenta

* Yellow

* Printheads box: Contains four printheads in the following colors:
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* Black

e Cyan

* Magenta
* Yellow

Power cord: Used to connect the printer to a power connection.

country part name part number
Saudi Arabia 0 AC Cordset - Euro o 8120-6811
o AC Cordset - US 0 8120-6812
0 AC Cordset - UK o0 8120-8706
Czech Rep., Hungary, Poland, Portugal, | AC Cordset - Euro 8120-6811
Spain, Turkey
Norway, Finland, Sweden, Denmark AC Cordset - Euro 8120-6811
UK AC Cordset - UK 8120-8706
Europe - England, Russia, Greece, Israel, | AC Cordset - Euro 8120-6811
Croatia, Slovenia, Romania, Slovakia
Europe - England, France, Germany, AC Cordset - Euro 8120-6811
Netherlands, Italy
South Africa AC Cordset - South Africa 8120-8886
Australia, NewZealand AC Cordset - Aust 8121-0524
Thailand, Indonesia AC Cordset - Euro 81206811
India AC Cordset - India 8121-0564
Singapore, Malaysia, Vietnam, Hong AC Cordset - UK 8120-1351
Kong, NSC
Taiwan AC Cordset - US 8120-6812
Philippines AC Cordset - US 8120-6812
China AC Cordset - China 8120-8376
Korea AC Cordset - Korea 8121-0017
Japan AC Cordset - Japan 8120-6798
Us AC Cordset - US 8120-6812
Canada AC Cordset - US 8120-6812
LAR, Mexico, Brazil 0o AC Cordset - US o 8120-6812
o0 AC Cordset - Chilean 0 8120-6980
0 AC Cordset - o 8120-6869

Argentinean

power cord information

Starter CD: Includes the printer software and other optional software.

country part name part number
Saudi Arabia o Driver Kit - CD1 o (€8108-60077
o Starter CD - CD1 o (€8108-10001
Czech Rep.Hungary, Poland, Portugal, o Driver Kit - CD1 o (€8108-60077
Spain, Turkey o Starter CD - CD1 o (€8108-10001
Norway, Finland, Sweden, Denmark o Driver Kit - CD2 o (€8108-60078
o Starter CD - CD2 o (€8108-10002
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UK o0 Driver Kit- CD1 o €8108-60077
o Starter CD - CD1 o €8108-10001
Europe - England, Russia, Greece, Israel, | o Driver Kit - CD2 o (€8108-60078
Croatia, Slovenia, Romania, Slovakia o Starter CD - CD2 o (€8108-10002
Europe - Engand, France, Germany, o Driver Kit - CD1 o (€8108-60077
Netherlands, Italy o Starter CD - CD1 o (€8108-10001
South Africa 0 Driver Kit- CD2 o €8108-60078
o Starter CD - CD2 o €8108-10002
Australia, NewZealand o Driver Kit- CD2 o €8108-60078
o Starter CD2 o (€8108-10002
Thailand, Indonesia 0 Driver Kit- CD2 o €8108-60078
o Starter CD2 o (€8108-10002
India 0 Driver Kit- CD2 o €8108-60078
o Starter CD2 o (€8108-10002
Singapor, Malaysia, Vietnam, Hong o Driver Kit - CD1 o (€8108-60077
Kong, NSC o Starter CD - CD1 o (€8108-10001
Taiwan o Driver Kit- CD1 o €8108-60077
o Starter CD - CD1 o €8108-10001
Philippines o Driver Kit- CD1 o (€8108-60077
o Starter CD - CD1China o (€8108-10001
China 0 Driver Kit - CD2 o €8108-60078
o Starter CD2 o (€8108-10002
Korea o Driver Kit- CD2 o €8108-60078
o Starter CD2 o (€8108-10002
Japan 0 Driver Kit - CD2 o (€8108-60078
o Starter CD2 o (€8108-10002
us o0 Driver Kit- CD1 o €8108-60077
o StarterCD 1 o (C8108-10001
Canada o0 Driver Kit- CD1 o €8108-60077
o StarterCD 1 o (€8108-10001
LAR, Mexico, Brazil o Driver Kit- CD1 o €8108-60077
o StarterCD 1 o (C8108-10001

starter CD information

Setup poster: A detailed, graphical roadmap on the setup procedure.

country part name part number
Saudi Arabia Roadmap C8108-90001
Czech Rep., Hungary, Poland, Portugal, Spain, Turkey Roadmap C8108-90001
Norway, Finland, Sweden, Denmark Roadmap C8108-90001
UK Roadmap C8108-90001
Europe - England, Russia, Greece, Israel, Croatia, Roadmap C8108-90001
Slovenia, Romania, Slovakia

Europe - Englland, France, Germany, Netherlands, Italy Roadmap C8108-90001
South Africa Roadmap C8108-90001
Singapore, Malaysia, Vietnam, Hong Kong, NSC Roadmap C8108-90001
Taiwan Roadmap C8108-90001

hp confidential
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Philippines Roadmap C8108-90001
China Roadmap C8108-90001
Korea Roadmap C8108-90001
Japan Roadmap C8108-90001
us Roadmap C8108-90001
Canada Roadmap C8108-90001
LAR/Mexico/Brazil Roadmap C8108-90001

setup poster information

Reference guide: Includes information to set up the printer and install the printer software:

country part name part number
Saudi Arabia 0 Reference Guide - UGFIDA o €8108-90002
0 Regulatory Guide - UGFIDAPS| o (€8108-90008
Czech Rep., Hungary, Poland, 0 Reference Guide - PCHSPT o C8108-90003
Portugal, Spain, Turkey 0 Regulatory Guide - CHPT o (€8108-90024
0 Regulatory Guide - UGFIDAPS| o €C8108-90008
Norway, Finland, Sweden, Denmark | o Reference Guide - NFSD o €8108-90005
0 Regulatory Guide - NFSD o (€8108-90011
UK 0 Reference Guide - U o (€8108-90006
0 Regulatory Guide - UGFIDAPS| o €C8108-90008
Europe - England, Russia, Greece, 0 Reference Guide - UGRHCSRS| o (€C8108-90007
Israel, Croatia, Slovenia, Romania, 0 Regulatory Guide - o €8108-90010
Slovakia URGHCSRS
Europe - English, France, Germany, 0 Reference Guide - UGFIDA o €8108-90002
Netherlands, Italy 0 Regulatory Guide - UGFIDAPS| o (€8108-90008
South Africa 0 Reference Guide - UGFIDA o €8108-90002
0 Regulatory Guide - UGFIDAPS| o (€8108-90008
Australia, NewZealand 0 Reference Guide - UTCI o €8108-90023
0 Regulatory Guide - UTCI o (€8108-90021
Thailand, Indonesia 0 Reference Guide - UTCI o €8108-90023
0 Regulatory Guide - UTCI o0 (€8108-90021
India 0 Reference Guide - UTCI o €8108-90023
0 Regulatory Guide - UTCI o (€8108-90021
Singapore/Malaysia/Vietham/Hong | o Reference Guide - UTCI o (€8108-90023
Kong/NSC 0 Regulatory Guide - UTCI o (€8108-90021
Taiwan 0 Reference Guide - UTCI o €8108-90023
0 Regulatory Guide - UTCI o (€8108-90021
Philippines 0 Reference Guide - UTCI o €8108-90023
0 Regulatory Guide - UTCI o (€8108-90021
China 0 Reference Guide - USCKJ o (€8108-90022
0 Regulatory Guide - USCKJ o €8108-90020
Korea 0 Reference Guide - USCKJ o (€8108-90022
0 Regulatory Guide - USCKJ o €8108-90020
Japan 0 Reference Guide - USCKJ o (€8108-90022
0 Regulatory Guide - USCKJ o €8108-90020
set up and configure hp confidential 2-
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us o0 Reference Guide - U o (C8108-90006
0 Regulatory Guide - UGFIDAPS| o €C8108-90008
Canada 0 Reference Guide - UFPS o C€8108-90018
0 Regulatory Guide - UGFIDAPS| o €C8108-90008
LAR/Mexico/Brazil 0 Reference Guide - UFPS o (C€8108-90018
0 Regulatory Guide - UGFIDAPS| o C8108-90008
reference and regulatory guide information
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printer

components on the basis of the types of SKUs

 hp color inkjet printer cp1700: Packaged with the base printer

* hp color inkjet printer cp1700ps: Packaged with the base printer and Adobe
PostScript 3 Software RIP

* hp color inkjet printer cp1700/d: Packaged with the base printer and auto-
duplex unit

steps to unpack the printer
1. Unpack the printer.

2. Remove the packing tape and any shipping material from inside the printer.

P,

set up and configure hp confidential 2-
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optional tray 2
Steps to unpack Tray 2

Tray 2 is an optional accessory that can be purchased separately. The steps to unpack
Tray 2 are:
1. Unpack the printer.

2. Remove the packing tape and any shipping material from inside the trays.
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auto-duplex unit

Steps to unpack the auto-duplex unit
1. Unpack the printer.

2. Remove the packing tape and any shipping materials from the auto-duplex unit.

set up and configure hp confidential
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overall setup procedure
check the box contents

setup Steps
procedure
Check the box 1. Identify and check the box contents of the printer.
contents
- " B
= =
= _ w‘iﬁ-‘gg. et
T - T &2

checking the box contents

check the box contents

unpack the printer and install tray 2

setup steps
procedure

Unpack the 1. Unpack the printer.

printer and 2. Remove the packing tape and shipping material from
install Tray 2 inside the trays.

(optional) 3. Toinstall Tray 2, position the tray at the location

where you want to place the printer.

4. Lift the printer and align the sides of Tray 1 with the
sides of Tray 2.

5. Set the printer over Tray 2.

unpacking the printer

unpack the printer and install tray 2
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install the auto-duplex unit

printer
cpl700/d)
(Optional with
hp color inkjet
printer cp1700
and hp color
inkjet printer
cpl700 ps)

setup Steps

procedure

Install the auto- 1. At the rear of the printer, push the buttons on both
duplex unit sides of the rear access panel. Then, slide the rear
(Available with access panel out.

hp color inkjet 2. Slide the auto-duplex unit into the rear of the printer.

NS

1 700d

_— =
ol e
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————
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installing the auto-duplex unit

turn on the printer

install the auto-duplex unit

setup steps

procedure

Turn on the 1. Connect the power cord to the printer and plug it in.
printer

turning on the printer

turn on the printer

set up and configure
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install ink cartridges

setup
procedure

Steps

Install ink
cartridges

1. Turn on the
printer.

2. Lift the ink
cartridge
door.

3. Remove
each ink
cartridge
from its

package and install each ink cartridge in its respective

color-coded socket.

installing ink cartridges

install ink cartridges

install printheads

setup Steps

procedure

Install 1. Ensure that the printer is turned on.
printheads 2. Lift the printhead cover.

3. Open the printhead access latch and first pull it forward
and then down. This releases the hook of the latch from
the carriage lock.

4. Lift and push the printhead access latch toward the rear of
the printer.

5. Remove the package and protective tape from each
printhead.

6. Insert each printhead in its respective color-coded socket.

installing printheads
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Install 1. Close the printhead access latch firmly so that the hook

printheads catches the carriage lock.

Close the printhead and ink cartridge covers.

3. Wait until the printer initializes the printheads. When
initialization is complete, an alignment page prints.

A

Note Ensure that paper is present in the printer before an
alignment page prints.

installing printheads

install printheads

load paper
setup steps
procedure
Load paper 1. Pull the tray out of the printer to load the paper.
pulling the tray out of the printer
set up and configure hp confidential
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Load paper 1. Slide the paper length and width guides to their outermost
positions.
2. Insert paper or transparencies into the tray.
3. Slide the paper length and width guides to fit against the
paper.
4. Reinsert the tray.
-;___"-'_"i;
_ e
—_—— = o = -
- _ LN A
loading paper
Load paper 1. To support paper larger than the legal size, locate the tray|
extension lock on the front left of the tray.
2. Slide the tray extension lock to the left and then release it.
3. Pull the tray out lengthwise.
EMTX T el 137X 15
loading paper larger than the legal size
Load paper 1. Insert paper or transparencies into the tray.
2. Reinsert the tray.

e

<

loading paper larger than the legal size
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Load paper

1.

resuming the print operation

Press the RESUME button to resume the print operation.

load paper
install the printer software
setup Steps
procedure
Install the printer 1. Install the printer software from the starter CD.
software

= i

installing the printer software

install the printer software

connect the interface cable

setup
procedure
Connect the

steps

interface cable

1. Connect the printer to the computer using:
0 USB cable or
o Parallel cable or
0 LIO module

2. Select the interface cable based on the operating system
used and the system configuration.

connecting the interface cable

overall setup procedure

set up and configure
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set the LCD language

The LCD panel displays messages in English, by default. You can set the printer to
display messages and print configuration pages in a different supported language. To
set the LCD language you can use the Toolbox or the LCD panel.

set the LCD language using the LCD panel

1. Ensure that the printer is turned off.
2. Hold down the CANCEL button and press the POWER button to turn on the printer in
a language-setting mode.

Note When the printer turns on, the LCD displays the current language.

3. Press the CANCEL button to scroll through the language list.
4. Press the RESUME button to confirm the language selected.

set the LCD language using the Toolbox

1. Ensure that the printer is turned on.
2. Select the Start -> Programs -> HP Color Inkjet CP1700 -> HP Color Inkjet
CP1700 Toolbox menu command to open the Toolbox.

3
B st Messerqer Serace

r.;-_.}mam

(=) ho busiress inkpst prinker 2600 series ¥
-1

accessing the toolbox
3. Select the Printer Services tab.
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Align Prirtheads

Clean Printheads:

Calbrate Color

Teast Pintar Communication

]
i
]
_| Frinta Damo Pags
Bl
Il

Set Language For LCD Panel

printer services tab
4. Select the Set Language for LCD panel option to set the required language.

|

To change the language in which pou wank the:
meszages bo appear, select a different
language from the kst of supported languages

provided.
\ : AR N0 Bive s i seliction sod ehckad

the OK button, the prinber resumes its nomal
furschionz with the: news language in effect.

Set Language For LCO Pane! [N ~)
o] Cancel |

set language for LCD panel option
5. In the Set language for LCD panel dialog box, select the required language from
the Set Language for LCD panel combo box.

set up and configure hp confidential 2 -
23



% Set Language For LCD Panel

Ta change the language in which pou want the
messages to appear, select a diferent
larguage from the Est of zupported languages
provided.

Aftes you have made pour selection and clicked
the: QK button, the prinbes resumes ite normal
funchions with the new language in elfect.

set the required language

hp confidential
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install tray 2
Steps to install tray 2

Tray 2 is an optional accessory for the hp color inkjet printer cp1700. The steps to install
tray 2 are:

1. Position Tray 2 where the printer is to be placed. The printer is designed to rest
directly on top of the tray.

set up and configure hp confidential 2-
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install the auto-duplex unit

Steps to install the auto-duplex unit

To install the auto-duplex unit, remove the preinstalled rear access panel.

1. At the rear of the printer, push the buttons on both sides of the rear access panel.
Then, slide the rear access panel out.

Warning Do not press the buttons on either side of the auto-duplex unit during installation. This
—may disrupt the installation process.

remove the rear access panel
2. Slide the auto-duplex unit into the rear of the printer.

slide the auto-duplex unit
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hp JetDirect print server

hp JetDirect print server

hp JetDirect print server/Internet connector LIO module
The printer can be shared in a network environment by using an LIO module. The LIO
module can be used in a client-server or peer-to-peer network.
The LIO module provides:

* Networking capabilities

« Internet connectivity
The LIO module is an optional accessory that you can purchase.
The hp JetDirect 200m/250m print server is a low-end input/output (LIO) module that
plugs into the LIO slot of the printer and provides networking for the printer. It utilizes
10/100Base-Tx Ethernet networking technology and comes with Status and Link-speed
LEDs, and a Test/Reset Button.
The hp JetDirect 200m/250m print server helps small businesses and small workgroups
share hp printers with LIO connectivity slots on a network. By connecting their printer to
the Internet with this print server, workgroups can use a variety of current and future
printing e-services and other distributed printing services.

differences between hp JetDirect 200m and hp JetDirect 250m

The hp JetDirect 200m and the hp JetDirect 250m are very similar. The main difference

between the two print servers is 250m’s greater versatility. Both the print servers support
recent Microsoft and Apple network operating systems. However, the hp JetDirect250m
also supports Novell, Linux, Unix and several other Network operating systems and the

250m is upgradeable via flash memory downloads using the hp Download Manager.

set up and configure hp confidential 2-
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install ink cartridges

identifying the part numbers and part names of ink cartridges

part name part number
Black ink cartridge C4840A
HP No. 10 Black ink cartridge C4844A
HP No. 11 Cyan ink cartridge C4836A
HP No. 11 Magenta ink cartridge | C4837A
HP No. 11 Yellow ink cartridge C4838A

part numbers and part names of ink cartridges

installing ink cartridaes

1. Turn on the

turning on the printer
2. Lift the ink cartridge door.

lifting the ink cartridge door
3. Remove each ink cartridge from its package, and install each ink cartridge in its
respective color-coded socket.
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installing the ink cartridge
4. Press each ink cartridge firmly to ensure proper contact after installation.

ensuring proper installation

guidelines for maintaining ink cartridges

» Keep the ink cartridges sealed in the original packaging until you are ready to
use them.

» Keep the opened ink cartridges in the printer or sealed in a plastic bag.

 Use the first-in first-out inventory process to avoid having expired ink cartridges in
stock.

« Store ink cartridges at room temperature.

identifying the expiration dates

set up and configure hp confidential 2 -
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« Install-by Date: Printed on the retail box for ink cartridges. Install by this date for
optimized performance.

« Manufacture Date: Printed on the pouch for ink cartridges. The number is in the
following format: YYMMDDhhmm. For example, an ink cartridge manufactured
on November 19, 1999 at 1:12 pm has a Manufacture Date of 9911191312.

« End-of-Warranty Date: Printed directly on ink cartridges. It marks the end date of
the warranty period for ink cartridges.
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install printheads

identifying the part numbers and part names of printheads

part name part number
HP No. 11 Black Printhead C4810A
HP No. 11 Cyan Printhead C4811A
HP No. 11 Magenta Printhead C4812A
HP No. 11 Yellow Printhead C4813A

part numbers and part names of printheads

Before installing the printheads ensure that you move the carriage to the docking

Warning -
position.

installing printheads

1. Ensure that the printer is turned on.
2. Lift the printhead cover.

lifting the printhead cover
3. Open the printhead access latch and first pull it forward and then down. This releases
the hook of the latch from the carriage lock.

set up and configure hp confidential 2 -
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opening the printhead access latch
4. Lift and push the printhead access latch toward the rear of the printer.

lifting the printhead access latch
5. Remove the package and protective tape from each printhead.
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removing the protective tape
6. Insert each printhead in its respective color-coded socket.

inserting the printhead
7. Press each printhead firmly to ensure proper contact after installation.

set up and configure hp confidential
33



ensuring correct installation
8. Close the printhead access latch firmly so that the hook catches the carriage lock.

closing the printhead access latch
9. Close the printhead and ink cartridge covers.
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closing the printhead and ink cartridge covers
10. Wait until the printer initializes the printheads. When initialization is complete, an
alignment page prints.

Note If an alignment page does not print, ensure that the printer is loaded with paper.

printhead initialization

guidelines for maintaining printheads

« Keep the printheads sealed in the original packaging until you are ready to use
them.

« Keep the opened printheads in the printer or sealed in a plastic bag.

« Store printheads at room temperature.

« Power off the printer by pressing the Power button. Do not power off the printer
by unplugging the power cord. Powering off with the Power button returns the
Carriage to the Service Station. The Service Station caps the printhead ink
nozzles to prevent them from drying.

identifying the expiration dates

« Install-by Date: Printed on the retail box for printheads. Install by this date for
optimized performance.

« Manufacture Date: Printed on the pouch for printheads. The number is in the
following format: YYMMDDhhmm. For example, a printhead manufactured on
November 19, 1999 at 1:12 pm has a Manufacture Date of 9911191312.

* End-of-Warranty Date: Printed directly on printheads. It marks the end date of the
warranty period for printheads
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media type matrix

media type tray 1 | tray 2 | front rear
manual manual
feed feed

Plain Paper Yes Yes Yes Yes

Inkjet Paper Yes Yes Yes

Photo Paper Yes Yes Yes

Transparency Film Yes Yes Yes

Special Paper Yes Yes Yes

(Bannerpaper,

restickables,iron

transferables)

Greeting cards, Yes Yes

including Hagaki cards

Index Cards Yes Yes

Brochure Paper Yes Yes Yes

media type matrix

The printer supports media ranging from 4 x 6 inches to 13 x 19 inches. The printer has

4 paper paths:
e Tray 1 (default tray)

» Tray 2 (optional accessory)

* Front manual feed
* Rear manual feed

hp confidential
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paper capacity and weight matrix

tray or | size or type of media weight capacity
bin
Tray 1 e Paper (Plain, Inkjet, e 16to Up to 150
Photo, Brochure paper) 36 Ib sheets
e Envelopes (60 to Up to 15
e Cards 135 envelopes
« Transparencies gsm) Up to 60
« 20to cards
24 b Up to 80
« 1101b transparen
index cies
Tray 2 e Plain paperupto 13 x| 16to 28 1Ib Up to 400
19 inches (60 to 105 sheets
gsm)
Front « Paper (All paper types e 16to Up to 10
manual supported by Tray 1) 36 Ib sheets
feed e Envelopes (60 to Up to 10
e Cards 135 envelopes
e Transparencies gsm) Up to 10
« 20to cards
24 |b Upto 3
« 1101b transparen
index cies
Rear » Paper (Plain, Inkjet, « 16to 1 sheet
manual Photo, Brochure paper) 72 b 1 envelope
feed » Envelopes (60 to 1 card
e Cards 270 1
» Transparencies gsm) transparen
e Special media e« 20to cy
24 b 1 sheet
e 1101b
index
Output All media types Up to 75 sheets
tray
Auto- Media up to 13 x 19 inches | 16to 36 Ib
duplex
unit

tray specifications

set up and configure
37

hp confidential



guidelines for loading paper

 Default paper size of Tray 1 and Tray 2: 8.5 x 14 inches (215.9 x 355.6 mm).

 Default tray: Tray 1.

« For paper that is smaller than the default size of paper for the trays: Adjust the
paper width and length guides in the required tray.

« For paper of sizes A3, 11 x 17 inches, and 13 x 19 inches/A3+: Extend Tray 1
and Tray 2.

« Media is always loaded in portrait orientation even when printing in landscape
orientation. Select the output orientation from the software used.

Note To prevent a paper jam, do not load more than one type of paper in a paper path.
Always remove the existing paper and realign the paper with new paper before loading.
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extend tray 1 or tray 2
Steps to extend tray 1 or tray 2

You need to extend the tray to load paper that is larger than the legal size. The steps to
extend tray 1 or tray 2 are:

1. Locate the tray extension lock on the front left of the tray.
2. Slide the tray extension lock to the left and then release it.

tray extension lock
To support paper up to 11 x 17 inches, pull the tray out lengthwise.

pull the tray out
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load the front and rear manual feed

load the front manual feed

1. Slide the paper width guide on the output tray to its outermost position.

sliding the paper width guide outward
2. Insert paper or transparencies into the front manual feed.
« Insert a maximum of 10 sheets of paper or 3 transparencies.
« Place the paper along the right of the front manual feed.

inserting media
3. Slide the paper width guide to fit securely against the paper.

sliding the paper width guide against the paper
load the rear manual feed

The steps to load the rear manual feed are:
1. Insert a single sheet of paper.
« Insert the paper in portrait orientation.
* Insert the paper to the left of the rear manual feed. The printer sensors activate
the rear manual feed mechanism.
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Note The paper should be placed with the print side facing upward.

inserting paper
2. Push the paper into the printer until it reaches the maximum depth. When the printer
sensors detect the paper, the printer pulls the paper further into the printer.

Note The printer sensors activate the rear manual feed mechanism after 2 seconds.

pushing the paper
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scrubber utility

The scrubber utility enables you to clean the system in the following situations:
« A failed uninstallation
e An unclean uninstallation

Note The scrubber utility is available only for Windows 2000 and Windows 98/ME.

* Reads the .ini file for all information.

« Deletes all printers using the driver specified.

« Deletes the printer driver and its dependent files.

« Deletes all the devices in the computer with the specified plug-n-play ID and USB
ID.

« Deletes all the .inf and .pnf files specified in the scrub.ini file.

* Deletes all oem*.* files in the inf directory.

« Deletes all the files specified in the DeleteFiles section.

Note To ensure a clean system, execute the uninstaller before using the scrubber utility.
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connectivity options

connection points in the rear of the printer
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print a demo page

print a demo page

Print a demo page

to perform the following activities:

* Check the printer setup.

e Check the printer hardware configuration.
You can print a demo page without connecting the printer to the computer and with only
a power supply connection. The demo page does not ensure that the computer and
printer are properly connected.

The steps to print a

demo page are:

1. Turn on the printer.

2. Press and holc
3. Hold the RESI
4. Release the Pt

hp color inkjet printer cp1700

high quality, wide-tormat printer
designed for small business
beautiful quality, quick
Achioen realistc photo quality wl'th'F PhosaREs Il ol
1éppm block and 14, Sppm color, Why woil

lower msl-por-ﬁgge
Indivigdual color ink corridges give you lewer cosi porpoge ond
kv irdervention role. Save mane.
wide-format and paper versatility
Pried upda 13" 19" /A 3+ on plasn ond photo poper,
ronspasencies and oord sock. You decide

LA

fnwaeat

e PR e

demo page

print a double-sided demo page

To check whether the printer is working with the auto-duplex unit, print a double-sided

demo page.

hp confidential
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Note Print a double-sided demo page with only a power supply connection by using the
CANCEL and RESUME buttons.

The steps to print a double-sided demo page are:

1. Turn on the printer.

2. Press and hold down the POWER button.

3. Press the CANCEL button three times.

4. Press the RESUME button once.

5. Release the POWER button to print a double-sided demo page.
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install the printer software

printer software

Printer software enables the computer to communicate with the printer. If you do not
have access to a CD-ROM drive, download the printer software and other updates from
the Internet at the following address:
www.hp.com/support/clp1700.
The following Windows operating systems support the printer software:

* Windows 95

* Windows 98

* Windows Me

e Windows NT 4.0

* Windows 2000
You must have administrator privileges to install a printer driver on a computer running
the Windows NT 4.0 or Windows 2000 operating systems.

It is recommended to install the printer software before connecting the printer to the
computer.

Note

steps to install the printer software

1. Start Windows and ensure that no Windows applications are running.

2. Insert the starter CD into the CD-ROM drive. System Setup Wizard executes
automatically.

3. Click Install Printer Driver on the starter CD menu.

4. Select the language of the printer software and click OK.

Note The software is installed in the language that you select in Windows Control Panel.

(1010 1 [1L] 1 - E!
&L Srlartthe language forthis installatinn from the
=g 2 rhmicrac ol e

ﬁilMﬂ

Ik Cancel

selecting the language
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5. Click Yes to accept the terms of the license agreement.

[x

ey | e fow P « s qde 5 == f < .
% Hieasa raad the I‘Clllﬂ'n.'l'lﬂg liCErse agmgmgnl LIz thie scroll bar to wview the entire

agrsumsnt

WTTENTION: USE OF THE SOFTWARE IS SUBJECT TO THE HP SOFTWARE LICENSE ,:|
TERMS SET FORTH BELCW. USING THE SOFTWARE INDICATES YOUR ACCEFTANCE
OF THESE LICENSE TERMS. IFYOU DO NOT ACCEPT THESE LICENSE TERMS, YOU

MUST RETURN THE SOFTWARE FOR A FULL REFUND. IF THE SOFTWARE |5 SUFFLIED
I TH ANOTHER PRODUCT, Y'0OU MAY EETURN THE ENTIRE UNUSED FRODUCT FOR A

FULL REFUIND.

The foliowing Licensa Tarms gowvemn your usa of the accompanying Sofiwane unless vou have a

=

Do you accept the tems of the praceding license agreement? If so, click Yas. Ifyou select No,
Setup wil close.

accepting the terms of license agreement
6. If the printer is set up for local printing, click Connected to this computer and

click Next . If the printer is set up for network printing, continue with step 9.
T xl

Fiease selact how vour onnterwill be connected:

! * Connected to this computar

G

(2.0 parallel cable, USE cable or IR)

 Connectad to the netanrk

(e.g. the printer is connected directhy 1o the network or
shared through anoiher comouter on the network]

< Back ! Meod » ! Cancel !

setting up the printer for local printing
7. Select the type of cable to connect the printer to the computer in the Cable Type
Selection window and click Next .
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Note

| ) 77 T
&d| Seieciihe poriyou wani to use wiith this printer:
L port F

1

. ——
@ Parsliel  |AZARN =]

¥ Express Install usina HF recommended defaults

" Other. \Uocuments and Setr -ij

- P I o m 1 - x
£ Back I Plont s I Cancol i

selecting the type of cable
8. To complete installing the software for a local connection, click the Finish button.
9. If the printer is set up for network printing, click Connected via the network and
then click Next .
10. Click Connected to this computer if the printer is connected to a server or to
another computer.
« Click Basic Server or Peer-to-peer Network Setup to create a connection
to the printer attached directly to the network.
« Click Client Setup if the printer is setup as a shared printer on the network and
is managed by a server or another computer.
11. To complete installing the software for network connection, follow the instructions
that appear on the screen.

You can also install the printer software by using the Add Printer wizard.
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[
N
_.

= |

The required files foryour HF Color Inkjet TR 700 printer heose been

successiuliv insialled. inamoment vouwil be prompied io restar
Wnur compustar

Selectthe achons to nerdom when Setud finishes.

¥ Bun Wah Bagictratinn

¥ Installation Motes

o o= ]

completing the installation of the software for local connection
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contents of the software CD ROM

identifying the contents of the software CD ROM
The contents of the software CD ROM are:

e CD Shell

« Installer for PCL3 for Windows 9x, Windows NT, and Windows 2000 platforms
e Drivers: Windows, Mac, and ADI

» Toolbox

* Optional software: Print Creator and Acrobat
* Documentation: User Guide and Quick Tour
» Miscellaneous drivers and utilities for other operating systems:

* DOS DJCP
 Scrubber utility
« HP File Expansion utility

languages supported by CD 1

Europe NA AP
Windows e US English e US English e US English
driver e Portuguese(Brazilian) e Portuguese(Brazilian) e Portuguese(Brazilian)
e Euro-Spanish e Euro-Spanish e Euro-Spanish
e French e French e French
e ltalian e ltalian e ltalian
« German e German e German
e Dutch e Dutch e Dutch
e Polish e Polish e Polish
*» Czech e Czech e Czech
e Turkish e Turkish e Turkish
e Arabic « Arabic e Arabic
« Traditional Chinese « Traditional Chinese » Traditional Chinese
Mac e US English e US English e US English
driver e Portuguese e Portuguese e Portuguese
(Brazilian) (Brazilian) (Brazilian)
e Euro-Spanish e Euro-Spanish e Euro-Spanish
e Swedish e Swedish e Swedish
e French e French e French
e ltalian e ltalian e ltalian
¢ Germany e Germany e Germany
e Dutch e Dutch e Dutch
e Japanese e Japanese e Japanese
languages supported by CD 1 for Windows and Mac drivers
2-50 hp confidential set up and configure



languages supported by CD 2 for Windows and Mac drivers

Europe AP

Windows driver| US English e US English
Swedish ¢ Swedish
Norwegian * Norwegian
Danish e Danish
Finish e Finish
Russian e Russian
Greek e Greek
Hebrew e Hebrew
Japanese e Japanese
Korean e Korean
Simplified Chinese e Simplified Chinese

Mac driver US English e US English
Portuguese (Brazilian) e Portuguese (Brazilian)
Euro-Spanish e Euro-Spanish
Swedish e Swedish
French e French
ltalian e ltalian
Germany e Germany
Dutch e Dutch
Japanese e Japanese

languages supported by CD 2
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startup page of the CD browser

The startup page of the CD browser consists of the following buttons:
1. Install printer driver : Enables you to install the printer driver on the
computer.
2. Browse documentation : Enables you to view the contents of the following
documentation:
 Release notes
« User guide
e Setup poster
* Printer Web site
3. Register product : Enables you to link to the site http://register.hp.com to
register the printer and access service or support.
4. Customization utility: Enables you to copy the printer software onto disks, hard
drive or network drive.
5. Optional software: Enables you to install the following optional software:
* HP Web JetAdmin
e AutoCAD Driver
o IrPrint
e HP Photo Printing software
6. Quick tour : Enables you to access the following information related to the
printer:
« Expandability options
« Connectivity
» Smart software features

0 Wiimins

Euii

startup page of the CD browser
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software installation requirements

software installation requirement in Windows

* Windows 95

* Windows 98

* Windows Me

* Windows NT 4.0
* Windows 2000

software installation requirement in Macintosh

* USB port/IR port/LIO module
* Mac OS 8.6 and above
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install the Macintosh printer software
install the printer software for Mac OS X

Note Set up the printer before installing the printer driver in the Macintosh operating system.

1. Insert the starter CD into the CD-ROM drive.

2. Double-click the Installer icon for the Mac operating system.

3. To complete installing the printer driver, follow the instructions on the screen.

4. Connect the USB cable, containing the part number C6518A.

5. Launch the Print Center located in the applications:utility folder. The Print Center
automatically binds the printer driver.

install the printer software for Mac OS other than Mac OS X

1. Repeat steps 1 to 4 of the procedure to install the printer driver for Mac operating
system.

2. Select Chooser from the Apple menu.

3. Click the HP Deskjet xx Printer icon on the left of the Chooser window, where
XX represents the version of the current printer driver.

4. Select HP Color Inkjet CP1700 from the right of the Chooser window.

5. Close the Chooser window.

Use the USB cable, which is sold separately, to install the printer driver on the Macintosh
operating system.

Note
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install the software on DOS

DOS software installation steps

Before installing the DeskJet Control Panel on DOS, ensure that the printer is set up and
turned on.

1. Insert the starter CD into the CD-ROM drive.

2. At the DOS prompt, type the CD-ROM drive letter and press ENTER. Change the
directory to drivers\dos\<location>\ where <location> represents either Europe or
chi_tra.

U WINNT WS ystemi32 ol e xe

t Windows ZBHHA [Version H.00.21%%1]
right 19785-2000 Microsoft Cowrp.

GCzsood gisdeivershsdossEurope

changing to the CD-ROM drive
3. Type INSTALL and press ENTER.
U WINNT WS ystem32 ol e xe

ASEUROPE>install

typing install to install the printer software
4. Type the letter of the language version of DJCP to be installed from the language
menu displayed.
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identifying the language version of DJCP

hp confidential
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install the printer software using the add printer wizard

install the printer software for local printing using the add printer wizard

The steps to install the printer software local printing are:
1. Select the Start -> Settings -> Printers menu command.

.[@ﬂ Metscape SmartUpdate
.Iﬁ Dpen Office Document

[« =a]

M=

H [55:] Programs ¢
BTE

Kkl Documents 4
i Q-

B/

Settings N [« Contral Panel

Metwork and Dial-up Connections

E (3 Search

Sl Bl Frinters
N rep S Taskbar & Start Menu... |
- Fun...

I [ Shu it Mo
—I 1 o = E FEEIE, }}I .
Start || & & & Il
opening the Printers window
2. Double-click the Add Printer icon and click Next button.

r
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T @ Acrobat Distiller
Printars Bdr1on_BEDT An Asldt anabe-de 1 Doy

Add Printer

The &dd Printer wizard Qives
you step-by-step instructions for
installing a printer. To install &
new printer, double-click the
Add Printer icon.

\lindows 2000 Sunport

4| I

N

!1 object(s) selected

accessing the Add Printer wizard
3. Select the Local Printer option and click Next .
Add Printer Wizard

Local or Hetwork Printer
[z the printer attached to your compliter?

If the printer iz directly attached to vour computer, click Local prinker. [Fit iz attached to
another computer. or directly ta the network., click MNetwork printer.

* |ocal printer

I dutamatically detect and install mu Plig and Plag prinkes

" Metwork orirter

| — i
¢ Back ! Mext » ! Cancel !

selecting the Local printer option
4. Select the printer port and click Next .
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| o

Select the Printer Port
Computers communicate with printers through ports,

Select the port pow want your printer to uze. |F the part iz nat listed, you can create a
) Do,

£+ Uze the following port:

Port | Dezcription | Printer =
LPT3: Printer Part i
CO1: Serial Port |
COMZ: Sernial Port
COM3: Serial Part
kA A- Carizl Pt |

Mote: Most computers uze the LPT1: port bo communicate with a local printer.

" Create a new mork:
Tupe: Local Port j

1 i
¢ Back ! Mext » ! Cancel !

selecting the printer port
5. Select the manufacturer of the printer as HP.

. . [
Add Printer Wizard m’!
The manufacturer and model determing which printer to uze. \'

Select the manufacturer and model of waur printer. IF pour prinker came with an inzstallation
W dizk, rlick Have Disk IF your printer iz nnt izted, consolt yoor printer docomentation far A
compatible Drinter.

iy h

M anufacturers: Printers:
Epzon 1 | HP Color Inkjet CP1700 LI
Fuijitzu HF Busziness Inkjet 2600 PCL &C by
GCC | HP Business Inkjet 2600 PS5
Genernic Hewlett-FPackard HP-GL/Z Plotter
Gesztetner HF 2000C

HP | | HP 2500C Series 4
1P kd = ] HP 2R00 Carias P22 =

Windows Update ! Have Disk... !

| —| I
¢ Back ! Meut > ! Cancel !

selecting the printer manufacturer
6. Select the model of the printer as HP Color Inkjet CP1700 and click the Have Disk

button.
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. , e
Add Printer Wizard m‘!

The manufacturer and model determing which printer to uze. \

@ Select the manufacturer ahd model of your printer. [F pour prinker came with an installation
] dizk, rlick Have Disk IF your printer iz nnt izted, consolt yoor printer docomentation far A
compatible Drinter.

M anufacturers: Printers:
Epzon 1 | HP Color Inkjet CP1700 LI
Fuijitzu HF Busziness Inkjet 2600 PCL &C by
GCC | HP Business Inkjet 2600 PS5
Genernic Hewlett-FPackard HP-GL/Z Plotter
Gesztetner HF 2000C

HP | | HP 2500C Series 4
1P kd = ] HP 2R00 Carias P22 =

Windows Update ! Have Disk... !

| —| I
¢ Back ! Meut > ! Cancel !

selecting the model of the printer
7. Insert the installation disk.

nska pmn Disk m x|
1 Inzert the manufacturer's installation disk into the drive 0k |
[  szelected, and then click OF. |
Cancel |

Copy manufacturer's files from;

iG:HDrivers'xF'u:IS'xWinEkhE nalish ¥

[}
Browse... |
.| l—.

inserting the installation disk
8. Specify the location of the hp1700k.inf file in the Copy manufacturer file from
combo box, click OK , and click the Next button.
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1 Inzert the manufacturer's installation disk into the drive 0k |
[  szelected, and then click OF. |
Cancel |

Copy manufacturer's files from;

1 [}
| Browse.. |
|t

iG:HDriversHF‘clS'xWinEk"-.E hglish -

|

specifying the location of the hp1700Kk.inf file
9. Specify whether you want to use the existing driver or replace the existing driver and
click the Next button.

Usze Existing Driver m’!
&, driver iz already installed for thiz printer. Y'ou can use or replace the existing | [~=4F |
driver. Bl oEHE

HP T alar lal et TR 700

Do you want to keep the exizting driver or uge the new one?

' Keep existing diver [recommended)

" Reolace existing driver

Cancel

specifying whether to keep or replace the existing driver
10. Specify the printer name and whether the printer is to be set as default and click the
Next button.
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. e
Mame Your Printer | 73 |
ay

Y'ou must azzign a name for this prinker.

Supply a name far thiz printer. Some programs do not suppaort server and printer name
combinations of more than 31 characters.

Printer name:
e oy
IIIIEEIEI'IEIEIIIII]

Do wou want vour 'Windows-based orograms to use this printer as the default orinter?
" ‘ez
" Mo

1
& Rarl I bt I MManeal i

specifying the printer name
11. Indicate whether you want to share the printer and click the Next button.

i i )
Printer Sharing mﬂ

Y'ou can zhare thiz prinker with other netwark, users. \

Indicate whether you want thiz printer to be available to other uzers. |F vou share thiz
oiinter, you must provide a zhare name.

¥ Do nat share this printet

" Shareas: |
1

1
& Rarl I bt I Maneal i

specifying whether to share the printer
12. Specify whether you want to print a test page and click the Next button.
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} i
Print Test Page BEraa
To confirm that the printer iz ingtalled properly, vou can print a test page. @
Do wou want bo print a test page?
" Mo
— 1 1
s Rarl I blat I M ameal I

specifying whether to print a test page

13. Click the Finish button to complete the Add Printer wizard and install the printer

software.
| Add Printer Wizard

T

Completing the Add Printer
Wizard

O
EEEEE

Y'ou have succeszsfully completed the Add Printer wizard.

“'rny sperified the Fallmwing prinker sethings

M arne: HPF Color Inkjet CP1700
Shared asz <Mt Sharrd:

Port: LPTZ:

b odel: HP Calar Inkjet CP1700
Drefault: Yes

Test page:  “es

To cloge thiz wizard, click Finizh.

¢Back 1i  Firish i Cancel |

completing the installation of the printer software
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browse documentation

browse documentation
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register product

You can register the product by clicking the Register Product button in the startup
page in the Starter CD. On clicking the Register Product button, the following web
site is
displayed:http://register.hp.com/servlet/\WebReg.servlets.EntryServlet?applD=java_wre
g_wreg_genpg
By registering the product you can have access to:

1. Enhanced customer service
Faster expert technical support
Timely notices of product and software upgrades
Free newsletters with exclusive tips and tricks
Special offers specific to your needs
Create a profile
Update your existing profile
; b regEstration - Microsoft Intermet Explorer _Ig XI’
| Fle Edt Vew Favorfes Took b ' :
Ia-:m-- @ E A Pseadh GFowtes JHeny (D3 A-H28
o oy ereerep—r— T ————————————— L

b LAETED STATEY

registration

NoorwN

me:'iflﬂlﬂ'l -I

mnﬂlnwudemmﬁﬁemnuu:m
T

HF of COMATaliibd 10 DIOttEng pons’ Brreddy . Tioupr snfgrrnation will not be shared outade HP's
confracted supplers unless you give your consent. (M2 Srrvscy S5 atermens])

- |
11 (6 fems remaining) Downloading pickre hip:fregser fponsevierch) | | (@ bemet
register the product
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customization utility

The starter CD contains a utility to copy the printer software to a hard drive or a network
drive. To copy disks while executing Installer, select Customization Utility. Install the
printer software from the location where the files are copied. Perform the following
activities by using the Customization utility:
e Copy the printer software onto disks
« Copy the printer software onto hard drive
« Copy the printer software onto network drive
Use the Customization Utility button to perform the following:
e Copy Printer Drivers only: Copy the printer drivers to selected media. The
resulting files can be used with the Add Printer Wizard of Microsoft.
« Create Customized Installer: Create an installer that is customized by language,
operating system, model, and components.
« Copy Entire Printing System Installer: Copy the printing system installer for
selected language to media apart from floppy disks, such as network drives.
O I~ x|

Select an Inztaller Customization option,

i_‘l *  Copy Printer Drivers Only |

Copies printer drivers to zelected media. The rezulting
files zan be used with Microsoft's Add Printer “izard.

F = <

E!'( Create Cuztomized |nstaller
Creates an interactive or silent [ho user input required)
inztaller customized by language, operating system|s),
modeliz] and components.

elf" Copy Entire Printing Systemn [nztaller |

Copies the Printing Systern installer for selected
language and operating zyztem(z] to media other than

Hammn dizk = e a shared Mehaark laeatinsl

1
| Mext » I Cancel i

customization utility

copy the printer software to a floppy disk or hard drive

1. Click the Customization Utility button in the starter CD.
Select the setup language from the Choose Setup Language dialog box.
Select the Copy Printer Drivers Only option and click the Next button.
Select the required language and operating system and click the Next button.
Select the components that you require to install and click the Next button.
Select the destination path for the driver.

« Select the 3.5”” Floppy Disks option to copy the printer software onto a floppy
disk.

o0k wnN
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7.

Select the Other Media option to copy the printer software onto the hard drive
and specify the destination path in the Destination Path text box.

Click the Finish button to complete copying the printer software onto the hard
drive or onto disks.

copy printer software to a network drive

1.
2.

©® N ORW

Click the Customization Utility button on the starter CD.

Select the required setup language from the Choose Setup Language dialog
box.

Select the Copy Entire Printing System Installer option.

Select the required language and operating system and click the Next button.
Select the components that you require to install and click the Next button.
Select the Other Media option.

Click the Browse button to display the Choose Folder dialog box.

Click the Network button to connect to a shared network folder.

Specify the network folder name in the Folder combo box and click the Finish
button.

. Click the OK button of the Choose Folder dialog box.
11.

Click the Next and the Finish buttons to complete copying the printer software
onto a network drive.
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optional software

You can install optional software by clicking the Optional software button in the startup
page in the starter CD. The following optional software is available with the printer:

* HP WeblJet Admin: You can download the HP WeblJet Admin software from the
Internet. The software is Web-browser based and is a printer management tool
for the network. On clicking this option, you can access the following URL:

http://pandi.itrc.hp.com/pdi/t3/CDA/SeriesDisplay/0,1953,27905,00.html?
product_type o0id=13037&currCatlD=Print+Servers+and+Network+Software%2
linstallation+%26+Management+Software&lsidebarLayld=79&rsidebarLayld=6
2

e AutoCAD driver: You can install the ADI driver for AutoCAD Release 13/14 to
support the printer. You can install Hewlett-Packard HP GL/2 drivers for
AutoCAD on the computer.

e IrPrint: You can download IrPrint for the printer to print from Palm ll, V, VII, and
other Palm OS devices. This utility enables robust printing from handheld devices.
On clicking this option you can access the following URL:
http://www.hp.com/support/cp1700.

 Photo printing software: You can install HP Photo printing software to create and
print photo album pages. You can use the photo printing software to perform the
following activities:

 Collect images

< Adjust images

» Save and print photographic images

hp color inkjet printer cp 1700
CD Browser

hp color inkjet printer cp1700

Install Prnber Doves

Dptional S oltwaie

Br Doc rali HF Web JetAdmin

Hsgieior Froduct Install AutoCAD® Diives

Customization Utility

L > Optional Software

HP Photo Printing Soflware

Optional software
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quick tour

You can identify the main features and highlights of the printer by clicking the Quick tour
button. The following information related to the printer is available:
« Key highlights: Provides the key highlights of the printer.
» Expandability options: Provides the various expandability options available for
the printer.
» Connectivity: Provides the connectivity options available with the printer.
* Smart software features: Provides the various software features available with the
printer.

P gl'i-r.'quif';ur
wide-format printer hp color inkjet printer
with individual ink cp1700 series

cartridges

| printer highlights _ ]
[ expandobitiry aptions ]
Ceomnecy )
| o software teatures ]
LD e
quick tour
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test the software installation

Perform the following steps to test the software installation:
1. Ensure that the interface cable is properly connected and the printer is turned
on.
2. Select the Start -> Settings -> Printers menu command.
Right-click the printer icon and select Properties .
4. On the General tab, click Print Test Page .

w
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uninstall printer software

uninstall the printer software using the uninstaller in Windows

Note To uninstall the printer software from the Windows NT 4.0 operating system, you require
administrator privileges.

1. Start the Windows operating system and ensure that no other Windows applications
are running.

2. Select the Start -> Programs -> HP Color Inkjet Printer cp1700 ->
Uninstaller menu command.

I
D) necooe s [
L
f. i ¥
i (54 - ofseen Compmriclioe = ]
ke L -
) ST
Rl ;L= e > |
Ined=
& R R wh Messenger senvice I ——
el <o ~— o - | —
b 4] Search > L) TH Checker |
= N o I e
B4 B FF Color Inkjet CP1700 %=, P Calor Inkjek CP 1700 UninsEsler
ﬁl ﬂ e, s l—l
.l?."j'l i Y 53 ho business inkjet printer 2600 serkes b b |
— —_—
= e >
@ shut cown.

[ listart || 2 @ S0 D ||
accessing the uninstaller
3. Click Next .
4. Select the components that you want to uninstall and click Next .
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Select the component(z] to uninztall. Click Mest to perform the
LnirEtall.

HP Color Inkjet CP1700 Toolbo: 4477 E

Selectall | Clearl

< Back I Mext = I Cancel

selecting the components to be uninstalled
5. Click the Finish button to complete the uninstallation procedure.

Uninstall Wizard Complete ﬂ
m The Uninstall Wizard successtully finished uninstalling HP Calor
'ﬁ Inkjet CF1700 printing system.

g/;

g Your computer needs to be restarted to complete uninstallation.

hi."‘-..

Firizh

completing the uninstallation procedure

uninstall the printer software using the Add printer wizard in Windows

1. Select the Start -> Settings -> Printers menu command.
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MNetscape Smartpdate

Programs 4

Cocuments L

@EE

Settings (=] Control Parel

2000 Professional

MNetwork and Dial-up Connections
% Search b :
Bl printers
& Help M Taskbar 8 Start Menu...
§ Fur...
§ E Shut Dowen,..

#MStart | D E L H ||

accessing the Add printer wizard
2. Select the File -> Server Properties menu command.

_ioj xi

J| File Edit “iew Favorites Tools  Help ﬁ
Il Server Properties aSearch LY Falders i
J Create Shorteut j ©Go

r Deleiz | Documents | Status | Co
E Eemname

g Froperiies i Ready

g 0 Ready

Cl

£ oee 0 Ready

CHP Business Inkjet 260... 0 Ready

CHP Business Inkjet 2580... 0 Ready

C@HP Color Inkjet CP1700 0 Ready

‘ | =
\J Displays properties for this server, v

accessing the printer server properties
3. Select the Drivers tab in the Print Servers Properties dialog box.
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& Print Server Properties

Formz I Portz  Drivers |.-'1'-.dvan|:ed|

@ 0130

Inztalled printer drivers:

21X

M ame | E revironmment |

W ersion

obePS Acrobat Distiller  Intel
HP Buzinesz Inkjet 2600...  Intel
HP Buzinesz Inkjet 2600...  Intel
HPF Color [nkjet CP1700 Intel
HP Lazenlet 4050 Series... Intel

wWindowz 2000

Wfindows 2000
Wfindows 2000
Wfindows 2000

Wfindowes MT 4.0 ar 2000

HF Lazerlet b Plus Intel Windowes 2000
Add... | R emowve | |lpdate | Properties. .. |
| (1] I Cancel | Spply |

accessing the Drivers tab
4. Select the HP Color Inkjet CP1700 from the Installed printer drivers list.
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& Print Server Properties x|

Formz I Portz  Drivers |.-'1'-.dvan|:ed|

@ 0130

Inztalled printer drivers:

M ame | E revironmment | W ersion |
AdobePS Acrobat Distiler — Intel Windowes 2000

HP Buzinesz Inkjet 2600...  Intel Wfindows 2000

HP Buzinesz Inkjet 2600...  Intel Wfindows 2000

HP Caolor [nkjet CF1700 Intel Wfindows 2000

HF Lazerlet 4050 Seriez...  Intel Windows MT 4.0 or 2000

HF Lazerlet b Plus Intel Windowes 2000

Add... | R emowve | |lpdate | Properties. .. |

| (1] I Cancel | Spply |

selecting the printer software to be uninstalled

uninstall the printer software in the Mac operating system

Uninstall the printer software from the Mac OS by using the Uninstall option of the
setup program.

1. Unplug the printer and restart the computer.

2. Insert the starter CD into the computer CD-ROM drive. The HP Printer Software
window is displayed. If the HP Printer Software window is not displayed, double-
click the icon for HP Printer Software.

3. Double-click the Installer icon.

4. Select Uninstall from the drop-down menu in the upper left corner of the main
installation dialog box.

5. Follow the instructions on the screen to complete the procedure for uninstalling the
printer software.
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install the software on DOS

-

CAWINNWSystemd S omdexe

Jim [ .
2 DOy i =2 H "
l 0

installing the software on DOS

Before installing the DeskJet Control Panel on DOS, ensure that the printer is set up and
turned on.

1. Insert the starter CD into the CD-ROM drive.

2. At the DOS prompt, type the CD-ROM drive letter and press ENTER. Change the
directory to drivers\dos\<location>\ where <location> represents either Europe or
chi_tra.

=100 xi

——

changing to the CD-ROM drive
3. Type INSTALL and press ENTER.

LSRN [ Sy SEE NS LTI _;

insta

typing install to install the printer software
4. Type the letter of the language version of DJCP to be installed from the language
menu displayed.

hp confidential set up and configure



selecting the language version of DJCP
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install the printer software using the add printer wizard

install the printer software for local printing using the add printer wizard

1. Select the Start -> Settings -> Printers menu command.

.[ﬁjﬂ Metscape SmartUpdate

-
.Iﬁ Dpen Office Document

=L}

ﬂ xs] Programs ¢
mE=E _ -
Bl "% Documents K
-y S

f

Search

Help

Fun...

LR

| Windows 2coolP
&
2
.
:

SMStart | HE ST >

—

opening the Printers window
2. Double-click the Add Printer icon and click Next .

o
o
m

dit View Favorites Took Heip |

| Fii

| #=gzck » = ~ 21| Disearch [LFolders (#Hisory | 2 2 X = | Ed~
|

I

J

|
pi—— x — |
P . _ |
ACICress 2] Printers w| a0 |
) S— i
N P | pocuments | status | com
L = 1 1
=] :
i, - &# Acrobat Distiller 0 Ready
Printars Befiri1 0n_BEDT me dal-dt OnAldnerde 1 Daady
Add Printer

The &dd Printer wizard Qives
you step-by-step instructions for
installing a printer. To install 3
newr printer, double-click the
Add Prirter icon,

\lindows 2000 Sunport

5
b

i'_'l obiect(s) selected
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accessing the Add Printer wizard
3. Select the Local Printer option and click Next .

Add Printer Wizard

Local or Hetwork Printer
[z the printer attached bo your computer?

If the printer iz directly attached to your computer, click Local printer. IF it i attached to
another computer. or directly ta the network., click MNetwork printer.

¢ Local printer
I Auteenatically detect and install rmg Phog and Play prinker

" Metwark orinter

| — i
¢ Back ! Mext » ! Cancel !

selecting the Local printer option
4. Select the printer port and click Next .

(Add Printer Wizard m

Select the Printer Port
Computers communicate with printers through ports,

Select the port pow want your printer to uze. |F the part iz nat listed, you can create a
) Do,

£+ Uze the following port:

Port I Dezcription I Printer Ig
LPTZ Printer Part |
CO1: Serial Port |
CO2: Serial Port
COk4A3: Serial Part
kA A- Carial Pt ~|
Mote: Most computers uze the LPT1: port bo communicate with a local printer.
" Create a new park:
Tipe; Local Port d
— 1 i
¢ Back ! Mext = ! Cancel !

selecting the printer port
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5. Select the manufacturer of the printer as HP.

Add Printer Wizard
The manufacturer and model determing which printer to uze.

©

Select the manufacturer and model of waur printer. IF pour prinker came with an inzstallation
dizk, click Have Dizk I your printer iz not listed, consult your printer docurmentation far a
compatible orinter.

i anufacturers: Printers:
Epzon 1 | HP Color Inkjet CP1700 LI
Fuijitau HF Buziness |nkjet 2600 PCL &C b
GCC ~— | HP Business nkjet 2600 PS5
Genernic Hewlett-Packard HP-GL/Z Plotter
Gestetner HF 2000C

EHF | _; | HP 2500C Series =
1P kd [l ] HP 2R00 Carias P22 =

Windows Update ! Have Disk... !

1 i
< Back ! Meut > ! Cancel !

selecting the printer manufacturer
6. Select the model of the printer as HP Color Inkjet CP1700 and click the Have Disk

button.
. . [
Add Printer Wizard m’!
The manufacturer and model determing which printer to uze. \'

5, Select the manufacturer and model of your printer. IF pour printer came with an installation
W dizk, rlick Have Disk IF your printer iz nnt izted, consolt yoor printer docomentation far A
compatible Drinter.

M anufacturers: Printers:
Epzon 1 | HP Color Inkjet CP1700 LI
Fuijitzu HF Busziness Inkjet 2600 PCL &C by
GCC | HP Business Inkjet 2600 PS5

Genernic Hewlett-FPackard HP-GL/Z Plotter

Gesztetner HF 2000C

HP | | HP 2500C Series 4
1P kd = ] HP 2R00 Carias P22 =

Windows Update ! Have Disk... !

| —| I
¢ Back ! Meut > ! Cancel !

selecting the model of the printer
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7. Insert the installation disk. Specify the location of the hp1700Kk.inf file in the Copy
manufacturer’s file from combo box, click OK , and click Next .

15043 o sk i x|
r_@ Inzert the manufacturer's installation disk inta the drive 0k |
= zelected, and then click OF.

Cancel |

Copy manufacturer's files from;

iG:HDrivers'ﬁF‘clS'ﬁWinEk'\English = i Browsze. .. i
.| I

specifying the location of the hp1700Kk.inf file
8. Specify whether you want to use the existing driver or replace the existing driver and
click Next .

Usze Existing Driver TR
&, driver iz already installed for thiz printer. Y'ou can use or replace the existing | [~=4F |
driver. Bl oEHE

HE T alar Lale et R 700

Do you want to keep the exizting driver or uge the new one?

¥ Keep existing driver [recommended)

" Reolace exizting driver

Cancel

specifying whether to keep or replace the existing driver
9. Specify the printer name and whether the printer is to be set as default and click
Next .
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. e
Mame Your Printer | 73 |
ay

Y'ou must azzign a name for this prinker.

Supply a name far thiz printer. Some programs do not suppaort server and printer name
combinations of more than 31 characters.

Printer name:
e oy
IIIIEEIEI'IEIEIIIII]

Do wou want vour 'Windows-based orograms to use this printer as the default orinter?
" ‘ez
" Mo

1
& Rarl I bt I MManeal i

specifying the printer name
10. Indicate whether you want to share the printer and click Next .

i i )
Printer Sharing mﬂ

Y'ou can zhare thiz prinker with other netwark, users.

‘:

Indicate whether you want thiz printer to be available to other uzers. |F vou share thiz
oiinter, you must provide a zhare name.

¥ Do nat share this printet

" Shareas: |
1

1
& Rarl I bt I Maneal i

specifying whether to share the printer
11. Specify whether you want to print a test page and click Next .
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1 " L1} =
} i
Print Test Page BEraa
To confirm that the printer iz ingtalled properly, vou can print a test page. @
Do wou want bo print a test page?
" Mo
— 1 1
s Rarl I blat I M ameal I

specifying whether to print a test page
12. Click Finish to complete the Add Printer wizard and install the printer software.

:
;
]

T

Completing the Add Printer
Wizard

ﬁ

4

HEHE W
MRS

Y'ou have succeszsfully completed the Add Printer wizard.

“'rny sperified the Fallmwing prinker sethings

M arne: HPF Color Inkjet CP1700
_ Shared asz <Mt Sharrd:

Port: LPTZ:

bodel: HF Colaor [nkjet CP1700

Drefault: Yes

Test page:  “es

To cloge thiz wizard, click Finizh.

: ; I
<Back |i  Finizh ] Cancel |

completing the installation of the printer software
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optional software

Install optional software by clicking the Optional software button in the startup page in
the starter CD. The following optional software is available with the printer:

* HP WeblJet Admin: Download the HP WebJlet Admin software from the Internet.
The software is Web-browser based and is a printer management tool for the
network. On clicking this option, you can access the following URL:

http://pandi.itrc.hp.com/pdi/t3/CDA/SeriesDisplay/0,1953,27905,00.html?
product_type o0id=13037&currCatlD=Print+Servers+and+Network+Software%2
linstallation+%26+Management+Software&lsidebarLayld=79&rsidebarLayld=6
2

* AutoCAD driver: Install the ADI driver for AutoCAD Release 13/14 to support the
printer. Install Hewlett-Packard HP GL/2 drivers for AutoCAD on the computer.

« IrPrint: Download IrPrint for the printer to print from Palm Ill, V, VII, and other
Palm OS devices. This utility enables robust printing from handheld devices. On
clicking this option you can access the following URL:
http://www.hp.com/support/cpl1700.

 Photo printing software: Install HP Photo printing software to create and print
photo album pages. Use the photo printing software to perform the following
activities:

« Collect images

* Adjust images

e Save and print photographic images

h'_'l ol -r'ul-ic:a‘l F'-r'ir'l'-': roep 1

CD Browser

Install Printer D iwvern

HF Web Jetfdmin

Browsze Documentation

Install AutoCAD® Driver

1 IFnnt

I HP Photo Printing Software I

Customization Wkility

Dphonal 5oftware

Duick Touwr

Optional software
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establish a network connection using the LIO module

Share the printer in a network environment by using an LIO module. The LIO module can
be used in a client-server or peer-to-peer network.

After installing the LIO module and setting up the network connection install the printer
software on the client computers. Install the software from the starter CD or by adding a
printer to the computer and browsing for the .inf file.

install a network printer on a client computer

1. Select the Start -> Settings -> Printers dialog box.
2. Doubleclick Add Printer.
3. When prompted:
* Click Network Printer in Windows 95/98/Me.
¢ Click Network Print Server in Windows NT 4.0/2000.
4. Type the network path of the shared printer and click the Have Disk... option
when prompted to select the printer model.
5. Click Browse and browse to the .inf file located on the starter CD.
6. Follow the on-screen directions to complete adding printer.
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hp file expansion utility

The hp File Expansion Utility is used for manually expanding the compressed file drivers.
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establish a network connection using the LIO module

You can share the printer in a network environment by using an LIO module. The LIO
module can be used in a client-server or peer-to-peer network.
After installing the LIO module and setting up the network connection install the printer
software on the client computers. You can install the software from the starter CD or by
adding a printer to the computer and browsing for the .inf file.
The steps to install a network printer on a client computer are:
1. Select the Start -> Settings -> Printers dialog box.
2. Double-click Add Printer.
3. When prompted:
¢ Click Network Printer in Windows 95/98/Me.
* Click Network Print Server in Windows NT 4.0/2000.
4. Type the network path of the shared printer and click the Have Disk... option
when prompted to select the printer model.
5. Click Browse... and browse to the .inf file located on the starter CD.
6. Follow the on-screen directions to complete adding printer.
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setup issues

symptom cause solution
Printer is not Power connection 1. Press and hold down the
responding faulty POWER button on the printer

for a few seconds.

2. After a brief printer startup, a
steady green light should
appear next to the button.

3. If the printer does not turn on,
ensure that the printer cable is
firmly connected to the
computer.

4. Ensure that the power cable is
connected to a working outlet.

5. If you still cannot turn on the
printer, you might have a faulty
power cable or LCD panel.

Incorrect driver e If you print when the printer is

installation turned off, an alert message
appears on the computer
screen.

e If the printer is turned off and no
message is displayed when
executing a print command, the
printer setup might be incorrect.

e To correct the printer setup,
reinstall the printer software.
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Incorrect .
hardware / .
accessories /
supplies
installation

Check the printer setup.
Ensure that the following
components are loaded
correctly:

0 Ink cartridges

o0 Printheads

o Paper
Ensure that all the printer covers
are closed.
Ensure that the tape is removed
from printheads.
Ensure that the paper is loaded
correctly into the tray.
Ensure that the paper is not
jammed in the printer.
Ensure that the printer is
selected as the default printer.
Ensure that Pause Printing is not
selected.

Incorrect network .
installation /
configuration

Ensure that the printer is
properly set up in the network
environment.

Check IP address.

Ensure that correct network
protocols are installed.

identifying and resolving

setup issues
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paper handling
identifying the printer paper paths

e Tray 1 (default tray): Holds a maximum of 150 sheets

» Tray 2 (optional accessory): Holds a maximum of 250 sheets

 Front manual feed: Holds a maximum of 10 sheets

e Rear manual feed: Holds one sheet
The printer supports paper ranging from 4 x 6 inches to 13 x 19 inches. The following
table lists the type of paper, including transparencies, which you can print from each

paper path.

media type tray 1 tray 2 front rear
manual manual
feed feed

Plain Paper Y Y Y Y

Inkjet Paper Y Y Y

Photo Paper Y Y Y

Transparency Film Y Y Y

Special Paper (Banner | Y Y Y

paper, restickables,

iron transferables)

Greeting cards, Y Y

including Hagaki cards

Brochure Paper Y Y Y

paper types supported by the printer
loading paper
loading paper in tray 1or tray 2

1. To load tray 1, lift the output tray.

lifting the output tray
2. To load tray 2, remove the tray completely by holding the handle under the front
of the tray and pulling the tray towards you.
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pulling tray 2
3. Press and slide the paper length guide and paper width guide to the outermost

positions.

Vo /
\". !'-, r /
/X

\I
.-"ig

I

sliding paper guides
4. To load paper larger than legal size, follow these steps to extend the tray:
« Locate the tray extension lock on the front left part of the tray.
« Slide the lock to the left, and then release it.

sliding the lock
« Pull the tray out lengthwise until it clicks into place. This extends the tray to
support media up to 13 x 19 in/A3+ in size.
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pulling out the tray
5. Fortray 1, place up to 150 sheets of paper or 30 transparencies (up to .58 in
or 15 mm thick) into the tray. For tray 2, remove the cover and place up to 250
sheets of paper (up to .98 in or 25 mm thick) into the tray.

inserting paper into tray 1
6. Press and slide the paper length guide and paper width guide until they fit
tightly against the paper.

sliding the paper guides
7. Lower the output tray to its original position.
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lowering the output tray
8. If you have removed tray 2:
 Replace the cover.
« Align the cover with the opening in the printer.
« Slide it back into place.
loading paper in the front manual feed

1. Slide the paper width guide on the output tray to its outermost position.

sliding the paper guides
2. Insert paper or transparencies into the front manual feed.
Place the paper along the right of the front manual feed.
4. Push the paper in until it reaches the maximum depth.

w

pushing the paper
5. Slide the paper width guide to fit securely against the paper.
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sliding the paper guides
loading paper in the rear manual feed

1. Insert a single sheet of paper. Insert the paper in portrait orientation.
2. Insert the paper to the left of the rear manual feed. The printer sensors activate
the rear manual feed mechanism.

inserting paper into the rear manual feed
3. Push the paper into the printer until it reaches the maximum depth. When the
printer sensors detect the paper, the printer pulls the paper further into the
printer.

pushing paper

printing on special media
printing on envelopes and cards

Print envelopes and cards from Tray 1 of the hp color inkjet printer cp1700 series
e Dimensions of media: 4 inches x 6 inches (101.6 x 152.4 mm) or larger.
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printing envelopes or cards from Tray 1

The steps to print envelopes or cards are:

1. Select the File -> Print menu command.

2. Click the Properties button to open the printer driver.

3. From the options on the Setup tab, select the paper type that you are using. For
example, if you are printing on HP glossy greeting card paper, select the HP glossy

greeting card p HP Color Inkjnt [PL7) Properties - R 1 il HH
4. Select the env Sep | Fawhae] Gl | S| .

B o EE
 Homal T Lindesgs ==
= I bimor bmage I'E

Fat

A &
s
[Pagei | Fota P Pirirg

I U ditereri lnst page 1= PratofEx
Pagoes Tpma ! 20001 200

gost & »
[ e ey et st gt 0|
Fagam Sim I™ Emlsta Lasmlet Hagn
Fiagabi o] (10001 2458 pum] E| rs M

HF ZoormSmgt I
Piuges Time .
|'|l|u'| :I :j
Faciogy Setrgs I
[k ] o | e |

selecting the paper type and paper size
5. Lift the output tray of the printer.

lifting the output tray
6. Remove all the papers from tray 1.

removing paper from tray 1
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inserting cards
8. Slide in the paper width and length guides to align with the edges of the envelopes or
cards.

sliding the paper guides
9. Lower the output tray.

lowering the output tray

10. Print the document.
tips for printing on envelopes

To avoid jams and wrinkled or torn output:
< Avoid envelopes that have:
« Slick finish, self - stick adhesives, or clasps.
« Thick, irregular, or curled edges.
* Avoid envelopes that are:
* Wrinkled, torn, or damaged.
» Use a sturdy envelope that weighs 16 to 27 pounds (56 to 95 gsm)
approximately.
« Use tightly constructed envelopes.
« Ensure the folds of the envelopes are sharply creased.
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printing on thick paper by using the rear manual feed

Use the rear manual feed of the printer to print on thick paper such as a card stock and
a photo paper.
Paper Weight:

* Up to 0.02 inches (0.4 mm) thick or 72 Ib (270 gm) in weight
Paper Dimensions:

e Minimum of 4 inches x 6 inches (102 mm x 152 mm)

e Maximum of 13 inches x 19 inches (330.2 mm x 482.6 mm)
If the auto - duplex unit is installed, the rear manual feed is not available. To restore the
rear manual feed, replace the auto - duplex unit with the rear access panel.

Note You can print only one sheet at a time when you use the rear manual feed.

Following are the steps to print using the rear manual feed:

1. Select the File -> Print menu command.

2. Click the Properties button in the Print dialog box to display the printer driver.

3. In the Setup tab of the printer driver, select the Rear Manual Feed option from the

Paper Tray lis I T B i £
4. Select the typ:  sue |Fasmess| coke | Seniees|
77 Privk Dty —— - Dibwtiory
& Begt * Pomrat
& Hewnal Lminoirs
« fan : e
[ Lise diffessnt st page: R Pt
Paper Topa . £ | 28001 2N
Theck [Pl P 2
| b s J Mugns
Praper Sz - [~ Emudste Lapslet Magn
[ 2 200 25 i 2| | St Mg
HP ZoomSmat
Pager Trar Copies: i_1:|
Ret Marnasl Feed E
Famgfeng |
0 | Cacd | Hen |

selecting the paper type
5. Click the OK button to close the printer driver.
6. Click the OK button to print.
7. Insert a single sheet of paper in portrait orientation into the rear manual feed.
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inserting paper in the rear manual feed
tips for printing by using the rear manual feed

« To print in landscape orientation, select the option in the software used.
« To remove the paper after inserting it into the rear manual feed, press the
CANCEL button. The printer ejects the paper and cancels the print job.
printing on transparencies

The steps to print on transparencies are:
1. Remove paper from tray 1.

removing paper from tray 1
2. Insert the transparencies with the rough side down and the adhesive strip pointing
forward into tray 1.

inserting transpararencies in tray 1
3. Slide the width and length guides to align with the edge of the transparencies.

sliding paper guides
4. Slide the tray back into the closed and locked position.
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sliding the tray back
5. Select the File -> Print menu command.
6. Click the Properties button in the Print dialog box to display the printer driver.
7. In the Setup tab, select the Best radio button from the Print Quality group box.

8. Select the Tre & HP Calar Inkjet CO1700 Properties - RC 1 H =] Type list box.
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selecting the transparency size
10. Click the OK button to close the printer driver.
11. Click the OK button to print the transparencies.
printing on custom - size paper

To print on custom - size paper from the front manual feed, use Tray 1, or Tray 2 of the
hp color inkjet printer cp1700 series.
If the application in use supports custom - size paper:
1. Set the size of the paper in the application.
2. Create the document.
3. Print the document.
If the application in use does not support custom - size paper:
1. Set the size in the printer driver.
2. Create the document.
3. Print the document.
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Note Note: You might need to reformat existing documents to print correctly on a custom - size

paper.

The steps to print on custom - size paper are:
1. Lift the output tray of the printer.

lifting the output tray
2. Remove existing paper from the trays.

removing paper
3. Insert the custom - sized paper into the required tray.

inserting custom - sized paper
4. Slide the width and length guides to the edges of the paper.
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sliding the paper guides

5. Lower the output tray.

6. Select the File -> Print menu command.
7. Click the Properties button in the Print dialog box to display the printer driver.
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selecting the paper size
10. Click the OK button to close the printer properties dialog box.

11. Click the OK button to print on a custom - size paper.
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printer features overview

The hp color inkjet printer cp1700 series printer has the following hardware components:
e control panel
* infrared lens
 paper input and output trays

control panel

The control panel consists of the LCD (Liquid Crystal Display) that displays information
regarding the current status of the printer and the buttons to perform basic printer
operations.

infrared lens

The infrared lens enables printing from an infrared device. For infrared printing, establish a
wireless connection between an infrared device and the printer.The infrared device projects
a beam on the printer during the information transfer process. When the information
transfer is complete, the beam turns off.

paper input and output trays

The hp color inkjet printer cp1700 series contains different paper trays for handling
different types of paper and media. The different types of paper trays are:
 Tray 1: This tray holds both A-size and B-size paper.
 Tray 2: This tray holds both A-size and B-size paper.
 Front manual feed: This tray holds paper and media that are manually fed into the
printer.
» Rear manual feed: This tray holds cards and any special type of printable media. This
provides a straight paper path
« QOutput tray: This tray collects the printed paper and media.
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LCD panel

The LCD panel displays information about the status of the printer. It also has buttons to
perform basic printer operations.

e control panel

* infrared lens

 paper input and output trays

LCD panel
The components of the LCD panel are:

1. CANCEL button: Cancels the current print job.

2. Resume light: Blinks whenever the printer requires user intervention, such as
clearing a paper jam or closing an open cover.

3. RESUME button: Resumes current print operation after temporary interruption, such
as adding paper to printer.

4. LCD: Displays messages relating to the current state of the printer and the ink levels
in the individual ink cartridges.

5. Power light: Blinks when the printer is initializing, canceling a job, or turning off.

6. POWER button: Controls the power to the printer. Press this button to turn on or off
the printer.

7. Infrared lens: Enables printing from an infrared device.
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canceling a print job

Cancel a print job by using:
 The LCD panel on the printer
« The printer icon on the desktop

canceling a print job by using the LCD panel

canceling a print job
The steps to cancel a currently processed print job by using the LCD panel are:
1. Press the CANCEL button on the LCD panel to clear the currently processed job.

Note Canceling a print job does not affect the jobs waiting to be processed.

canceling a print job by using the printer icon on the desktop

The steps to cancel a print job by using the printer icon on the desktop are:
1. Double-click the printer icon on the lower-right corner of the computer screen.
2. Select the print job that you want to cancel in the printer window.
3. Click the Document -> Cancel menu command to cancel the print job.
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internal diagnostic tests

printing a Diagnost |-
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diagnostic page
Information displayed on the Diagnostic page:
* Printer information: Firmware version number, Model, and Service ID
* Printhead information: Technical information on printhead performance
« Technical information: Technical information on printheads and ink cartridges
The steps to print a Diagnostic page are:
1. Press and hold down the POWER button.
2. While holding down the POWER button, press the CANCEL button once.

printing a self-test g~~~
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self-test page
A self-test page verifies if the:
* Printer is connected to the computer properly.
* Printer and printer software are functioning properly.
This page is not available entirely to the end-user. The service or call center staff must use

the hard copy of the self-test page.
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Note If the selftest page does not print, check the printer configuration.

The steps to print a selftest page is:
1. Press and hold down the POWER button.
2. While holding down the POWER button, press the RESUME button four times.

displaying printhead health

You can view the condition of the printheads. The condition of printheads is displayed on
the LCD in KCMY sequence.
The steps to display the printhead health are:

1. Press and hold down the POWER button.

2. While holding down the POWER button, press the CANCEL button thrice and the

RESUME button thrice.
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printing using IR connectivity

Perform infrared printing by establishing a wireless connection between an infrared device
and the printer.
Following are the steps to perform infrared printing from a handheld device or laptop:
1. Locate the infrared (IR) lens on the device or the laptop.
2. Align the device IR lens with the printer IR lens.
3. Position the device or laptop 1 meter (3 feet) from the printer and within a 30-
degree angle from the printer infrared lens.

Note The infrared device should not be more than 1 meter from the printer IR port.
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media and tray compatibility

identifying the printer paper paths

 Tray 1 (default tray): Holds a maximum of 150 sheets

* Tray 2 (optional accessory): Holds a maximum of 250 sheets
* Front manual feed: Holds a maximum of 10 sheets

* Rear manual feed: Holds one sheet

paper types supported by the printer

media type tray | tray | front rear
1 2 manual manual
feed feed
Plain Paper Y Y Y Y
Inkjet Paper Y Y Y
Photo Paper Y Y Y
Transparency Film Y Y Y
Special Paper (Banner paper, Y Y Y
restickables, iron transferables)
Greeting cards, including Hagaki | Y Y
cards
Brochure Paper Y Y Y
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printing on special media
printing on envelopes and cards

Print envelopes and cards from Tray 1 of the hp color inkjet printer cp1700 series.
» Dimensions of media: 4 inches x 6 inches (101.6 x 152.4 mm) or larger.

Note The hp color inkjet printer cp1700 series supports the printing of Hagaki cards.

tips for printing on envelopes

To avoid jams and wrinkled or torn output:
» Avoid envelopes that have:
« Slick finish, self-stick adhesives, or clasps.
* Thick, irregular, or curled edges.
 Avoid envelopes that are:
* Wrinkled, torn, or damaged.
» Use a sturdy envelope that weighs 16 to 27 pounds (56 to 95 gsm) approximately.
* Use tightly constructed envelopes.
« Ensure the folds of the envelopes are sharply creased.
The steps to print envelopes or cards are:
1. Select the File -> Print menu command.
2. Click the Properties button to open the printer driver.
3. From the options on the Setup tab, select the paper type that you are using. For
example, if you are printing on HP glossy greeting card paper, select the HP glossy
greeting card option as the paper type.
4. Select the envelope or card size from the Paper Size menu.

3-12 hp confidential use and maintain



& HP Color Inkjet CP1700 Properties - RC 1
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selecting the card size

5. Lift the output tray of the printer.

lifting the output tray
6. Remove all the papers from tray 1.

removing paper from tray 1
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7. Insert the stack of cards or envelopes into tray 1.

inserting cards
8. Slide in the paper width and length guides to align with the edges of the envelopes or
cards.

9. Lower the output tray.

lowering the output tray

10. Print the document.

printing on thick paper by using the rear manual feed

Use the rear manual feed of the printer to print on thick paper such as a card stock and a
photo paper.
Paper Weight:

e Up to 0.02 inches (0.4 mm) thick or 72 Ib (270 gm) in weight
Paper Dimensions:

e Minimum of 4 inches x 6 inches (102 mm x 152 mm)

* Maximum of 13 inches x 19 inches (330.2 mm x 482.6 mm)
If the auto-duplex unit is installed, the rear manual feed is not available. To restore the rear
manual feed, replace the auto-duplex unit with the rear access panel.
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Note Youcan print only one sheet at a time when you use the rear manual feed.

tips for printing by using the rear manual feed

« To print in landscape orientation, select the option in the software used.
» To remove the paper after inserting it into the rear manual feed, press the CANCEL
button. The printer ejects the paper and cancels the print job.

Following are the steps to print using the rear manual feed:

1. Select the File -> Print menu command.

2. Click the Properties button in the Print dialog box to display the printer driver.

3. In the Setup tab of the printer driver, select the Rear Manual Feed option from the

Paper Tray list box.

4. Select the type of the paper from the Paper Type list box.
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selecting the paper type
5. Click the OK button to close the printer driver.

6. Click the OK button to print.
7. Insert a single sheet of paper in portrait orientation into the rear manual feed.
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inserting paper in the rear manual feed

printing on transparencies

To print on transparencies, use:

* HP Premium Transparency films.

 Other transparency films designed for inkjet printers.
The steps to print on transparencies are:
1. Remove paper from tray 1.

removing paper from tray 1
2. Insert the transparencies with the rough side down and the adhesive strip pointing
forward into tray 1.

inserting transparencies in tray 1
3. Slide the width and length guides to align with the edge of the transparencies.

"_-il."‘.-"-'-."
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sliding paper guides
4. Slide the tray back into the closed and locked position.

sliding the tray back
5. Select the File -> Print menu command.
6. Click the Properties button in the Print dialog box to display the printer driver.
7. In the Setup tab, select the Best radio button from the Print Quality group box.
8. Select the Transparency Films option from the Paper Type list box.
9. Select the required size for the transparency from the Paper Size list box.
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selecting the transparency type
10. Click the OK button to close the printer driver.
11. Click the OK button to print the transparencies.

printing on custom-size paper

To print on custom-size paper from the front manual feed, use tray 1, or tray 2 of the hp
color inkjet printer cp1700 series.
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If the application in use supports custom-size paper:
1. Set the size of the paper in the application.
2. Create the document.
3. Print the document.
If the application in use does not support custom-size paper:
1. Set the size in the printer driver.
2. Create the document.
3. Print the document.

Note You might need to reformat existing documents to print correctly on a custom-size paper.

The steps to print on custom-size paper are:
1. Lift the output tray of the printer.

lifting the output tray
2. Remove existing paper from the trays.

removing paper
3. Insert the custom-sized paper into the required tray.

'-_-'i."--....,'_
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inserting custom-sized paper
4. Slide the width and length guides to the edges of the paper.
o —

sliding the paper guides
5. Lower the output tray.
6. Select the File -> Print menu command.
7. Click the Properties button in the Print dialog box to display the printer driver.
8. In the Setup tab, select the paper type from the Paper Type list box.
9. Select the appropriate size of the paper from the Paper Size list box.
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selecting the paper size
10. Click the OK button to close the printer properties dialog box.
11. Click the OK button to print on a custom-size paper.
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cleaning the printer

printer cleaning procedure

The hp color inkjet printer cp1700 series does not require scheduled maintenance.
However, you should clean the printer to keep it in peak condition. You can also diagnose
printer problems easily by cleaning the printer.
* To clean the case of the printer:
 Use a soft cloth moistened with water or water mixed with mild detergent
¢ To clean the inside of the printer
» Use a dry, lint-free cloth
Do not touch the rollers
The following are the steps to clean the printer:
1. Turn the printer off.

turning off the printer
2. Unplug the power cord.

unplugging the power cord
3. Open the top cover of the printer.

Warning Avoid reaching too far into the printer. The adjacent fusing area might be hot.
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opening the top cover of the printer
4. Clean dust or dirt from the paper feed guides by using a dry, lint free cloth.

cleaning dust from the paper feed guides
5. Close the top cover.
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closing the top cover
6. Plug in the power cord.

plugging in the power cord
7. Turn on the printer.

turning on the printer
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cleaning the printer

cleaning the hp color inkjet printer cp1700 series

* To clean the case of the printer:
* Use a soft cloth moistened with water or water mixed with mild detergent
* To clean the inside of the printer
* Use a dry, lint - free cloth
* Do not touch the rollers
The hp color inkjet printer cp1700 series does not require scheduled maintenance.
However, you should clean the printer to keep it in peak condition. You can also diagnose
printer problems easily by cleaning the printer.
The following are the steps to clean the printer:
1. Turn the printer off.

turning off the printer
2. Unplug the power cord.

-

unplugging the power cord
3. Open the top cover of the printer.

Warning Avoid reaching too far into the printer. The adjacent fusing area might be hot.
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opening the top cover
4. Clean dust or dirt from the paper feed guides by using a dry, lint - free cloth.

cleaning the paper feed guides
5. Close the top cover.
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closing the top cover

6. Plug in the power cord.
-

o

plugging in the power cord
7. Turn on the printer.

turning on the printer
Use the following guidelines to clean the hp color inkjet printer cp1700:
* To clean the case of the printer:
 Use a soft cloth moistened with water or water mixed with mild detergent.
* To clean the inside of the printer:
e Use a dry, lint - free cloth.
Do not touch the rollers.
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cleaning and maintaining printheads

Printheads require little maintenance. Typically, printheads last for one-and-a-half years.
Using a single printhead, you can print:

» 16,000 black and white pages

* 24,000 color pages
Ink nozzles might clog due to prolonged exposure to air, and result in incomplete printed
characters. To ensure proper printing and avoid incomplete printouts, the printheads must
be cleaned, aligned, or replaced. To perform these maintenance activities, use the toolbox
or the LCD panel. The toolbox is most frequently used to clean the printheads. The
printheads should be cleaned by using the LCD panel if:
The printer aligns printheads whenever you replace them. If the appearance of printouts
indicates improper alignment of printheads, you need to align the printheads. Align the
printheads by using the Toolbox or the LCD panel.

* The Toolbox is not installed.

» Use an Apple computer with a Macintosh operating system.
Perform three levels of cleaning by using the LCD panel. After each cleaning, the printer
prints a test page to check the print quality.

Note Clean printheads only when it is necessary because it wastes the ink and shortens the life of
printheads.

printhead maintenance

* Cleaning the printheads by using the LCD panel
* level-one cleaning
* level-two cleaning
« level-three cleaning
« Cleaning the printheads by using the toolbox
« Aligning the printheads
« aligning printheads by using the Toolbox
« aligning printheads by using the LCD panel
* replacing the printheads

level-one cleaning

The level-one cleaning is the quickest, it uses the least amount of ink as compared to the
other methods of cleaning.

The steps to perform level-one cleaning are:

1. Press and hold down the POWER button.
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pressing and holding the POWER button
2. Press the CANCEL button two times while holding down the POWER button.

pressing the CANCEL button with the POWER button pressed
3. Release the POWER button.

releasing the POWER button
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level-two cleaning

If the level-one cleaning is insufficient, perform the leveltwo cleaning.
The steps to perform leveltwo cleaning are:
1. Press and hold down the POWER button.

pressing the POWER button
2. Press the CANCEL button two times and the RESUME button once while holding down
the POWER button.

pressing the CANCEL and RESUME button with the POWER button depressed
3. Release the POWER button.
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releasing the POWER button
level-three cleaning

The level-three cleaning is the most comprehensive among the three levels of cleaning but it
consumes the maximum ink and time.

The steps to perform level-three cleaning are:
1. Press and hold down the POWER button.

pressing the POWER button

2. Press the CANCEL button two times and the RESUME button twice while holding down
the POWER button.
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pressing the CANCEL and RESUME button with the POWER button depressed
3. Release the POWER button.

releasing the POWER button

cleaning printheads by using the Toolbox

Using the Toolbox is the easiest way to clean printheads.

Note You need to install the Toolbox to use it.

The steps to clean printheads by using the Toolbox are:

1. Select the Start -> Programs -> HP Color Inkjet CP1700 -> HP Color Inkjet
CP1700 Toolbox menu command.

2. Click the Printer Services tab in the Toolbox.

3. Click Clean Printheads .
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%¢ HP Color InkJet CP1700 Toolbox

Printer Status | Information  Printer Services |

|HP Color Inkjet CP1700 on LPTZ =]

‘

Abgn Prntheads

Clean Prntheads
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Pt a Demo Page

Test Prnter Commurication

I TR N I 1

Set Language For LCD Panel

Hide | Ext Help

clicking the Clean Printheads button

aligning printheads by using the Toolbox

The steps to align printheads by using the Toolbox are:
1. Select the Start -> Programs -> HP Color Inkjet CP1700 -> HP Color Inkjet
CP1700 Toolbox menu command.

2. Click the Printer Services tab in the Toolbox.

3. Click the Align Printheads button in the Printer Services tab.
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aligning the printheads
4. Click the Align button in the Align Printheads dialog box to start the alignment
process.

1 Align Printheads _H

renlpsum Dolor pshesds o sach e
I+
‘\),‘I This will provide the best possible print qualy.

Although you may not nolice misalignment, it is
recommended that you perform an alignment sach
lamee poul replace & pimthesd.

starting the alignment process
aligning printheads by using the LCD panel

The steps to align printheads by using the LCD panel are:
1. Press and hold down the POWER button.
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pressing the POWER button
2. While holding down the POWER button, press the RESUME button on the LCD panel
thrice.
After the alignment process is over, the printer prints an alignment page.

replacing printheads

Replace a printhead when LCD displays a warning message.

Note Do not need to replace all the four printheads at once. Replace only the printhead that is
exhausted.

The steps to replace a printhead are:
1. Turn on the printer.

turning on the printer

2. Lift the printhead cover.
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lifting the printhead cover
3. Open the printhead access latch by lifting the latch from the rear.

opening the printhead access latch
4. Pull the latch forward and down to release the hook from the carriage lock.
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pulling the printhead access latch forward
5. Hold both ends of the printhead firmly and pull it up straight out of its slot.

pulling out the printhead
6. Install the new printhead in the color-coded slot that matches the color of the printhead.

installing the new printhead
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7. Press the printhead firmly to ensure proper contact.

pressing the installed printhead
8. Close the printhead access latch firmly to ensure that the hook catches the carriage lock.

closing the printhead latch
9. Close the printhead cover.
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closing the printhead cover
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control panel

The front panel serves two primary purposes. Firstly, it notifies the users on printer
operations (eg. printing, ready), requirement of user intervention (eg. out of paper, replace
printhead) and component status (eg. ink level status, print head health). Secondly, the front
panel will be used to drive second-order functions such as printing test pages, pen cleaning
and alignment. This is achieved through some unique key press sequences.
However, it will not be used to configure low-level information set in NVRAM or on LIO
cards. Low-level configurations of the IO cards will be provided by host software or its
equivalent, through the driver or through a combination of driver/firmware. The printer front
panel has a LCD display, two LEDs and three key buttons, which are the POWER, RESUME
and CANCEL buttons.
imﬂ;e key function
0 POWER | It is a momentary pushbutton that is used to control the
printer power. This is a "Hard On, Soft Off" switch, which
has direct control of the power supply when the printer is off.
However, it acts as an input logic to the firmware when the
power is on. It is used to initiate a power down sequence
instead of cutting of the power directly.
@ RESUME| This momentary pushbutton is context sensitive. Depending
on the state of the printer, pressing the RESUME button has
different effect on the printer. If a media related condition,
such as out of paper, has occurred, pressing this button will
cause the printer to resume its print operation. Together with
the POWER button, it can be used to invoke an internal
page or printhead related functions.
0 CANCEL A momentary pushbutton used to cancel current print job.
After the user presses the cancel button, the printer will eject
the current page; clears the buffer, and prepare for a new
print job.

front panel display states

The five display states are:
» normal operation
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e warning display

e user intervention
 unrecoverable error
* special display

Display State

POWER

RESUME

CANCEL

Normal Operating
State

Power off printer

Disabled

Cancels job if in
processing job state.
Eject page loaded
from rear manual feed
if in ready state.

Warning Display

Power off printer

Clears the current
warning

Cancels job if in
processing job state.
Eject page loaded
from rear manual feed
if in ready state.

User Intervention

Power off printer

Indicate to the printer
that the intervention is

complete (if required).

Cancels job if in
printing state

Unrecoverable Error| Turn power off Disabled Disabled
State
Special Display Turn power off Clear current display Disabled
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maintaining ink cartridges
printer cartridge maintenance procedure

1. Ink cartridges do not require maintenance.
2. Life of Ink Cartridge: An ink cartridge should print 1750 pages in black or color.
3. Checking status of ink cartridge: Use the Toolbox to check the status of the ink
cartridges. In addition, LCD displays a message when an ink cartridge exhausts
and needs to be replaced. Replace ink cartridges when the ink exhausts.
4. Tips for storing and maintaining ink cartridges:
 Keep the ink cartridges sealed in the original packaging until you use them.
» Keep the opened ink cartridges in the printer or seal them in a plastic bag.
« Store ink cartridges at room temperature.

Do not replace all four ink cartridges when one of them exhausts. Replace only the empty ink
cartridge.

Note

The steps to replace an ink cartridge are:
1.Turn on the printer.

turning on the printer
2. Lift the ink cartridge cover.
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lifting the ink cartridge cover
3. Remove the empty ink cartridge by holding it firmly between the thumb and the forefinger
and pulling it out.

removing the empty ink cartridge
4. Insert the new ink cartridge into the color-coded slot that matches the color of the ink
cartridge.
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pressing the new cartridge
6. Close the ink cartridge cover.

hp confidential
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closing the ink cartridge cover
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changing default hardware settings

The printer picks up paper from the currently selected tray.
If the currently selected tray is out of paper and the Auto-Pick feature is not turned on:
« The printer displays a message that instructs you to provide paper to that tray.
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auto-pick feature
Following are the steps to turn on the Auto-Pick feature:
1. Select the Start -> Settings -> Printers menu command to display the Printers
window.
2. Right-click the icon for the printer.
3. Select the required menu item, depending on the operating system:
* Properties for Windows 95 and Windows 98
* Printing Preferences for Windows 2000
» Document Defaults for Windows NT 4.0
4. Click the Features tab.
Click the Advanced Features button.
6. Select the Auto-Pick from Next Tray check box in the Advanced Features
dialog box.
7. Click OK to close the dialog box.

o
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software features and functions overview

Use the options of the Setup and Features tabs in the printer driver of the hp color inkjet
printer cp1700 series to perform the following functions:

1.
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printer driver features
Print in duplex mode : Print on both sides of a page by using the auto-duplex
unit. Perform duplex printing manually if you have not installed the auto-duplex unit.
When you select manual duplexing, LCD displays instructions on how to insert
paper into the printer.
Create handouts : Print presentation slides on regular paper.
Create a booklet : Print and collate a multiple-page document by printing two
pages of the document on each side of a paper. For example, an eight-page
document is printed with pages 1 and 8 on the same side of the paper and pages
2 and 7 on the other side of the paper. Fold the printout in half to create a booklet.

use and maintain
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Tile pages : Enlarge and print a page in sections and on different sheets of
paper. Use these sheets of paper as tiles to form a large poster.

Create and use watermarks : Specify the text to be placed in the background
of an existing document. For example, you might want to print draft or confidential
diagonally across the first page or all pages of a document.

Create a banner : Create a banner by using software, such as Corel Print
House, Microsoft Publisher, and Broderbund Print Shop.

Resize document views : Resize document views by using the HP ZoomSmatrt
feature.
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printer driver features

performing duplexing
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performing duplexing
Print on both sides of a paper by using the hp inkjet color printer cp1700 series. This is
called duplexing. Enable the duplexing feature of the hp color inkjet printer cp1700 series
by checking the Two-sided Printing (Duplex) check box in the Features tab of the
printer driver.
1. Book radio button: Enables the user to print using both sides of a sheet of paper
with the binding along the longer edge of the paper like a book.
2. Tablet radio button: Enables the user to print using both sides of a sheet of paper
with the binding along the shorter edge of the paper.
Following are the two types of duplexing:
* Automatic
* Manual

automatic duplexing

Select the Automatic check box in the Features tab of the printer properties dialog box to
perform automatic duplexing.
When printing is complete on one side of the paper, the printer performs the following
functions:

1. Holds the paper.

2. Pauses while the ink dries.

3. Pulls back the paper after the ink dries.

4. Prints the second side of the paper.
When printing on both the sides of the paper is complete, the paper is released to the
output tray.

manual duplexing

Deselect the Automatic check box in the Features tab of the printer driver to perform
duplex printing manually.

creating handouts
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creating handouts
The handout feature enables printing a multiple page document on to a single sheet of
paper. Enable the handout feature of the hp color inkjet printer cp1700 series by checking
the Handout check box in the Features tab of the printer driver.
1. Pages Per Sheet list box: Enables the user to print a multiple page document in
a single sheet of paper. This feature enables printing of upto 16 pages in a single
sheet of paper.
2. Page Order list box: Enables the user to select the order in which the pages
appear on the printed document. Following are the options for page order:
* Left then down
* Down then left
* Right then down
* Down then right

creating a booklet
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creating a booklet

The Booklet feature takes the page printing sequence of a multi page document and prints
two pages in a single sheet of paper. This enables the user to fold the printed output and
bound it to form a booklet. Enabling the booklet feature automatically activates two-sided
printing. You enable the booklet feature of the hp color inkjet printer cp1700 series by
checking the Booklet Printing check box in the Features tab of the printer driver.

1. Print on one side check box: Enables the user to print on a single side of a

sheet.

2. Reverse order check box: Enables the user to print backwards from the end of

the document.

tiling pages
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The tiling feature of the hp color inkjet printer cp1700 series enables users to enlarge a
page to fit on up to 25 sheets of paper. Access the tiling feature by checking the Tiling
check box in the Features tab of the printer driver

1. Sheet list box: You can specify the number of sheets the printable document would
span. The number of tiles supported by hp color inkjet printer cp1700 are:

° 2X2
e 3x3
° 4x4

2. Select Tiles button: The Select Tiles button in the Features tab of the printer
driver enables the user to specify an individual tile or selection of tiles to print.
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creating and using watermark
Print watermark on a document by using the watermark feature of the hp color inkjet printer
cpl700 series. Select the required watermark option from the Watermark list box in the
Features tab of the printer driver. Clicking the Edit button in the Features tab of the
printer driver displays the Watermark Details dialog box that contains various options
to change the format of the watermark. You can also create a watermark by using the
Watermark Details dialog box.
The Watermark Details dialog box contains the following:
1. Current Watermarks list: Enables the user to view and select an available
watermark.
2. New button: Enables the user to add a new watermark to the list of existing
watermarks.
3. Delete button: Enables the user to delete an existing watermark.
4. Watermark Message text box: Enables the user to specify the text of watermark
or modify the text of an existing watermark.
5. Message Angle group box: Enables the user to specify angle of the watermark
text by selecting the required message angle radio button.
6. Justified Across Page check box: Enables the user to specify whether the
watermark will appear in a justified alignment across the printed page.
7. Preview box: Displays a preview of the watermark.
8. Font Attributes group box: Enables the user to specify the font attributes of the
selected watermark.

creating banners
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creating banners

Create a banner by using software, such as Corel Print House, Microsoft Publisher, and
Broderbund Print Shop. To perform banner printing, first select the hp banner paper list item
from the Paper Type list box in the Setup tab of the printer driver. Next, select the
required size of the banner paper from the Paper Size list box. Select the banner paper
size from the following:

* Banner — Letter [8.5 x 11 inches]

e Banner A4 [210 x 297 mm]

* Banner A3 [297 x 420 mm]

 Banner Tabloid [11 x 17 inches]

enlarging or reducing documents
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enlarging or reducing documents
Enlarge or reduce document views by using the ZoomSmaurt feature of the hp color inkjet
printer cp1700 series. To enable the ZoomSmart feature, click the HP ZoomSmart
button in the printer driver to display the Scale to fit dialog box. The Scale to fit dialog
box has the following:
1. Resize to % of original size spin box: Enables the user to specify a scaling
percentage.
2. Paper type drop-down list box: Enables the user to specify the type of paper,
such as Letter, Tabloid, or A4.
3. Scale to fit paper in device radio button: Enables the user to specify the
ZoomSmart scale factor to fit the document and printer paper sizes.
4. Document Size list box: Enables the user to specify the media size that matches
the media size of the document to be printed.
5. Paper in device list box: Enables the user to specify the media size that is
currently present in the media tray of the printer as indicated by your selection.

advanced features
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advanced features

Use the advanced features of the hp color inkjet printer cp1700 series driver to set options,
such as ink volume and dry time.
The steps to set advanced options are:

1.
2.
3.
4.

Select the File -> Print menu command to display the Print dialog box.

Click the Properties button in the Print dialog box to display the printer driver.
Click the Features tab.

Select the required option.

The advanced features of the hp color inkjet printer cp1700 series driver are:

1.

Ink Volume : The ink volume feature enables the user to adjust the amount of ink
printed on a page. Use the Ink Volume slider to specify the ink volume of a
printed page. The lighter the ink volume, faster the printout dries.

Dry Time : B-size printouts often smear due to paper shape and take a longer time
to dry. The dry time feature enables the user to provide extra drying time for slow-
drying printouts. Use the Dry Time slider to increase or decrease the drying time.
The printer holds the printout until the printout dries.

Media Width Sensor : The media width sensor feature enables the users to
detect whether the paper loaded is wide enough for the print job. Select the If
Paper is Too Small, Eject Page and Pause check box to enable automatic ejection
of the paper if the paper width is too small.

Low Memory Mode : When the computer is very low on memory or disk space,
it fails to process a print job. The low memory mode feature enables printing even if
the computer is very low on memory. Select the Low Memory Mode check box to
enable processing of a print job even if the computer is very low on memory.
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changing default software settings

changing the default printer settings

The printer driver stores the default print settings for most applications. Change these
settings to:
« Print on different sizes and types of paper.
» Use an optional feature.
For example, you need to change the default printer settings to print on both sides of a
paper.
Following are the steps to change default print settings:
1. Select the Start -> Settings -> Printers menu command to display the Printers
window.
2. Right-click the icon for the printer.
3. From the context menu, select the required menu item, depending on the operating
system:
* Properties for Windows 95 and Windows 98
* Printing Preferences for Windows 2000
» Document Defaults for Windows NT 4.0
4. In the dialog box that appears, click the Setup tab and select the required print
settings.
5. Click the OK button to close the Properties dialog box and activate the changes.

changing print settings for the current document

You can also change the print settings for the current document from the application in
which you create the document.
Following are the steps to change the print settings for the current document:
1. Select the File -> Print menu command to display the Print dialog box.
2. Click the Properties button in the Print dialog box to display the document
properties dialog box. Perform the required changes.
3. Click the OK button to close the dialog box and apply the changes.
The printer uses the settings of the application you are using for the current document.

Note Youcan also change the print settings from the control panel of the printer. However, the
settings in the printer driver and application override the control panel settings.
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troubleshooting usage issues

power light of the printer blinks amber and green, alternately

symptom cause solution
Power light of the * A nonrecoverable error e Turn off the
printer blinks amber has occurred. (e.g. a the printer, wait for
and green, carriage might be sometime, and
alternately stalled) turn on the

* The latest version of the printer again.

firmware is absent or the e Turn off the
firmware might have
been incorrectly flashed on again.

printer and then

e |If the problem
persists, it may
be a hardware
issue or fault

setup issues - 1

printer takes a long time to print

configuration of
hardware on the
PC side

¢ Low ink supply

symptom cause solution
Printer takes a e Incorrect e Ensure that the computer
long time to configuration meets the minimum
print ¢ Inadequate hard operating system
disk space in the requirements for the printer.
spool directory e Atleast 50 MB of hard disk
¢ Incorrect space should be available

in the following cases:
o Toprinton11x17
inch or A3 paper
o To print graphics-
intensive files
Ensure that the port settings
configuration in the
computer is set to ECP.
Check the status of the ink
cartridges.
Replace any ink cartridges
that are low on ink.

setup issues - 2

hp confidential
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troubleshooting paper jams

To clear a paper jam, first check the paper input paths. If the jammed paper is visible from
one of the input trays or the front manual feed, carefully pull the jammed paper straight up
and out of the printer. Select new paper and reload the printer with it.

Note Ensure that the paper is aligned to the right side of the tray. In addition, verify that the guides
are adjusted tightly against the stack of paper and they do not wrinkle or bend the paper.

clearing paper jam by opening the top cover

1. Remove all paper from the output tray.
2. Open the top cover. The carriage should return to its position on the right of the
printer.
3. If the carriage does not return to the right of the printer, turn off the printer before
you remove the jammed paper.
4. Remove any wrinkled paper by pulling the paper through the top of the printer.
After clearing the jam:
* Close all covers of the printer.
* Press the RESUME button to continue the print job.

Note The print job continues from the next page. Reprint the pages that were jammed in the
printer.

clearing paper jam in tray 1

symptom cause solution
Paper jam in e Skewed paper 1. Pull out Tray 1 from the
Tray 1 e Curled paper printer.
¢ Incorrectly 2. Locate and remove the
stacked paper jammed paper from Tray 1.
3. Lower the output tray.
4. Replace Tray 1.

clearing paper jam in tray 1
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clearing paper jam in tray 2

symptom cause solution
Paper jam in e Skewed paper 1. Pull out Tray 2 from the printer.
Tray 2 e Curled paper 2. Locate and remove the jammed

¢ Incorrectly

stacked paper 3.

paper from Tray 2.

If you cannot locate the jammed
paper, turn off the printer and
remove the power cord.

1. Lift the printer off Tray 2.
2. Remove the jammed paper
from the bottom of the

printer.
3. Place the printer back on

top of Tray 2.

clearing paper jam in tray 2

clearing paper jam in rear access panel

symptom cause solution
Paper jam in the e Paper is too 1. Push the buttons on either
rear access panel thick side of the rear access
e Usage of panel.
unsupported 2. Pull the panel out of the
media printer.

3. Remove the jammed paper
by pulling it out with both
hands.

4. Place the rear access panel
back in the printer.

clearing paper jam in rear access panel
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print quality troubleshooting
poor print quality

symptom cause solution
Poor print e Printer *  Check the printheads and ink
quality needs cartridges
cleaning o0 Check and replace clogged
* Ink supplies or worn printheads.
issues 0 Check and replace low or

empty ink cartridges.
*  Check the paper quality
0 Ensure that the paper you are
using is not too moist or too
rough.
*  Check the inside of the printer
0 Clean the inside of the printer
with a lint-free cloth.

poor print quality

meaningless characters printed

symptom cause solution

Meaningless ¢ Incorrect *  Check the cable connection

characters connectivity o0 Ensure that the cable

printed ¢ Incorrect connection at both the
document ends is proper and the
settings cable is securely fastened.

*  Check the document file
0 Check whether the
printable document is
damaged.
0 Print the document by
using a backup copy.

meaningless characters printed

use and maintain
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flashing firmware / upgrades

To flash the printer with the latest firmware flash code, perform the following steps:
1. Download the latest firmware flash code.
2. Set the printer in manufacturing mode by holding down the RESUME button and
hitting the POWER button.
Initiate the DOS prompt.
At the MS-DOS prompt enter the command copy /b "<filename> Ipt1.
5. To check the firmware flash code version sent, print the 4-button self-test page.

P w
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flashing firmware / upgrades
Product will ship with FLASH-ROM

Note

* Flash accomplished through Parallel Port
 Can flash be done through USB?

Switch to Mask—-ROM : approx FCS +6
Current — Firmware flash instructions :

* Set the printer in reflash mode

* Power down

» Power up while depressing the RESUME key
* Open the DOS prompt

 Execute:

e Copy /b <firmwarefilename> Iptl

Firmware flash utility to be released by FCS, watch the division web pages for updates

To flash a printer with the latest firmware flash code, perform the following steps:

1.
2.

3.

»

1.Download the latest firmware flash code

2.Set the printer in manufacturing mode by holding down the RESUME button and
hitting the POWER button.

3.Initiate the DOS prompt.

4.At the MS-DOS prompt enter the command copy /b "<filename> Iptl

5.To check the firmware flash code version sent, print the 4-button self-test page.

support
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controls

controls

The front panel serves two primary purposes. It notifies the users on printer operations (eg.
printing, ready), requirement of user intervention (eg. out of paper, replace printhead) and
component status (eg. ink level status, print head health). Second, the front panel will be

used to drive second-order functions such as printing test pages, pen cleaning and

alignment. This is achieved through some unique key press sequences.
However, it will not be used to configure low-level information set in NVRAM or on LIO
cards. Low-level configurations of the IO cards will be provided by host software or its
equivalent, through the driver or through a combination of driver/firmware.
The printer front panel has a LCD display, two LEDs and three key buttons, which are the
POWER, RESUME and CANCEL buttons.

key

function

POWER

It is a momentary pushbutton that is used to control the printer
power. This is a "Hard On, Soft Off" switch, which has direct
control of the power supply when the printer is off. However, it
acts as an input logic to the firmware when the power is on. It is
used to initiate a power down sequence instead of cutting of the
power directly.

RESUME

This momentary pushbutton is context sensitive. Depending on
the state of the printer, pressing the RESUME button has different
effect on the printer. If a media related condition, such as out of
paper, has occurred, pressing this button will cause the printer
to resume its print operation. Together with the POWER button,
it can be used to invoke an internal page or printhead related
functions.

CANCEL

A momentary pushbutton used to cancel current print job. After
the user presses the cancel button, the printer will eject the
current page; clears the buffer, and prepare for a new print job.

controls
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LCD messages

messages that do not require action

message explanation
INITIALIZING The printer is starting up.
READY The printer is idling.

PROCESSING JOB

The printer is busy printing.

CANCELLING JOB

The printer is canceling the current print job.

ATTENTION

User interaction is required.

POWERING OFF

The printer is switching off.

details of messages that do not require action

messages that require action

message

explanation

recommended action

PAPER JAM,OPEN
COVER AND CLEAR
PAPER PRESS

Paper is jammed in the
printer.

Clear the jammed
paper. For more
information, see "Print

CARTRIDGE EMPTY

and the printer will not
print until the cartridge is
replaced.

RESUME TO media is jammed."
CONTINUE
[COLOR] INK The cartridge is out of ink ¢ Remove the ink

cartridge and install a
new cartridge.

REPLACE [COLOR]
INK CARTRIDGE

The printer detects a
faulty ink cartridge.

Reinstall the faulty ink
cartridge and try to
print.

If the error persists,
replace the cartridge.

[COLOR] INK
CARTRIDGE
MISSING

The printer cannot detect
the ink cartridge because
it is missing, improperly
installed, or defective.

Open the ink cartridge
door and check for a
missing, incompatible,
or improperly installed
cartridge.

Reinstall or replace the
cartridge as
appropriate.

If the error persists,
contact HP customer
support.

[COLOR] INK 1S
LOW

The specified ink
cartridge is running low
on ink.

If the print quality is
insufficient, replace the
ink cartridge.

[COLOR] INK
CARTRIDGE EXPIRED

The expiration date for

the specified ink cartridge

has passed.

Replace the ink
cartridge.

support
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REPLACE [COLOR]
PRINTHEAD

The printer detects a
faulty ink printhead.

Remove the printhead,
ensure the protective
film has been removed
from the printhead,
and then reinstall it
and try to print.

If the error persists,
remove the printhead
and use a dry, lint-free,
soft cloth to gently
clean any ink off the
contact pads, and then
reinstall it and try to
print.

If the error persists,
replace the printhead.

[COLOR]
PRINTHEAD
MISSING

The printer cannot detect
the ink printhead because
it is missing, improperly
installed, or defective.

Open the printhead
cover and check for a
missing, incompatible,
or improperly installed
printhead.

Reinstall or replace the
printhead as
appropriate.

If the error persists,
contact HP customer
support.

BAD INK
CARTRIDGE OR
PRINTHEAD

The printer detects a
faulty ink cartridge or
printhead.

Follow the instructions
in the printer message.

INCOMPATIBLE
[COLOR]
PRINTHEAD

The printhead is not
compatible with the
printer.

Replace it with the
correct printhead.

LOAD [MEDIA TYPE]
in [TRAY] PRESS
RESUME TO
CONTINUE

Printer requires media of
a specific type and size
to be loaded in specified
paper tray.

Follow the instructions
in the printer message.

LOAD [MEDIA SIZE]
MEDIA IN [TRAY]
PRESS RESUME TO
CONTINUE

For a print job that
automatically selects the
media type, the printer
requires media of the
specified size to be
loaded into the specified
paper tray.

Follow the instructions
in the printer message.

hp confidential
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PRINTED PAGE IS
DRYING... PRESS
RESUME TO
CONTINUE

Printer has paused

printing to let the current

page dry

Wait for the printer to
automatically resume
printing after the
drying period.

If you want the printer
to resume printing
immediately, hold the
current page and press
the RESUME button.
When the printer
releases the current
page, remove it from
the output tray and
place it elsewhere to
dry.

This prevents the
printed pages from
smudging each other.

CLOSE ALL COVERS

One or more covers on
the printer are open.

Close any open
covers.

REAR MANUAL FEED
NOT
AVAILABLE...JOB

Check to see if the auto-

duplex unit is installed.

If the auto-duplex unit
is installed, you must
remove it and reinstall

CANCELLED the rear access panel
to print from the rear
manual feed.

If the rear access panel
is installed, check to

make sure it is installed
correctly in the printer.

TRAY 2 NOT Tray 2 is an optional If you have purchased

AVAILABLE PRESS accessory. If you have Tray 2, make sure it is

RESUME OR not purchased Tray 2, installed correctly in

CANCEL you cannot print from it. the printer.

Otherwise, press the
RESUME button to
continue the job using
Tray 1, or press the
CANCEL button to
cancel the job.

hp confidential



AUTO-DUPLEX UNIT
NOT AVAILABLE
PRESS RESUME OR
CANCEL

The auto-duplex unit is an
optional accessory. If you
have not purchased the
auto-duplex unit, you
cannot print an auto-
duplex job.

If you have purchased
the auto-duplex unit,
make sure it is installed
correctly in the printer.
Otherwise, press the
RESUME button to
continue the job using
single-sided printing,
or press the CANCEL
button to cancel the
job.

REINSERT [number]
PAGES INTO [TRAY]

This message is for
manual duplexing.
Indicates that printing on
the first side of the media

Take the printed stack
of paper from the
output tray and put it
back into the specified

is complete. tray.
PRINTHEAD ACCESS| The printhead access Open the printhead
LATCH OPEN latch is open. cover, close the

printhead access latch,
and then close the
printhead cover.

You will have to use
some force to close the
printhead access latch.
If the printhead access
latch will not close,
ensure that the
printheads are seated
properly by pushing
down firmly on each
printhead.

REAR ACCESS

The rear access panel is

Make sure the rear

PANEL OPEN not installed correctly or access panel is
at all in the printer. inserted correctly and
completely into the
printer.
LANGUAGE= Displays the language in For information about
[LANGUAGE] which the LCD shows changing the display

messages.

language, see "Setting
the LCD language."

details of messages that require action
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key driver improvements

 Auto-duplexing

* Normal mode printing in 600dpi
* Printing with black ink only

* Windows 2000 user mode driver
» Hagaki support

* Emulate LaserJet Margins

» Symmetrical Margins

ADI driver

installing a driver on a network

If an AutoCAD driver is installed on a network, the process is basically the same as
installation on a workstation. It is in two parts:

* Installation on the server.

 Configuration and operation on each client.

installation on the server

The following table lists the AutoCAD releases that can be used with different operating

systems.
Operating System AutoCAD release
Windows 9x and Windows NT 13 and 14

AUtoCAD release and OS

driver/SKU matrix

PCL3
driver printer features
PCL3 e hp color inkjet printer « Object-based language
cpl700 e Use to print from DOS as no
« hp color inkjet printer DOS driver is available
cpl700d
e hp color inkjet printer
cpl700 ps

PCL3 features
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PostScript

driver printer features
Postscript hp color inkjet printer e PostScript language
cpl700 ps e Designed for compatibility
with PostScript level 3 needs
e Printer automatically switches
between PS and PCL printer
languages
e Used to print from Macintosh
computers
PostScript features
ADI driver
driver printer features
ADI driver « hp color inkjet printer e Provides AutoCAD support
cpl700 for graphic designer segment
e hp color inkjet printer * Host based Postscript
cpl700d software RIP. Adobe
e hp color inkjet printer Postscript 3 compliant.
cpl700 ps
ADI driver features
IR Print
driver printer features
IR Print * hp color inkjet printer « Improved print quality while
cpl700 printing from external devices
* hp color inkjet printer e IrPrint enables printing from
cpl700d Palm OS
* hp color inkjet printer
cpl700 ps
IR Print features
Print Creator
driver printer features
Print e hp color inkjet printer | Print Creator is used to print photos
Creator cpl700 and graphics
e hp color inkjet printer
cpl700d
e hp color inkjet printer
cpl700 ps

Print Creator features

hp confidential
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windows XP statement

 The Unidriver PCL 3 driver will be available as part of the Windows Update by
December 2001
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driver features

software drivers available with the hp color inkjet printer cp1700

* Postscript

 The Postscript software provides an affordable postscript solution for low-end
graphic professionals. The RIP software allows customers to print PostScript files. The
target customer for the postscript SKU is the graphic artist in small studio who needs
a color printer to print comps. OS Support: Windows and Mac

* CAD drivers

» The CAD driver provides AutoCAD support for low-end technical graphics users. The
CAD driver is available in English, French, Spanish, German, Italian, Simplified
Chinese, Traditional Chinese, Japanese, and Korean.

* Print creator

« The Print Creator software increases ink and paper usage. Use the software to view
and edit images and photos. Localized languages: English, Japanese, French,
Italian, Spanish and German

features of the software driver for each OS

feature Windows Mac OS 8
9X/Me/NT/2000 and 9
Installer Yes Yes
Uninstaller Yes Yes
Print Quality Yes Yes
Orientation Yes Yes
Margins Yes Yes
User-defined paper size Yes Yes
Start printing from the last page Yes Yes
Copies (*1 to 999) Yes Yes
Device Settings, Windows Printer Yes No
Publishing service
Print Preview Yes Yes
Manual/Auto-duplex Yes Yes
Extra dry time Yes Yes
Save settings No Yes
Help Yes No
Toolbox (using SDIO for Windows, Yes Yes
DeskJet Utility for Mac)

features and OS

smart features for each OS

feature Windows Mac OS 8
9X/Me/NT/2000 and 9

Different first paper type Yes Yes

Photo Paper Printing Yes Yes

Concept preview Yes Yes

Banner Printing Yes Yes
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Scale to Fit (ZoomSmart) Yes Yes
Color Options Automatic Image Yes Yes
Enhancement (*on)

Two-sided printing Yes Yes
Multiple pages per Sheet Yes Yes
Booklet Printing Yes Yes
Poster printing Yes Yes
Optimized for Fax mode Yes Yes
Sepia No Yes
Media type sensing Yes Yes
Media width sensing Yes Yes

features and OS

support
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troubleshooting process

check the printer setup

* Plug in and power on the printer.

» Check that the network cable is connected. Check that the USB or parallel cable
between the printer and the computer or the HP JetDirect print server is connected
securely and functioning properly.

« Ensure the printheads and ink cartridges are properly installed.

» Check the LCD control panel for an error message.

» Check that too many programs are not open when trying to perform a task. Close
programs that are not in use, or restart the computer before attempting the task
again.

check the computer

» Make sure the network is accessible from the computer.

« Ensure the driver settings are properly configured.

» Check the driver version. Visit the HP Web site to download the latest drivers. If the
printer prints a nonsense version of the document, updating the driver might solve
the problem.

print a demo/duplex demo page
- If the demo page is printed, the printer is working.
print a demo page through the driver

« If the demo page is successfully through the driver, the OS to printer connectivity is
working.

check the self diagnostic page

* With a self-diagnostic page, all configuration information regarding the printer in
the current state, such as the health of the printheads and the ink cartridge usage is
available.
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diagnostic tests

introduction

This document explains how to perform built-in internal tests for hp color inkjet printer
cpl700 series. The internal tests include:

* Printing a demo page

* Printing a caliberation test page

* Printing a diagnostics test page

* Printing a test page for the two-sided printing module.

« Printing a Skew Measurement test page.
Use internal tests to verify that the printer's internal firmware is functioning properly. It will
not verify that the computer and printer connection is working properly. On the basis of the
output of the test, the internal tests can be classified as:

e Output - LCD Panel

* Output - printout

* No Output
Use the following instructions to print the test pages for the hp color inkjet printer cp1700
series:

Instructions

Before beginning the internal tests:
« Be certain that the printer is not connected to the computer.
» Make sure that the printer's power light is on solid and that no other lights are
active.

Output - LCD Panel

firmware revision

To test the firmware revision:

1. Turn on the printer.

2. Press and hold down the POWER button.

3.  While holding down the POWER button, press the RESUME button on the LCD

panel five times.

4. Release the POWER button.
The firmware revision number of the hp color inkjet printer cp1700 series is displayed on
the LCD panel.

most recent error code

To identify the latest error code:
1. Press the RESUME button six times.
The latest error code is available on the LCD panel.
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printhead health

The steps to display the printhead health information are:

1.
2.
3.

4

Turn on the printer.

Press and hold down the POWER button.

While holding down the POWER button, press the CANCEL button thrice and the
RESUME button thrice.

Release the POWER button.

The health of printheads is displayed in the KCMY sequence.

pages picked: tray 1

The steps to identify the number of pages picked in tray 1 are:

1.
2.

Press the CANCEL button four times.
Press the RESUME button three times.

The total numbers of pages picked from tray 1 is displayed in the LCD panel.

pages picked : tray 2

The steps to identify the number of pages picked in tray 2 are:

1.
2.

Press the CANCEL button four times.
Press the RESUME button four times.

The total number of pages picked from tray 2 is displayed in the LCD panel.

serial number

The steps to identify the serial number of the printer are:

1.
2.
3.

4.

Turn on the printer.

Press and hold down the POWER button.

While holding down the POWER button, press the CANCEL button four times and
the RESUME button five times.

Release the POWER button.

The serial number of the printer is displayed in the LCD panel.

Output - printout

demo page

Print a demo page to perform the following activities:

» Check the printer setup.
» Check the printer hardware configuration.

It is possible to print a demo page without connecting the printer to the computer. The demo

page does not ensure that the computer and printer are properly connected.
The steps to print a demo page are:

1. Turn on the printer.

2. Press and hold down the POWER button.

3. Hold the RESUME button for three seconds.

4. Release the POWER button to print the demo page.

4-18 hp confidential



hp color inkjet printer cp1700

high quality, wide-lormat printer
designed for small business
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demo page
double-sided demo page

Print a double-sided demo page to check whether the printer is working with the auto-duplex
unit.

Note To print a double-sided demo page, a power supply connection is required.

Print a double-sided demo page by using the CANCEL button and the RESUME button on
the LCD control panel.

The steps to print a double-sided demo page are:

1. Turn on the printer.

2. Press and hold down the POWER button.

3. Press the CANCEL button three times.

4. Press the RESUME button once.

5. Release the POWER button to print a double-sided demo page.

align printheads

The steps to align printheads by using the LCD panel are:
1. Press and hold down the POWER button.
2.  While holding down the POWER button, press the RESUME button on the LCD
panel thrice.
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pen calibration test
After the alignment process is over, the printer prints an alignment page.

list of available tests

A self-test page verifies if the:
* Printer is connected to the computer properly.
* Printer and printer software are functioning properly.
To obtain a list of available tests:
1. Press the RESUME button four times.
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hp color inkjer cpl?00

Serial Numiber

EELGCLINEXNK

Service ID: 11167

FH Revigicm: UMR1002A

Total HEngine Page Count: 1946

BCL Default Symbol Seb: 341

Mfg D0-2: DO0000000000

T wal: 235

Error Code: 90020003

DEMOQ = 1 Demo Page
CALIBRATION_PAGE = 3 Pen Calibration
SELFTEST = 4 This Repact

REV_CODE =5 Firmeare Revision
LAST_ERE = & Most Recent Ercor Code
LINUS - 7 Linus Pattern
INFIMITE_HS = 8 Contineous H Patbern
LINUS4aXE a 9 4 ¥ & Linus Pactern

TECH MAREFETING 10 Bali Test Diagnostic Page

PAPER_CAL_PAGE 11 Faper Cal Data Tahbler

TECHY_SELFTEST = 12 NVRAM Contents Plug Constants

COLOR_HS = 13 Continuous Coler H Pattern

NORMAL_PAPER_CAL = 1 Schedule a paper cal

TECH MARKETING = 1% Technical Diagnoatic Page

EPIT_N_WIPE = 20 Pen Recavery Level 1

CLEAN_PENS = 2% Pen Recovery Level I

SUPER_CLEAN = 22 Pen Recovery Lewvel 1

UMCAP S5 = 23 Uncap the pens and pause pen gervicing

HP_S;S = 24 Cap the pens and resume pen servicing
AIR_PURGE_STARTUP = 25 Purge the Tube .

AIR_PURGE_DISABLE = 28 Disable IDS air purging until pawer cycle
DUPLEX_DEMO = 31 Demo page with twa sides

PEN_HEALTH i3 Show pen health in EOMY segquence

MTF_FOV = 14 SPOT cptic part measurements

DOT OOUNT = 41 Fon Doe Counter Data

MAIN TRAY FASE CHT = 43 Counter for page picked from main tray

IND TRAY PAGE CNT = dd Counter for page picked from Inmd tray

SZRIAL HUMEER = 45  Display serial number

PICK MATN = 46 Continuous pick paper from main bray w/cleancut
PICK 2ND - 47 Centinucus pick paper from Ind tray w/cleanout
PFICKE MAIN DUPLEX = 48 Continucud pick paper from main cray w/duplexer
FICK 2ZND DUPLEX = 49 Continucus pick paper from Ind tray w/duplexer
N MECH_CH = %8 Ser Data Score WO _MECH vo TRUE

BI_MECH_DFF = 59 Set Data Store NWO_MECH to FALSE

SHEW_E_RA_L - &7 Gkew Dots for Beenofast A size main cray
SEEW_E_A_Z = B# Skew Dota for Bconofast R osize Ind tray
SEEW_E_B_1 = 63 Skew Dots For Eccnofast B size malin tray
SEEW_E_D_2 = 70 Skew Dots for Boonofast B sige Pnd tray
EREW_M_A_1 = Tl Skew Dota for Normal A size main tray
SYEW_N_A_2 - 72 Skew Dobs for Narmal A gize Ind cray
NORZLE_PFATTERN = H4 Print the Pen Mozzle PacLern

LIDTEST = AE8 Execute LIO Teat (no page printed]
EOD_DIAGNOSTIC = 92 EDD diagrostic page

list of available tests
self diagnostic page

Information displayed on the Diagnostic page:
* Printer information: Firmware version number, Model, and Service ID
« Printhead information: Technical information on printhead performance
* Technical information: Technical information on printheads and ink cartridges
The steps to print a Diagnostic page are:
1. Press and hold down the POWER button.
2. While holding down the POWER button, press the CANCEL button once.
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hp color inkjet cpl700Q

Product Number: c&436a

Serial Number: SG16C1306XXX

Service ID: 0B218

FW Rewvision: UMRIDOZA

Optional Accessories
hutomatic Two-5ided Printing Module:
I/0 Module: SMART CARD

Not Installed

. - .

- E Ink Level

97%
Status: OK HP Part No: HP C48444
Expiration: 02/19/2004 Selectability No:
P © Ink Level R T 94%
Status: QK HPF Part NHo: HP C4836A
Expiration: 02/19/2004 Selectability No:
Bl ¥ Ink Level 94%
Etatus: (8] 4 HPF Part No: HP C4B37A
Expiration: 02/19/2004 Selectability No:
¥ Ink Level 94%
Status: OK HF Part No: HP C4838A
Expiration: 02/15%/2004 Selectability HNo:
Prxint
Color Cyan Black Magenta Yellow
Status OK QK OK [8]:4
Installation Date 08/06/2001 oBf06/2001 0B/08/2001 08/06/2001
HP Part HNo. HP C4811A HPF C4810A HP C4BlZA HPF C4Bl3A
Selectability No. HP No. 11 HP No. 11 HP No. 11 HP No. 11
Drop Count (KDrop)331155 897154 332626 367287
Printhead Alignment I I I I
iENN
(IR R
I I I [ i

self-diagnostic page

paper path calibration data

The steps to print the paper data are:
1. Press the CANCEL button once.
2. Press the RESUME button once.

The paper path data is displayed in a printout.

NVRAM contents

The steps to print the NVRAM contents are:
1. Press the CANCEL button once.

hp confidential
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2. Press the RESUME button twice.
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NVRAM contents

The contents of the NVRAM are displayed in a printout.

technical diagnostic page

The steps to print a technical diagnostic page are:

1. Press the CANCEL button once.

2. Press the RESUME button five times.
The technical diagnostic page is printed. It contains advanced configuration information for

use of CCC and service center users.
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hp celer inkjet ecol700

EDD DIAGHNOSTIC PAGE

W Hovigion: UMRLOD3A
Serial Humber: S5G16C130G6KXX

EDD INFORMATION
EDD State: INSTALLED? ENABLED? OP-AMP TYFE OTHER
- 1 4 X
Wuzber of NP: 24 of 24000, ETOE counte:l0l0101 (hex byce)
Buslerr of print jobs between BDD NP: 10
Elack Pen X-Posicion Eor =EDD: 4087
Pen Drog Counts (Dropa=1000}: =L00004 134661 +336132 30T

EDD CHARACTERIZATION

EDD sensor DC offset (m¥): 2019

ETOV (mJy s ¥B1L50 B650 =8225 B225

Pen Pulse Widthi{uf) +187% 1621 *14bB6 1466

Operating Voles(oV) *9128 * 9538

Sub- Pen ETOV waluesimy) :
XK EDD TOV'Ss: 0 00
C EDD TOV's: O 0 0
M EDD TOV'E: 200
¥ EDD TOV's: 0 0 0

Single Nozzle Moise Threshold:
# MNP Threshold: 2462 z-factor+1000: 3304
C MNP Threshold: 2298 z-factor*19000: 3181
¥ NP Threshold: 2313 z-factorvl000: 5421
¥ NP Threshold: 2024 z-factorv*1000: 5239

Humber of nozzles below threshold: 0 g 0 0 g

i
o
o
o

technical diagnostic page

spot sensor check

The spot sensor check is useful to service Center and test the accuracy of the spot sensor.
The steps to test the spot sensor are:

1. Press the CANCEL button thrice.

2. Press the RESUME button four times.

skew test - econofast mode - A size - tray 1

Use the skew test to test for paper tray with the specified location, paper size, and print
mode. The steps to perform the skew test are:

1. Press the CANCEL button six times.

2. Press the RESUME button seven times.
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skew test - econofast mode - A size - tray 2

Use the skew test to test for paper tray with the specified location, paper size, and print
mode. The steps to perform the skew test are:

1. Press the CANCEL button six times.

2. Press the RESUME button eight times.

skew test - econofast mode - B size - tray 1

Use the skew test to test for paper tray with the specified location, paper size, and print
mode. The steps to perform the skew test are:

1. Press the CANCEL button six times.

2. Press the RESUME button nine times.

skew test - econofast mode - B size - tray 2

Use the skew test to test for paper tray with the specified location, paper size, and print
mode. The steps to perform the skew test are:
1. Press the CANCEL button seven times.

skew test - normal mode - A size - tray 1

Use the skew test to test for paper tray with the specified location, paper size, and print
mode. The steps to perform the skew test are:

1. Press the CANCEL button seven times.

2. Press the RESUME button once.

skew test - normal mode - A size - tray 2

Use the skew test to test for paper tray with the specified location, paper size, and print
mode. The steps to perform the skew test are:

1. Press the CANCEL button seven times.

2. Press the RESUME button twice.

nozzle pattern

Print the pen nozzle pattern to test the printhead health and check for blocked printhead
nozzles. The steps to print the nozzle pattern are:
1. Turn on the printer.
2. Press and hold down the POWER button.
3.  While holding down the POWER button, press the CANCEL button eight times and
the RESUME button four times.
4. Release the POWER button.

EDD diagnostic information

The electronic drop detect test tests whether the pens are spitting satisfactorily. The steps to
obtain EDD diagnostic information are:

1. Press the CANCEL button nine times.

2. Press the RESUME button twice.
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tests with no output

continuous H pattern

Use the continuous H pattern to stress test the printer. The printer picks paper continuously
and prints a page each of the letter H. To print the continuous H pattern:
1. Press the RESUME button eight times.

continuous color H pattern

Use the continuous color H pattern to stress test the printer. The printer picks paper
continuously and prints a page each of the letter H. The steps to print the continuous color H
pattern are:

1. Press the CANCEL button once.

2. Press the RESUME button three times.

pen recovery level 1

The steps to perform level-one cleaning of the printheads are:
1. Press and hold down the POWER button.
2. Press the CANCEL button two times while holding down the POWER button.
3. Release the POWER button.

pen recovery level 2

The steps to perform leveltwo cleaning of the printheads are:
1. Press and hold down the POWER button.
2. Press the CANCEL button two times and the RESUME button once while holding
down the POWER button.
3. Release the POWER button.

pen recovery level 3

The steps to perform level-three cleaning of the printheads are:
1. Press and hold down the POWER button.
2. Press the CANCEL button two times and the RESUME button twice while holding
down the POWER button.
3. Release the POWER button.

purge RIDS tubes

The steps to purge air from tubes are:
1. Press the CANCEL button twice.
2. Press the RESUME button five times.

disable purge RIDS

The steps to disable RIDS air purging until power cycle are:
1. Press the CANCEL button twice.
2. Press the RESUME button eight times.
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continuous pick: main

To diagnose the causes for paper handling problems, such as paper jams, perform the
continuous paper pick test. The steps to perform the continuous paper pick test from tray 1
are:

1. Press the CANCEL button four times.

2. Press the RESUME button six times.

continuous pick: 2nd

To diagnose the causes for paper handling problems, such as paper jams, perform the
continuous paper pick test. The steps to perform the continuous paper pick test from tray 2
are:

1. Press the CANCEL button four times.

2. Press the RESUME button seven times.

continuous pick: main duplex

To diagnose the causes for paper handling problems, such as paper jams, perform the
continuous paper pick test. The steps to perform the continuous paper pick test from tray 1
with the auto-duplex unit installed are:

1. Press the CANCEL button four times.

2. Press the RESUME button eight times.

continuous pick: 2nd duplex

To diagnose the causes for paper handling problems, such as paper jams, perform the
continuous paper pick test. The steps to perform the continuous paper pick test from tray 2
with the auto-duplex unit installed are:

1. Press the CANCEL button four times.

2. Press the RESUME button nine times.

support
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product troubleshooting and issue resolution

symptom cause solution
Unexpected * No 1. Ensure that the power cord is
printer shutdown power connected firmly to the printer and a
supply working outlet.
2. Check if power cord is defective.

3. Ensure that the printer is turned on
and the color of the POWER light on
the LCD panel of the printer is green.

4. Restart the printer.

e Printer 1. Check the printer vents.
overheate 2. Ensure that the vents are not covered
d and the printer is in a cool, dry
location.

printer status

symptom cause solution
Blank page e Printhead problems 1. Check that the tape is
printed * Incorrect driver removed from the
e Media mispick issue printheads.
2. Check for empty ink
cartridges.
3. Check that the paper is
wide enough.

4. Check the parallel port on
the computer.

5. Check that application
print preview (if any) is
correct.

6. Check that the correct
printer driver is selected.

Wrong fonts e Fonts in document are Check the fonts used.

printed non-standard or Check the available fonts.

customized 3. Check whether the font
that is incorrectly printed is

a TrueType font.

N

Jagged text Use of non-standard fonts 1. Check the chosen font
type
2. Check the font type of the
software
3. Check the bitmap image
of text

print quality issues
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symptom cause solution

Content on the * Incorrect paper 1. Check margin settings.

page is missing or size 2. Ensure that the margin

incorrect * Incorrect settings for the document do
Margins for print not exceed the printable
job area of the printer.

e Specialized 3. Check color print settings.
color settings 4. Deselect the Grayscale
printing option in the Print Settings

dialog box.
Placement of the Incorrect page settings 1. Check the page orientation.
text or graphics is 2. Check the paper size.
incorrect 3. Check margin settings.
4. Check how the paper is

loaded.

incorrect / incomplete content

symptom cause solution
Problems printing| System / network 1. Check the system configuration.
over a network configuration 2. There may be insufficient hard
issues disk space in the system.
3. Increase the size of the system's
virtual memory.
4. The port setting configuration in

the system is not set to ECP
(Windows 3.1x/95/98 only).

connectivity problems

support
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performing print software troubleshooting

HP offers:

 Support services to troubleshoot and diagnose printer problems

« Instructions for service and repair

» Documentation for troubleshooting

» Online and telephone support for troubleshooting

* URL for support:

« During the warranty period, customers receive assistance from HP Customer Care
Center

« Before calling a Customer Care Center representative, the customer needs to
provide information regarding:

* Results of a configuration page, brand and model of the computer, operating system
of the computer, and printer driver installed
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performing internal diagnostic tests

diagnostic test : output - LCD panel

test keypanel description
sequence
Firmware revision 5 Available as LCD information
Most recent error 6 Available as LCD information
code
Display Printhead 33 Shows health of printheads in KCMY
health sequence
Pages Picked: Tray | 43 Total numbers of pages picked from
1 tray 1
Pages Picked: Tray | 44 Total numbers of pages picked from
2 tray 2
Serial Number 45 Displays serial number of the printer

output - LCD panel

diagnostic test : output - printout

test keypanel description

sequence
Technical Diagnostic | 15 Contains advanced configuration
Page information for use of CCC and service

center users

Skew Test - Econofast | 67 Tests for Paper tray with the specified
mode - A size - Tray 1 location, paper size and print mode
Skew Test - Econofast | 68 Tests for Paper tray with the specified
mode - A size - Tray 2 location, paper size and print mode
Skew Test - Econofast | 69 Tests for Paper tray with the specified
mode - B size - Tray 1 location, paper size and print mode
Skew Test - Econofast | 70 Tests for Paper tray with the specified
mode - B size - Tray 2 location, paper size and print mode
Skew Test - Normal 71 Tests for Paper tray with the specified
mode - A size - Tray 1 location, paper size and print mode
Skew Test - Normal 72 Tests for Paper tray with the specified
mode - A size - Tray 2 location, paper size and print mode

diagnostic tests : no output action

output - printout

test keypanel sequence description

Pen recovery level 1 | 20 Pen cleaning : Basic

Pen recovery level 2 | 21 Pen cleaning : Intermediate
Pen recovery level 3 | 22 Pen cleaning : Advanced

no output action

support
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repackage for return shipment

Perform the following checks while repackaging the printer for return shipment:
* Ensure that the ink cartridges are removed.
« Ensure that the printheads are removed.

l Unplug the printer
Bamoua Ink Bamoua Rame
SUDEIEs printhEads ik CaTIRIOgES
'-\Ir o o =y =Y
(R | I i = i
Ramouve trave hemaove ATSLEIETE I QAR I
B Traw 1 outBUttry || Tray 2 |
Tee E Yo i
= — = Rarnowa
Remove instaiied HRemowve i
Semassmaine T L ]
Egessoaies ey d o
- - - -
= E 3
o Pack Pack I S I
Pack the printer .- || rearaccess |
iray i oUtput tray || — |
J 5 3 [t ]
l Prevent turning the printer upside down during transportation

repackaging for return shipment
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escalation and support by region

North America

Support FlowEnd Customer->Dealer->Call Center->Division->
Escalation FlowEnd Customer->Dealer->Call Center->Division->

Middle East

Support FlowEnd Customer->Dealer->Call Center->Division->
Escalation FlowEnd Customer->Dealer->Call Center->Division->

Latin America

Support FlowEnd Customer->Dealer->Call Center->Division->
Escalation FlowEnd Customer->Dealer->Call Center->Division->

Europe

Support FlowEnd Customer->Dealer->Call Center->Division->
Escalation FlowEnd Customer->Dealer->Call Center->Division->

Asia Pacific

Support FlowEnd Customer->Dealer->Call Center->Division->
Escalation FlowEnd Customer->Dealer->Call Center->Division->

Africa

Support FlowEnd Customer->Dealer->Call Center->Division->
Escalation FlowEnd Customer->Dealer->Call Center->Division->

support
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run tests
Diagnostic Test : Output - LCD Panel

test description procedure

Firmware Revision Press the RESUME button five times.

Most recent error code Press the RESUME button six times.

Display Printhead health Press the CANCEL button and the
RESUME button three times.

Pages Picked: Tray 1 Press the CANCEL button four times and
the RESUME button three times

Pages Picked: Tray 2 Press the CANCEL button four times and
the RESUME button four times

Serial Number Press the CANCEL button four times and
the RESUME button five times

Diagnostic tests: Output - LCD Panel

Diagnostic Test : Output - printout

test description procedure

Demo Page Press the RESUME button once.

Demo Page - Double-sided Press the CANCEL button three times
and the RESUME button one time.

Pen Calibration Press the RESUME button three times.

Self Diagnostic Page Press the CANCEL button one time.

Paper path calibration data Press the CANCEL button one time and
the RESUME button one time.

Technical Diagnostic Page Press the CANCEL button one time and
the RESUME button five times.

Spot Sensor Check Press the CANCEL button three times

and the RESUME button four times.
Skew Test - Econofast mode - A size - | Press the CANCEL button six times and

Tray 1 the RESUME button seven times.

Skew Test - Econofast mode - A size - | Press the CANCEL button six times and

Tray 2 the RESUME button eight times.

Skew Test - Econofast mode - B size - | Press the CANCEL button six times and

Tray 1 the RESUME button nine times.

Skew Test - Econofast mode - B size - | Press the CANCEL button seven times.

Tray 2

Skew Test - Normal mode - A size - Press the CANCEL button seven times

Tray 1 and the RESUME button one time.

Skew Test - Normal mode - A size - Press the CANCEL button seven times

Tray 2 and the RESUME button two times.

Nozzle Pattern Press the CANCEL button eight times
and the RESUME button four times.

EDD diagnostic Information Press the CANCEL button nine times and

the RESUME button two times.
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Diagnostic tests: Output - printout

Diagnostic Tests : No Output - (Action to be performed)

test description

procedure

Continuous H pattern

Press the RESUME button 8 times.

Continuous color H pattern

Press the CANCEL button one time and
the RESUME button three times.

Pen recovery level 1

Press the CANCEL button two times.

Pen recovery level 2

Press the CANCEL button two times and
the RESUME button one time.

Pen recovery level 3

Press the CANCEL button two times and
the RESUME button two times.

Purge RIDS tubes

Press the CANCEL button two times and
the RESUME button five times.

Disable Purge RIDS

Press the CANCEL button two times and
the RESUME button eight times.

Continuous Pick: Main

Press the CANCEL button four times and
the RESUME button six times.

Continuous Pick: 2nd

Press the CANCEL button four times and
the RESUME button seven times.

Continuous Pick: Main Duplex

Press the CANCEL button four times and
the RESUME button eight times.

Continuous Pick: 2nd Duplex

Press the CANCEL button four times and
the RESUME button nine times.

LIO test

Press the CANCEL button eight times
and the RESUME button eight times.

Diagnostic Tests : No Output

service and repair
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exploded view

exploded view

S. Part Name Service | Bar codes Part Number

No. Level

1. Serial label NV Mﬂ”ﬂ"ﬂ"ﬂlﬂ"ﬂ"mmw C8108-67025

2. hp jetdirect J6039A
200mhp IR ERCANRIE T
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2a. | jetdirect 200m NV || Ill I”Il |I|I||| l J" J6042A
3. Cover LIO SVC NV || m Jum Illmlu“" | m C8108-67014
4. | Assy. Tray Main | NV || m Jum Jl Iﬂﬂﬂl Iﬂm u“ C8108-67044
5. | 2nd Bin SVC NV || m Jum Jl Imlu"”m"m“ C8108-67052
6. | Output tray NV || m Jum Jl Iﬂﬂﬂl M Ju“ C8108-67045
7. | Assy. Door Main | NV || m J""Hl Iﬂﬂﬂl J""JI"“ C8108-67020
8. | Assy. Access Door | NV || m J"m Jl Iﬂﬂﬂl J"JII ]“ C8108-67022
9. | Assy. Cleanout NV — i | 810867036
Trough T EREER
10. | Duplex Unit SVC NV || m J"m Illmlummmm C8108-67053
11. | Assy. Pick Roller | NV || m Jum Jl Iﬂﬂﬂl "| | u“ C8108-67039
12. | CaseRightSVC | NV || m J"m Jl Iﬂﬂﬂl HIII“J"“ C8108-67017
13. | Caseleft SVC NV || m Jum Jl Iﬂﬂﬂl ]ﬂ]ﬂ[ﬂ]ﬂ C8108-67016
14. | Bezel SVC NV || m Jum Jl Iﬂﬂﬂl mljmu“ C8108-67015
15. | Cover Key panel | NV — C8108:67018
SV TP RO
16. | Assy. Lightpipe NV || m J"m Illmlu“_u_"”u“ C8108-67021
17. | PCA key panel NV || m Jum Jl Iﬂﬂﬂl ][H||J|H|| C8108-67007
18. | Assy. Case main | NV || m Jum Jl Iﬂﬂﬂl HIJ[ JJ"“ C8108-67019
19. | PCA Assy. Logic | NV || m Jum Jl Iﬂﬂﬂl I"H Jm“ C8108-67005
20. | PCA power supply | NV || m Jum Jl Iﬂﬂﬂl I[ Jlmu“ C8108-67004
21. | Assy. USB SVC NV || m Jum Jl Iﬂﬂﬂl I[ I“I[ ]“ C8108-67006
22. | PCA Duplexer NV — C8108-67031
nterconnect TR
23. | Assy. Service NV C8108-67011
sation [T ERER
24. | Assy. Ink supply NV C8108-67013
sation PR e
25. | Base NV C8108-67003
absorber/basin
svC
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26. | Bottom Cover - NV C8108-67023
Vi Case JATAEHEM RN

27. | Holder - NV C8108-67024
raceway/hanger AT
SvC

28. | Assy. Replaceable | NV C8108-67012
IS SvC. JATAERERM R

29. | Carriage Rod NV || mmﬂmﬂm]uuﬂlu“ C8108-67008
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high failure rate parts

part number | part name part AFR or % repair
C8108-67011 | Assy. Service Station SVC 15.00%
C8108-67013 | Assy. Ink Supply Station SVC 15.00%
C8108-67019 | Assy. Case Main SVC 15.00%
C8108-67045 | Assy. Output Tray SVC 15.00%
C8108-67003 | Base absorber/basin SVC 10.00%
C8108-67010 | Encoder Strip SVC 10.00%
C8108-67012 | Assy. Replaceable IDS SVC 10.00%
C8108-67016 | Case - Left SVC 10.00%
C8108-67017 | Case - Right SVC 10.00%
C8108-67020 | Assy. Door Main SVC 10.00%
C8108-67022 Assy. Access Door SVC 10.00%
C8108-67044 | Assy. Tray Main SVC 10.00%

high failure rate parts - in order of AFR%
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crew parts
Assy. Cleanout Trough SVC - C8108-67036

1.[ Push the two buttons located on both sides of the cleanout trough to remove
it.

Assy. Tray main - C8108-67044

1.| Lift the output tray.

2. Pull to remove the main tray.

Assy. Output tray - C8108-67045

=

Lift the output tray.

2. Pull to remove the output tray.
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non V-coded parts
2nd bin SVC - C8108-67052

| 1. [ Lift the printer off the 2nd bin SVC.

Assy. Door Main - C8108-67020

=

Lift the Assy. Door Main.
2. Release the two tabs and remove the Door Main.

Assy. Access Door - C8108-67022
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=

Lift the access door.

2. | Loosen the two catches of the access door and remove it.

Cover LIO SVC - C8108-67014

| 1. | Remove the LIO cover from its slot.

Duplexer SVC - C8108-67053

| 1.| Push the buttons located on both sides of the auto-duplex unit to remove it.

service and repair hp confidential



Assy. Pick Roller SVC - C8108-67039

First remove the following:
1. Auto-duplex unit/ rear access panel

=

Use long nosed pliers to turn the catch clockwise.

2. | Remove the Assy. Pick roller.

Case Left SVC - C8108-67016

First remove the following:
1. Auto-duplex unit/ rear access panel
2. Assy. Pick Roller

T —

. .

2 screws

=

Use a T-20 bit screwdriver to remove the T-20 screws.

Remove Case Left.

hp confidential
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Case Right SVC - C8108-67017

First remove the following:
1. Auto-duplex unit/ rear access panel
2. Assy. Pick Roller

2 screws 1.| Use a T-20 bit screwdriver to remove the T-20 screws.

2.| Remove Case Right.

Bezel SVC - C8108-67015

-

Lift the Main door.

2.| Use a flathead screwdriver to release the six catches and remove the Bezel.

service and repair hp confidential



Cover Key panel - C8108-67018

First remove the following:

1. Bezel

2 screws

Using a screwdriver remove the T-10 screws.

Remove the cover key panel.

Assy. Lightpipe SVC and PCA Key panel - C8108-67021 & C8108-67007

First remove the following:

1. Bezel

2. Cover key panel

-16
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4 screws

Using a screwdriver remove the T-10 screws.

Pull out the harness.

Release the four catches located on the back.

W INE

Remove the Assy. lightpipe and the PCA key panel.

Assy. Case Main SVC - C8108-67019

First remove the following:

1.

©CoNOrWLD

Assy. Tray Main

Assy. Output tray

Assy. Door Main

Assy. Access Door

Case Left

Case Right

Bezel

Cover Key Panel

Assy. Lightpipe & PCA key panel

service and repair
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Screw

1.[ Remove the T-20 screw and push the cable through the slot.

2.| Use a flathead screwdriver to release the six locks located at the

bottom of the printer.

3. Remove the Assy. Case Main.

PCA Assy. Logic SVC - C8108-67005

First remove the following:

1. Auto-duplex unit/ rear access panel
2. Assy. Pick Roller
3. Case Right
Step 2
3 screws 1. Remove the T-10 screws.
2. Pull the harness.
3. Remove the flexi cable.
4. Pull out the harness and the flexi cable.

PCA Power Supply SVC - C8108-67004

First remove the following:

1.

oakwd

Assy. Tray Main
Assy. Output tray
Assy. Door Main
Assy. Access Door
Case Left

Case Right

hp confidential
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7. Bezel

8. Cover Key Panel

9. Assy. Lightpipe & PCA key panel
10. Assy. Case Main

11. PCA Assy. Logic

3 screws

Remove the T-10 screws.

1 screw

Remove the T-20 screw to remove the green harness.

Use a flathead screwdriver to remove the power harness.

PIWINE

Remove the power supply unit.

Assy. USB SVC- C8108-67006

First remove the following:
1.

CoNOOGOr~WDN

Assy. Tray Main

Assy. Output tray

Assy. Door Main

Assy. Access Door

Case Left

Case Right

Bezel

Cover Key Panel

Assy. Lightpipe & PCA key panel

10. Assy. Case Main
11. PCA Assy. Logic

| 2 screws | 1. | Remove the T-10 screws.

service and repair
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| 2. | Detach the Assy. USB SVC.

PCA Duplexer Interconnect - C8108-67031

First remove the following:
1. Assy. Door Main
2. Auto-duplex unit/ rear access panel
3. Assy. Pick roller
4. Case Left

1screw | 1.| Remove the T-10 screw.
2.| Turn the Duplexer Interconnect unit to pull out the harness.

Assy. Service Station - C8108-67011

First remove the following:
1. Assy. Door Main
2. Auto-duplex unit/ rear access panel
3. Assy. Pick roller
4. Case Left

hp confidential service and repair



1 screw Remove the T-10 screw.

Slide out the Encoder strip from its slot in the Encoder holder.

Remove the Encoder holder.

Use manual uncap, if necessary.

Pull out the two harnesses.

S E b

Remove the Assy. Service station.

Assy. Ink Supply Station - C8108-67013

First remove the following:
1. Assy. Tray Main
Assy. Output tray
Assy. Door Main
Assy. Access Door
Auto-duplex unit/ rear access panel
Assy. Pick roller
Case Left
Bezel
Cover Key Panel
. Assy. Lightpipe & PCA key panel
. Assy. Case Main
. PCA Duplexer interconnect
. Assy. Service station

CoNOOGO~WDN

el
WN RO

Step 2

| 3 screws | 1.| Remove the T-10 screws.
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2.| Pull out the (Black and white) harness and the motor harness.

w

Use long nosed pliers to cut the clip to remove the harness.

4.| Remove the ink supply station.

Remove Ink Supply Station - C8108-67013

Base Absorber/Basin SVC - C8108-67003

First remove the following:

1.

©CoOoNORrWLD

e el
D WNPRO

Assy. Tray Main

Assy. Output tray

Assy. Door Main

Assy. Access Door

Auto-duplex unit/ rear access panel
Assy. Pick roller

Case Left

Bezel

Cover Key Panel

. Assy. Lightpipe & PCA key panel
. Assy. Case Main

. PCA Duplexer interconnect

. Assy. Service station

. Assy. Ink supply station

=

Remove the base absorber.

Remove the Basin SVC.

hp confidential
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Bottom Cover - Main Case SVC - C8108-67023

First remove the following:
1. Assy. Tray Main
Assy. Output tray
Assy. Door Main
Assy. Access Door
Auto-duplex unit/ rear access panel
Assy. Pick roller
Case Left
Bezel
Cover Key Panel
. Assy. Lightpipe & PCA key panel
. Assy. Case Main
. PCA Duplexer interconnect
. Assy. Service station
. Assy. Ink supply station
. Base absorber/ basin SVC

CoNOGOr~WDN

e ol
O »WNRO

1.| Use long nosed pliers to push the two tabs located on the bottom cover.
2.| Remove the Bottom Cover Main Case SVC.

Holder-raceway/hanger SVC and Assy. Replaceable IDS SVC - C8108-67024
& C8108-67012

First remove the following:
1. Assy. Tray Main
Assy. Output tray
Assy. Door Main
Assy. Access Door
Auto-duplex unit/ rear access panel
Assy. Pick roller
Case Left
Case Right

ONOoOA~WDN
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9.

Bezel

10. Cover Key Panel

11. Assy. Lightpipe & PCA key panel
12. Assy. Case Main

13. Assy. Service station

Step 3

5 screws | 1.| Remove the T-10 screws.
2.| Lift the printhead access latch to remove the hanger SVC.

3.| Separate the hanger SVC and the Assy. Replaceable IDS.

Encoder Strip - C8108-67010

First remove the following:

1.

ONOoOA~WDN

Assy. Tray Main

Assy. Output tray

Assy. Door Main

Assy. Access Door

Auto-duplex unit/ rear access panel
Assy. Pick roller

Case Left

Case Right
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9. Bezel Cover Key Panel

10. Assy. Lightpipe & PCA key panel
11. Assy. Case Main

12. PCA Duplexer interconnect

13. Assy. Service station

14. Assy. Ink supply station

=

Remove the Encoder strip from its slot.

A

Remove the Encoder strip from its slot in the Encoder holder.

3. | Slide out the Encoder strip.
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troubleshooting power-on problems
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Fig 5.84 troubleshooting power-on problems
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symptom

cause

solution

issues

Power on and
printer response

Access doors open

Check the Access Doors:

Ensure the Top Cover and Carriage
Access Cover are firmly closed.

If the LCD panel displays the message
CLOSE ALL COVERS, open and reclose
all access doors.

Check the vents.

If the printer's vents are covered, and the
printer overheats, it automatically turns
off. Ensure the vents are not covered and
the printer is placed in a cool, dry
location.

Power cord
incompatibilities

Ensure the printer is connected to the
power cord and it is plugged in. The
power cord can handle up to 230V. To
test the power cord:

Power off the printer.

Unplug the power cord and replace it
with a power cord that works. Power on
the printer. If the printer now works, then
the previous power cord was probably
faulty.

Verify Voltage of
Power Supply
Assembly

Disconnect the Power Supply Harness
Assembly from the Power Supply PCA.
Use a multimeter to check the output
voltage of the Power Supply Assembly.
It should measure +19V (B+).
Reconnect the Power Supply Harness
Assembly when you are finished.

Turn the printer off and then power the
printer on again.

It may also be due to an Opto-coupler
failure or Power MOSFET failure. In either
case you will need to replace the Power
Supply Assembly.

Measure Voltage of
Logic PCA

Use a multimeter to check the output
supply voltage of the Kayak ASIC on the
Logic PCA.

Use a multimeter to check the input supply
voltage of the Power Connector to the
Logic PCA.

Main Harness

Check that all connections to the Main
Harness are solid and that all connectors
are attached firmly to the wires. Also
ensure that none of the wire insulation is
frayed or missing.

service and repair
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Note If PCA/power supply is replaced, hardware tests must be performed.
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troubleshooting printer initialization problems
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Fig 5.85 troubleshooting printer initialization problems
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symptom

cause

solution

Service station
mechanism

Rotate the gears of the Service Station
Motor Assembly to ensure the Wiper
Assembly can move freely within the
Service Station Mechanism Assembly.

Carriage assembly
moves out of home
position

If the Carriage Lock is not releasing,
check the Carriage Lock and check
the Service Station for movement. If
the Carriage Assembly does not move
out of the home position or return to
the home position, clean the electrical
contacts on the printheads and print
cradle.

Remove the printheads from the
printer.

Clean the electrical contacts on the
print cradle with a dry cotton swab.
Clean the electrical contacts on the
printheads with a dry, lint free cloth.
To prevent damage to the electrical
contacts, you should wipe the
contacts only once. Do not wipe the
ink nozzles on the printheads.
Re-install the printheads.
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troubleshooting LCD messages
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Fig 5.86 troubleshooting LCD messages

The following table lists the messages that does not require an action:

message explanation
INITIALIZING The printer is starting up.
READY The printer is idle.

PROCESSING JOB

The printer is busy printing.

CANCELLING JOB

The printer is canceling the current print job.

ATTENTION

User interaction is required.

POWERING OFF

The printer is powering off.

The following table lists the messages that require action::

message

explanation

PAPER JAM, OPEN COVER
AND CLEAR PAPER PRESS
RESUME TO CONTINUE

Paper is jammed in the printer.

[COLOR] INK CARTRIDGE

The cartridge is out of ink and the printer will

EMPTY not print until the cartridge is replaced.
REPLACE [COLOR] INK The printer detects a faulty ink cartridge.
CARTRIDGE

service and repair
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[COLOR] INK CARTRIDGE
MISSING

The printer cannot detect the ink cartridge
because it is missing, improperly installed, or
defective.

[COLOR] INK IS LOW

The specified ink cartridge is running low on
ink.

[COLOR] INK CARTRIDGE
EXPIRED

The expiration date for the specified ink
cartridge has passed.

REPLACE [COLOR] PRINTHEAD

The printer detects a faulty ink printhead.

[COLOR] PRINTHEAD MISSING

The printer cannot detect the ink printhead
because it is missing, improperly installed, or
defective.

BAD INK CARTRIDGE OR
PRINTHEAD

The printer detects a faulty ink cartridge or
printhead.

INCOMPATIBLE [COLOR]
PRINTHEAD

The printhead is not compatible with the
printer.

LOAD [MEDIA TYPE] in [TRAY]
PRESS RESUME TO CONTINUE

Printer requires media of a specific type and
size to be loaded in specified paper tray.

LOAD [MEDIA SIZE] MEDIA IN
[TRAY] PRESS RESUME TO
CONTINUE

For a print job that automatically selects the
media type, the printer requires media of the
specified size to be loaded into the specified
paper tray.

PRINTED PAGE IS DRYING...
PRESS RESUME TO CONTINUE

Printer has paused printing to let the current
page dry.

CLOSE ALL COVERS

One or more covers on the printer are open.

REAR MANUAL FEED NOT
AVAILABLE...JOB CANCELLED

Check to see if the auto-duplex unit is installed.

TRAY 2 NOT AVAILABLE PRESS
RESUME OR CANCEL

Tray 2 is an optional accessory. If you have
not purchased Tray 2, you cannot print from it.

AUTO-DUPLEX UNIT NOT
AVAILABLE PRESS RESUME OR
CANCEL

The auto-duplex unit is an optional accessory.
If you have not purchased the auto-duplex unit,
you cannot perform an auto-duplex job.

REINSERT [number] PAGES
INTO [TRAY]

This message is for manual duplexing.
Indicates that printing on the first side of the
media is complete.

PRINTHEAD ACCESS LATCH
OPEN

The printhead access latch is open.

REAR ACCESS PANEL OPEN

The rear access panel is not installed correctly
or the printer does not have a rear access
panel.

LANGUAGE= [LANGUAGE]

Displays the language in which the LCD shows
messages.
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print media problems
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Fig 5.87 troubleshooting paper feed problems

print media
symptom cause solution
Special media does Media is curled Uncurl and flatten media as much as
not pull in possible by physically curling it in

the opposite direction

Envelope Feed
Width Adjuster is
too tight against
envelope

Loosen Width Adjuster if necessary.

Too many
envelopes in the
Envelope Feed

The Envelope Feed only supports
one envelope at a time. To print
more than one envelope, use Tray
1.
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Paper does not pull in

Left Width
Adjuster

Check, if Left Width Adjuster is
pressed too tightly against paper
stack. Loosen it slightly.

Paper stack
height

Reduce paper stack height to level
indicated by the yellow sticker on
right wall of Input Tray.

Dirt accumulated
on pick and drive
rollers

Use the cleaning kit to clean the
rollers. Replace Drive Shaft/Pivot
Assembly if cleaning several times
does not help.

Paper Motor

Listen and look for motor and roller
movement. If no movement is
present, use a multimeter to probe
contacts. If power is live, replace
Paper Motor.

Paper Motor
power supply

Listen and look out for motor and
roller movement. If no movement is
present, use a multimeter to probe
contacts. If power is not live, the
Paper Motor Power Supply has
failed.

Electrical contacts

Change Main Harness if necessary

hp confidential
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troubleshooting the demo page
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Fig 5.88 troubleshooting demo page
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Caution The ink in the cartridges has been carefully formulated by Hewlett-Packard to ensure superior

troubleshooting the demo page

cl

symptom

cause

solution

Protective tape on
printheads

Each new printhead is packaged
with protective plastic tape
covering the ink nozzles. Check
each printhead and remove tape if
necessary.

Print a Selftest page

Click Start on the task bar
Highlight Settings and click
Printers.

Double-click the HP printer icon.

In the menu bar, click Printer and
select Properties .

Click Print Test Page at the
bottom of the page. The printer
prints a Self-test page.

Out of Ink

If you are printing black text and a
blank page prints, your black ink
cartridge may be empty. Replace
the black ink cartridge.

ean printheads
test name test description CANCEL RESUME
button button
Pen recovery level| Pen cleaning: Basic 2
1
Pen recovery level| Pen cleaning: 2 1
2 Intermediate
Pen recovery level| Pen cleaning: 2 2
3 Advanced

change the ink cartridges

print quality and compatibility with your printer. Damage to the printer or the print cartridge

resulting from modifying or refilling the ink cartridge is not the responsibility of HP.

PoONPE

Remove the printheads from the printer.

Clean the electrical contacts on the print cradle with a dry cotton swab.
Clean the electrical contacts on the printheads with a dry, lint free cloth.
To prevent damage to the electrical contacts, you should wipe the contacts only

once. Do not wipe the ink nozzles on the printheads.

o

Re-install the printheads.

6. Print an Extended Diagnostic Test page.

hp confidential
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troubleshooting paper eject problems
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Fig 5.89 troubleshooting paper eject problems

service and repair hp confidential



troubleshooting paper eject problems

Paper stack not fitting
Length and Width
Adjusters too tight
Paper stack height is
below the indicator
Dirt accumulates on
Drive Rollers

symptom cause solution
Skew Test Input Tray not To check for skew test failure, print a
Failure inserted correctly. Diagnostic page. Fold the Diagnostic

page in half. Ensure the skew test
symbols in each corner of the page
line up correctly. For example, the
lines associated with 1=A should fall
between the 2 lines 1 1=C. Paper
skew most frequently occurs when the
Width Adjusters are not flush against
the paper or excessive force is used to
install the Input Tray. Check for the
following:

Input Tray is properly inserted.

Paper stack fits snugly against the
right and front walls.

Length and Width Adjusters are firmly
against the paper stack or envelope.
Paper stack height is below yellow
indication sticker on right wall of Input
Tray.

Drive Rollers are feeding unevenly due
to dirt. If so, use the cleaning kit or
replace the Drive Shaft/Pivot
Assembly if cleaning several times
does not help.

Glossy media are most prone to paper
skew due to curling. To fix this
problem:

Add side-wall on Input Tray.

Add front bias spring on Width
Adjuster.

Install additional stopper at corner of

page.

Paper does not
Exit Printer

The ramp maybe
incorrectly assembled
Room for exiting

paper

The ramp maybe incorrectly
assembled. Reassemble the ramp
correctly.
Ensure the ramps are installed before
the Pivot.
Clear the Output Tray to make room
for exiting paper.

Paper forms a
ny

Up/Rear Paper
Guide Assembly,
assembly may be
faulty

If paper forms a "U" on the Up/Rear
Paper Guide Assembly, the assembly
may be faulty. Replace the Up/Rear

Paper Guide Assembly.
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error codes

Note

Note

Introduction

There are two types of errors that will highlight potential problems to the user. The first is

recoverable, which the user can resolve, and the second is unrecoverable, which is

generally not solvable by the user and will cause the printer to stop functioning altogether.

Recoverable error codes

Note

Brackets [ ] in the Message column indicate variables

If the printer is in the Menu state, error messages will not be displayed until the printer is
back in the Ready state.

If a recoverable error appears, the printer will pause until the user resolves the error.

message explanation recommended action

INITIALIZING The printer is starting up. No action required.

READY The printer is idling. No action required.

PROCESSING | The printer is busy printing. No action required.

JOB

CANCELLING | The printer is cancelling the No action required.

JOB current print job.

ATTENTION User interaction is required. Follow the instructions in the
printer message.

POWERING The printer is powering off. No action required.

OFF

PAPER Paper is jammed in the printer. | Clear the jammed paper. For

JAM,OPEN more information, see "Print

COVERAND media is jammed."

CLEAR PAPER
PRESS RESUME

TO CONTINUE

[COLOR] INK [ The cartridge is out of ink and | Remove the ink cartridge and
CARTRIDGE the printer will not print until the| install a new cartridge.
EMPTY cartridge is replaced.

service and repair
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REPLACE The printer detects a faulty ink | Reinstall the faulty ink cartridge

[COLOR] INK | cartridge. and try to print.

CARTRIDGE If the error persists, replace the
cartridge.

[COLOR] INK [ The printer cannot detect the Open the ink cartridge door and

CARTRIDGE ink cartridge because it is check for a missing,

MISSING missing, improperly installed, incompatible, or improperly

or defective. installed cartridge.

Reinstall or replace the cartridge
as appropriate.
If the error persists, contact HP
customer support.

[COLOR] INK [ The specified ink cartridge is If the print quality is insufficient,

IS LOW running low on ink. replace the ink cartridge.

[COLOR] INK | The expiration date for the Replace the ink cartridge.

CARTRIDGE specified ink cartridge has

EXPIRED passed.

REPLACE The printer detects a faulty ink | Remove the printhead, ensure the

[COLOR] printhead. protective film has been removed

PRINTHEAD from the printhead, and then
reinstall it and try to print.
If the error persists, remove the
printhead and use a dry, lint-free,
soft cloth to gently clean any ink
off the contact pads, and then
reinstall it and try to print.
If the error persists, replace the
printhead.

[COLOR] The printer cannot detect the Open the printhead cover and

PRINTHEAD ink printhead because it is check for a missing,

MISSING missing, improperly installed, incompatible, or improperly

or defective. installed printhead.

Reinstall or replace the printhead
as appropriate.
If the error persists, contact HP
customer support.

BAD INK The printer detects a faulty ink | Follow the instructions in the

CARTRIDGE OR| cartridge or printhead. printer message.

PRINTHEAD

INCOMPATIBLE| The printhead is not compatible| Replace it with the correct

[COLOR] with the printer. printhead.

PRINTHEAD

LOAD [MEDIA | Printer requires media of a Follow the instructions in the

TYPE] in [TRAY]
PRESS RESUME
TO CONTINUE

specific type and size to be
loaded in specified paper tray.

printer message.
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LOAD [MEDIA
SIZE] MEDIA IN
[TRAY] PRESS
RESUME TO
CONTINUE

For a print job that
automatically selects the media
type, the printer requires media
of the specified size to be
loaded into the specified paper
tray.

Follow the instructions in the
printer message.

PRINTED PAGE

Printer has paused printing to

Wait for the printer to

IS DRYING... let the current page dry automatically resume printing

PRESS RESUME after the drying period.

TO CONTINUE If you want the printer to resume
printing immediately, hold the
current page and press the
RESUME button.

When the printer releases the
current page, remove it from the
output tray and place it
elsewhere to dry.

This prevents the printed pages
from smudging each other.

CLOSE ALL One or more covers on the Close any open covers.

COVERS printer are open.

REAR MANUAL| Check to see if the auto-duplex | If the auto-duplex unit is installed,

FEED NOT unit is installed. you must remove it and reinstall

AVAILABLE...JO
B CANCELLED

the rear access panel to print
from the rear manual feed.

If the rear access panel is
installed, check to make sure it is
installed correctly in the printer.

TRAY 2 NOT Tray 2 is an optional If you have purchased Tray 2,
AVAILABLE accessory. If you have not make sure it is installed correctly
PRESS RESUME| purchased Tray 2, you cannot | in the printer.
OR CANCEL print from it. Otherwise, press the RESUME
button to continue the job using
Tray 1, or press the CANCEL
button to cancel the job.
AUTO-DUPLEX | The auto-duplex unit is an If you have purchased the auto-
UNIT NOT optional accessory. If you have | duplex unit, make sure it is
AVAILABLEPRES| not purchased the auto-duplex | installed correctly in the printer.
S RESUME OR | unit, you cannot print an auto- | Otherwise, press the RESUME
CANCEL duplex job. button to continue the job using
single-sided printing, or press the
CANCEL button to cancel the
job.
REINSERT This message is for manual Take the printed stack of paper
[number] duplexing. Indicates that from the output tray and put it
PAGES INTO printing on the first side of the | back into the specified tray.
[TRAY] media is complete.

service and repair
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PRINTHEAD
ACCESS
LATCH OPEN

The printhead access latch is
open.

Open the printhead cover, close
the printhead access latch, and
then close the printhead cover.
You will have to use some force
to close the printhead access
latch.

If the printhead access latch will
not close, ensure that the
printheads are seated properly
by pushing down firmly on each
printhead.

REAR ACCESS

The rear access panel is not

Make sure the rear access panel

PANEL OPEN installed correctly or at all in is inserted correctly and

the printer. completely into the printer.
LANGUAGE= | Displays the language in which| For information about changing
[LANGUAGE] | the LCD shows messages. the display language, see

“Setting the LCD language.”
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troubleshooting problems with parts

part symptom recommended action
description

(OOPS Continuous paper feed Replace the sensor.
Sensor)

Door sensor Indicates carriage door Replace the sensor.
(combined) open

Media sensor

No detection of
transparency. Transparency
detected when paper
present.

Use hot keys to disarm or replace
Media Sensor.

Check paper skew-skewed paper
can make Media Sensor detect
transparency instead of paper.

Line sensor No auto pen alignment Replace the sensor.
Carriage Carriage slams to the end The Carriage Encoder Strip might
Assembly be defective.
Check the 5V supply.
"Replace printhead” error is | Check the 16V supply.
displayed Please check voltage
Carriage does not move out | Replace the carriage lock.
of home position.
Printout edges, lines and text| Replace the encoder strip.
misaligned Check the alignment of the
Encoder strip.
Noise coming from carriage.| Clean electrical contacts. Replace
Carriage Motor.
Check Carriage Shatft for dirt
particles.
Key Panel Garbled display Check the contact between LCD
PCA No response from printer panel and Logic PCA.

after pressing buttons
Running dots

Power Supply

Unexpected shutdown due to
overheating

Unable to power up
Opto-coupler failure

Check the fan.

Ensure that the cooling vents are
not obstructed.

Replace Power Supply PCA.

Service Station

Carriage does not move out

Check if Carriage Latch faulty.

Assembly of Home/Service Station Replace Service Station.
position
Logic PCA Garbled display. Check the contact between the

No response from printer
after pressing buttons.
Running dots.

LCD panel and Logic PCA.
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No power light.

If +5v and 18v cannot be
measured on Logic PCA, replace
Logic PCA.

Service Station does not
move smoothly.

Replace Service Station.
If problem is not resolved, replace
Logic PCA.

Carriage does not move out
of home position.

Replace Carriage Motor.
If problem is not resolved, replace
Logic PCA.

Drive Shaft/Pivot Assembly
rollers do not rotate.

Replace Paper Motor.
If problem is not resolved, replace
Logic PCA.

No paper feed.

Replace OOPs tag.
If problem is not resolved, replace
Logic PCA.

Self-Test does not look OK.

Check for protective tape on print
cartridge.

Replace print cartridge.

If problem is not resolved, replace
Logic PCA.

Gaps in Test pattern.

Perform the Pen Recovery
Diagnostic test.

Change the print cartridge.

If problem is not resolved, replace
Logic PCA.

Encoder Strip

Printer/Carriage stall. Error
code displayed if alignment
extremely poor.

Replace dirty or faulty Encoder
Strip.

Paper Motor

Drive Shaft/Pivot Assembly
rollers do not rotate.

Ensure that rollers and pins on
backbone are loose.
If not, replace Paper Motor.

No roller movement.

Check contacts to motor.
If power is available, replace
Paper Motor.

Noise form left side of

If noise is coming from the motor,

printer. replace Paper Motor.
Drive Paper jam cannot be Check Drive Shaft/Pivot Assembly
Shaft/Pivot cleared. gears.
Assembly If broken or cannot be turned

freely, replace the Drive
Shaft/Pivot Assembly.

Paper skewed. Uneven
paper feeding due to roller
contamination.

Clean rollers. If problem is not
resolved, replace Drive
Shaft/Pivot Assembly.
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troubleshooting unusual noises

START
¥
Noise from ; .
; : Service Station
right side of - Yes >
Printer? may be faulty.
Mo
v
Paper Motor,
Noise from Line Feed Motor,
left side of Yes * orFeed Gears »
primter? may be faulty.
Mo
¥
Up/Rear Paper Guide
Assambly or
r e Yes —» Drive Shaft/Pivot »
Roilers? Roller Assembly
miay be faulty.
Mo
b ) ¥
Carriage Shaft may
be dirty or sliders Replace one part
%ﬂsnai;r:.? Yas ¢ for Carriage may » at a time to isolate
ge: have metal the cause.
particles on them.
Mo
¥
STOP -
Fig 5.90 troubleshooting unusual noises
symptom cause solution
Noise from the | Faulty Service Station| If the right side of the printer is making
right side of Assembly unusual noises, the Service Station
Printer Assembly or one of its parts may be
faulty.
Noise from the | Faulty Paper Motor If the left side of the printer is making
left side of unusual noises, the Paper Motor may be
Printer faulty.
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Noise from the | Faulty Drive The Drive Shaft/Pivot Assembly and the

rollers Shaft/Pivot Assembly | Up/Rear Paper Guide Assembly have
and the Up/Rear rollers responsible for feeding the paper
Paper Guide in to the printer. Faulty rollers cause
Assembly unusual noises.

Noise from the | Carriage Shaft Check the Carriage Shaft for dirt

carriage

particles. To check the sliders on the
Carriage, you must remove the
Carriage.
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troubleshooting setup issues

symptom

cause

solution

Printer is not
responding

Power connection faulty

Press and hold down the
POWER button on the printer
for a few seconds.

After a brief printer startup, a
steady green light should
appear next to the button.

If the printer does not turn on,
ensure that the printer cable is
firmly connected to the
computer.

Ensure that the power cable is
connected to a working outlet.
If you still cannot turn on the
printer, you might have a faulty
power cable or LCD panel.

Incorrect driver installation

If you print when the printer is
turned off, an alert message
appears on the computer
screen.

If the printer is turned off and
no message is displayed when
executing a print command, the
printer setup might be incorrect.
To correct the printer setup,
reinstall the printer software.
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Incorrect hardware /
accessories / supplies
installation

Check the printer setup.
Ensure that the following
components are loaded
correctly:

Ink cartridges
Printheads

Paper

Ensure that all the
printer covers are
closed.

Ensure that the tape is removed
from printheads.

Ensure that the paper is loaded
correctly into the tray.

Ensure that the paper is not
jammed in the printer.

Ensure that the printer is
selected as the default printer.
Ensure that Pause Printing is not
selected.

Incorrect network
installation / configuration

Ensure that the printer is
properly set up in the network
environment.

Check IP address.

Ensure that correct network
protocols are installed.

Power light of the
printer blinks
amber and green,
alternately

A nonrecoverable error
has occurred. (e.g. the
carriage might be stalled)
The latest version of the
firmware is absent or the
firmware might have been
incorrectly flashed

Turn off the printer, wait for
some time, and turn on the
printer again.

Turn off the printer and then
turn it on again.

If the problem persists, it might
be a hardware issue or fault.
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Printer takes a Incorrect configuration Ensure that the computer meets

long time to print | Inadequate hard disk the minimum operating system
space in the spool requirements for the printer.
directory At least 50 MB of hard disk

Incorrect configuration of | space should be available in
hardware on the PC side | the following cases:

Low ink supply To print on 279 x 432 mm (11
x 17 inches) or A3 paper

To print graphics-intensive files
Ensure that the port settings
configuration in the computer is
set to ECP.

Check the status of the ink
cartridges.

Replace any ink cartridges that
are low on ink.

troubleshooting paper jams

tips and tricks

To clear a paper jam, first check the paper input paths. If the jammed paper is visible from
one of the input trays or the front manual feed, carefully pull the jammed paper straight up
and out of the printer. Select new paper and reload the printer with it.

Note Ensure that the paper is aligned to the right side of the tray. In addition, verify that the guides
are adjusted tightly against the stack of paper and they do not wrinkle or bend the paper.

The steps to clear a paper jam by opening the top cover of the printer are:
1. Remove all paper from the output tray.
2. Open the top cover. The carriage should return to its position on the right of the
printer.
3. If the carriage does not return to the right of the printer, turn off the printer before
you remove the jammed paper.
4. Remove any wrinkled paper by pulling the paper through the top of the printer.
After clearing the jam:
* Close all covers of the printer.
* Press the RESUME button to continue the print job.
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print quality troubleshooting

symptom cause solution
Poor print quality Printer needs Check the printheads and ink cartridges
cleaning Check and replace clogged or worn
Ink supplies printheads.
issues Check and replace low or empty ink
cartridges.
Check the paper quality
Ensure that the paper you are using is not
too moist or too rough.
Check the inside of the printer
Clean the inside of the printer with a lint-
free cloth.
Meaningless Incorrect Check the cable connection
characters printed | connectivity Ensure that the cable connection at both
Incorrect the ends is proper and the cable is
document securely fastened.
settings Check the document file
Check whether the printable document is
damaged.
Print the document by using a backup
copy.

troubleshooting power-on problems

symptom| cause solution

Power-on | Access doors | Check the Access Doors:

and printer| open Ensure the Top Cover and Carriage Access Cover are
response firmly closed.

issues If the LCD panel displays the message CLOSE ALL

COVERS, open and reclose all access doors.

Check the vents:
If the printer's vents are covered, and the printer
overheats, it automatically turns off. Ensure the vents
are not covered and the printer is placed in a cool,
dry location.

Power cord
incompatibiliti
es

Ensure the printer is connected to the power cord and
it is plugged in. The power cord can handle up to
230V. To test the power cord:

Turn off the printer.

Unplug the power cord and replace it with a power
cord that works. Turn on the printer. If the printer now
works, then the previous power cord was probably
faulty.
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Voltage of Disconnect the Power Supply Harness Assembly from
Power Supply | the Power Supply PCA.
Assembly Use a multimeter to check the output voltage of the
Power Supply Assembly.
It should measure +19V (B+).
Reconnect the Power Supply Harness Assembly when
you are finished.
Turn the printer off and then power the printer on
again.
It might also be due to an Opto-coupler failure or
Power MOSFET failure. In either case you will need to
replace the Power Supply Assembly.
Voltage of Use a multimeter to check the output supply voltage of
Logic PCA the Kayak ASIC on the Logic PCA.

Use a multimeter to check the input supply voltage of
the Power Connector to the Logic PCA.

Main Harness

Check that all connections to the Main Harness are
solid and that all connectors are attached firmly to the
wires.

Also ensure that none of the wire insulation is frayed
or missing.

Note If PCA/power supply is replaced, hardware tests must be performed.

troubleshooting printer initialization problems

symptom cause solution
Service station Rotate the gears of the Service Station
mechanism Motor Assembly to ensure the Wiper

Assembly can move freely within the
Service Station Mechanism Assembly.

service and repair
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Carriage assembly
moves out of home
position

If the Carriage Lock is not releasing,
check the Carriage Lock and check the
Service Station for movement. If the
Carriage Assembly does not move out of
the home position or return to the home
position, clean the electrical contacts on
the printheads and print cradle.

Remove the printheads from the printer.
Clean the electrical contacts on the print
cradle with a dry cotton swab.

Clean the electrical contacts on the
printheads with a dry, lint free cloth.

To prevent damage to the electrical
contacts, you should wipe the contacts
only once. Do not wipe the ink nozzles
on the printheads.

Re-install the printheads.

troubleshooting print media problems

symptom

cause

solution

Special media
does not pull in

Media is curled

Uncurl and flatten media as much as
possible by physically curling it in the
opposite direction

Envelope Feed
Width Adjuster is
too tight against
envelope

Loosen Width Adjuster if necessary.

Too many
envelopes in the
Envelope Feed

The Envelope Feed only supports one
envelope at a time. To print more than
one envelope, use Tray 1.

Paper does not
pull in

Left Width
Adjuster

Check if Left Width Adjuster is pressed
too tightly against the paper stack. Loosen
it slightly.

Paper stack
height

Reduce paper stack height to level
indicated by the yellow sticker on right
wall of Input Tray.

Dirt accumulated
on pick and
drive rollers

Use the cleaning kit to clean the rollers.
Replace Drive Shaft/Pivot Assembly if
cleaning several times does not help.

Paper Motor

Listen and look for motor and roller
movement. If no movement is present, use
a multimeter to probe contacts. If power is
live, replace Paper Motor.
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Paper Motor
power supply

Listen and look out for motor and roller
movement. If no movement is present, use
a multimeter to probe contacts. If power is
not live, the Paper Motor Power Supply
has failed.

Electrical
contacts

Change Main Harness if necessary

troubleshooting the demo page

symptom

cause

solution

Protective tape on
printheads

Each new printhead is packaged with
protective plastic tape covering the ink
nozzles. Check each printhead and
remove tape if necessary.

Print a Self-test
page

Click Start on the task bar

Highlight Settings and click Printers .
Double-click the HP printer icon.

In the menu bar, click Printer and select
Properties .

Click Print Test Page at the bottom of
the page. The printer prints a Self-test

page.

Out of Ink

If printing black text and a blank page
prints, the black ink cartridge might be

empty. Replace the black ink cartridge.
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troubleshooting paper eject problems

symptom cause solution
Skew Test Input Tray not To check for skew test failure, print a
Failure inserted correctly. | Diagnostic page. Fold the Diagnostic page
Paper stack not in half. Ensure the skew test symbols in
fitting each corner of the page line up correctly.
Length and Width | For example, the lines associated with 1=A
Adjusters too tight | should fall between the 2 lines 1 1=C.
Paper stack height| Paper skew most frequently occurs when
is below the the Width Adjusters are not flush against
indicator the paper or excessive force is used to
Dirt accumulates install the Input Tray. Check for the
on Drive Rollers following:
Input Tray is properly inserted.
Paper stack fits snugly against the right and
front walls.
Length and Width Adjusters are firmly
against the paper stack or envelope.
Paper stack height is below yellow
indication sticker on right wall of Input
Tray.
Drive Rollers are feeding unevenly due to
dirt. If so, use the cleaning kit or replace
the Drive Shaft/Pivot Assembly if cleaning
several times does not help.
Glossy media are most prone to paper
skew due to curling. To fix this problem:
Add side-wall on Input Tray.
Add front bias spring on Width Adjuster.
Install additional stopper at corner of page.
Paper does The ramp might be| The ramp might be incorrectly assembled.
not Exit Printer| incorrectly Reassemble the ramp correctly.
assembled. Ensure the ramps are installed before the
Room for the Pivot.
exiting paper Clear the Output Tray to make room for
might not be exiting paper.
enough
Paper forms a | The Up/Rear If paper forms a "U" on the Up/Rear Paper
U Paper Guide Guide Assembly, the assembly might be
Assembly might be| faulty. Replace the Up/Rear Paper Guide
faulty Assembly.
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troubleshooting unusual noises

symptom

cause

solution

Noise from the right
side of Printer

Faulty Service
Station Assembly

If the right side of the printer is making
unusual noises, the Service Station
Assembly or one of its parts might be
faulty.

Noise from the left

Faulty Paper

If the left side of the printer is making

side of Printer Motor unusual noises, the Paper Motor might
be faulty.

Noise from the Faulty Drive The Drive Shaft/Pivot Assembly and the

rollers Shaft/Pivot Up/Rear Paper Guide Assembly have

Assembly and
the Up/Rear
Paper Guide
Assembly

rollers responsible for feeding the paper
in to the printer. Faulty rollers cause
unusual noises.

Noise from the
carriage

Carriage Shaft

Check the Carriage Shatft for dirt
particles. To check the sliders on the
Carriage, remove the Carriage.

troubleshooting printer status
symptom cause action
Unexpected printer | No power Ensure that the power cord is connected
shutdown supply firmly to the printer and a working
outlet.
Check if power cord is defective.
Ensure that the printer is turned on and
the POWER light on the LCD panel is
green.
Restart the printer.
Printer Check the printer vents.
overheated Ensure that the vents are not covered,

and the printer is in a cool and dry
location.

troubleshooting prin

t quality issues

symptom cause action

Blank page printed | Printhead Ensure that the tape is removed from the
problems printheads.
Incorrect driver | Check for empty ink cartridges.
Media mispick | Check that the paper is wide enough.
issue Check the parallel port on the computer

Check whether the application print
preview (if any) is correct.

Ensure that the correct printer driver is
selected.
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Wrong fonts
printed

Fonts in
document are
non-standard or
customized

Check the fonts used.
Check the available fonts.

Check whether the font that is incorrectly

printed is a TrueType font.

Jagged text

Use of non-
standard fonts

Check the chosen font type.
Check the font type of the software.
Check the bitmap image of text.

troubleshooting incorrect / incomplete content

symptom

cause

action

Content on the
page is missing or
incorrect

Incorrect paper
size

Incorrect
Margins for print]
job

Check the margin settings.

Ensure that the margin settings for the
document do not exceed the printable
area of the printer.

Check color print settings.

incorrect

Specialized Deselect the Grayscale option in the
color settings Print Settings dialog box.
printing

Placement of the Incorrect page Check the page orientation.

text or graphics is | settings Check the paper size.

Check margin settings.
Check how the paper is loaded.

troubleshooting connectivity problems

configuration
issues

symptom cause action
Problems printing System / Check the system configuration.
over a network network There might be insufficient hard disk

space in the system.

Increase the size of the system’s virtual
memory.

The port setting configuration in the
system is not set to ECP (Windows
3.1x/95/98 only).
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nonrecoverable error codes

Note XX or XXXX signifies any digits, substitutes in their place in the character sting

error

description

recommended
action

C00300xx

Pen Problems

Replace sensor.

C00400xx

Carriage stall, shutdown

Replace carriage
motor, PCA,

C00600xx

Service Station Problems

Replace/Clean repair|
service station

CO11xxxX;
CO12xxxx

Problems with carriage
board, Power supply, PCA
logic board

Troubleshoot parts

C0id00xx

Pen & Supply errors

Replace printheads

CO1AXXXX

Real Time Clock errors

Replace PCA

service and repair
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part symptom recommended action

description

(OOPS Continuous paper feed Replace sensor.

Sensor)

Door sensor | Indicates carriage door Replace sensor.

(combined) open

Media sensor [*  No detection of * Use hot keys to disarm or replace
transparency. Media Sensor.

Transparency detected
when paper present.

Check paper skew-skewed paper
can make Media Sensor detect
transparency instead of paper.

Line sensor No auto pen alignment Replace sensor.
Carriage Carriage slams to the end| Carriage Encoder Strip defective.
Assembly Check 5V supply as well. Please
check voltage
"Replace printhead error"| Check 16V supply. Bad acumen.
display Bad pen contact. Please check
voltage
"Empty ink cartridge™ Bad acumen. Bad pen contact.
display
Carriage does not move | Carriage lock has not released (Error
out of home position. "E:0432") because lock faulty,
service station faulty, or service
station lost sequence position.
Printout edges, lines and |+ Bad bi-directional alignment.
text misaligned e Econofast mode.

* Encoder strip dirty (printer may
stall and display error code due to
misalignment)

Noise coming from » Clean electrical contacts. Replace
carriage. Carriage Motor.

» Check Carriage Shaft for dirt
particles.

Key Panel » Garbled display Check contact between LCD panel
PCA . No response from and Logic PCA.

printer after pressing
buttons
Running dots

Power Supply

Unexpected shutdown
due to overheating
Unable to power up
Opto-coupler failure

Check fan.

»  Ensure cooling vents not
obstructed.

Replace Power Supply PCA.

Service Carriage does not move | Check if Carriage Latch faulty.
Station out of Home/Service Replace Service Station.
Assembly Station position
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Logic PCA

Garbled display.

No response from printer
after pressing buttons.
Running dots.

Check contact between LCD panel
and Logic PCA.

No power light.

If +5v and 18v cannot be measured
on Logic PCA, replace Logic PCA.

Service Station does not
move smoothly.

Replace Service Station. If problem
is not resolved, replace Logic PCA.

Carriage does not move
out of home position.

Replace Carriage Motor. If problem
is not resolved, replace Logic PCA.

Drive Shaft/Pivot
Assembly rollers do not
rotate.

Replace Paper Motor. If problem is
not resolved, replace Logic PCA.

No paper feed.

Replace OOPs tag. If problem is not
resolved, replace Logic PCA.

Self-Test does not look
OK.

Check for protective tape on print
cartridge.

Replace print cartridge.

If problem is not resolved, replace
Logic PCA.

Gaps in Test pattern.

Perform Pen Recovery Diagnostic
Test.

Change print cartridge.

If problem is not resolved, replace
Logic PCA.

Encoder Strip

Printer/Carriage stall.
Error code displayed if
alignment extremely poor.

Replace dirty or faulty Encoder Strip.

Paper Motor

Drive Shaft/Pivot
Assembly rollers do not
rotate.

Check that rollers and pins on
backbone are loose. If not, replace
Paper Motor.

No roller movement.

Check contacts to motor. If power is
available, replace Paper Motor.

Noise form left side of
printer.

If noise is coming from motor,
replace Paper Motor.

Drive
Shaft/Pivot
Assembly

Paper jam cannot be
cleared.

Check Drive Shaft/Pivot Assembly
gears. If broken or cannot be turned
freely, replace Drive Shaft/Pivot
Assembly.

Paper skewed. Uneven
paper feeding due to
roller contamination.

Clean rollers. If problem is not
resolved, replace Drive Shaft/Pivot
Assembly.
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